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Workflows

This guide concerns designing, using, and monitoring STEP Workflows in the STEP Workbench. Workflows are
managed within the workbench, though end users can access them via both workbench and Web Ul. For
information on configuring and working with workflows in Web Ul, see the Workflows in Web Ul section of the
Web User Interfaces documentation.

Workflows may be considered as a view or representation of real work within a company, allowing businesses to
manage and streamline the flow of tasks among varying groups, users, and system activities. A workflow definition
consists of a number of states that an object or task can be in at a given time, the legal transitions between these
states, and the events via which the transitions can be triggered. The flow being described may refer to an asset,
service, person, product, or other element that is being transferred from one state to another. For example,
introduction of a new product may involve work from a variety of business groups, such as Product Management,
Marketing, Creative, and Legal. Each group needs to interact with the product in some way, and likely have
differing sets of data required for this interaction. Some groups may not be able to do their work until another group
has completed theirs, while other groups may be able to act on the product in parallel.

The same principles apply for any other data types and any type of data maintenance. Regardless of the type of
data or process being handled, an object in a state represents a task that requires work. For instance, a user could
be required to populate a set of attributes, and when completed, manually trigger a transition from one state to the
next. Alternatively, an object could be in a state waiting for data from an external system, waiting for a background
process to complete, or waiting for a specific event elsewhere in the workflow or in STEP in general, and thus not
require any direct human interaction.

STEP Workflows are data-centric workflows, meaning that a workflow instance is defined as the relation between
a workflow definition and an object in the STEP database. An object can be in multiple workflows simultaneously,
and each instance will have no impact on the others (unless the workflow definitions include business rules to
create a relationship between various workflows).

On top of the basic STEP Workflow functionality, a number of additional features are available that make
workflows powerful tools for streamlining processes and ensuring data quality. These include, but are not limited
to, options to:

« Configure business rules to validate data, assign tasks, move tasks through workflows, integrate workflows
with other processes such as imports and exports, and more

« Configure data views specific for each workflow state, allowing each actor in the flow to focus only on the data
most relevant for their tasks

« Support both static and dynamic task assignment and ownership, ensuring that the right actor sees the right
task at the right time

« Design for sequential and parallel execution of tasks, streamlining work processes for maximum efficiency
« Setdeadlines and escalation actions, ensuring that tasks are completed in a timely manner

« Configure dashboards for snapshot monitoring and KPI reporting, allowing administrators to quickly view and
assess key data points across the entire workflow
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The supported workflow enabled object types are:

o Assets

o Attributes

o Classifications

o Entities

o Lists of Values (LOVs)
« Planned pages

« Products

o Publications

« Publication sections

While workflows can become quite complex, the basics are really simple, and it is possible to get a small functional
workflow up and running in a matter of minutes. This guide will begin with the basic material and work up to more
advanced topics.
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Getting Started with STEP Workflows

This portion of the material introduces the user to basic STEP Workflow functionality, including creating a simple
workflow and accessing tasks within it. More advanced material can be found in the Advanced Workflow Topics
section of the Workflows documentation, but it is recommended that users be well-versed in the introductory
topics before beginning advanced functions.

If you are new to workflows, it is recommended that you read the material in the suggested order, as topics build
upon one another.

However, if you are concerned only with the end user functionality (working with tasks in a workflow), as opposed
to designing and configuring a workflow, you may wish to skip directly to the Working with Tasks in Workflows
section of the material.

Suggested Reading Order:

Workflow Terminology

Workflow Privileges

Initial Setup for Workflows
Creating a Workflow

STEP Workflow Designer

Views and Mappings for Workflows
Working with Tasks in Workflows
Managing Workflows

© N bk wd -~
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Workflow Terminology

This defines a list of commonly used terms in regards to workflows.

Action Type of business rule that can be executed on arrival in a new state (on-entry), on exit from a
state (on-exit), or on the transition between two states (on-transition). Actions may modify data.

Assignee The user or group to which a task is assigned for work to be performed. User states can be
assigned directly to a named user or to a user group. When a state is assigned to a user group
the task is ‘offered’ to all members of that group. To perform the task associated with the state,
a member of the group has to claim the task. Once a task is claimed it is no longer visible in the
group task list; only the person who claimed the task is able to see it. A user may subsequently
release a task back to the group.

AU ETCRE State in which the STEP system performs the required work and automatically progresses the
State workflow when the automated work is complete. Typically requires the use of at least one
business rule.

Business Automated activity that may implement customer-defined rules, such as validations, automatic
Rule updates, notifications, data-driven workflow routing, etc. Also see Condition and Action.

Condition Type of business rule that can prevent a transition from being taken when an event is
attempted. Within a workflow, conditions may only be executed on attempted transitions (e.g.,
before 'Proceed’ event is allowed, validate that all required data has been populated). A
condition may not change data.

Deadline Optional setting for time allowed for a task to be completed. If a deadline expires on a task it is
possible to perform an escalation.

L IEHGI The action(s) to be taken when a deadline expires. Escalations require at least one business
rule to be configured, which is triggered by the escalation.

The name associated with a transition between two states, such as Proceed, Reject, or Accept.
When a task is completed an event is triggered to transition an object to the next state(s) in the
workflow. In most cases where there is just a single event, this is called 'Proceed’ but in some
cases there is a need to support different routing via different events (e.g., 'Accept’ or 'Reject’)
or a different name is chosen to add clarity (e.g., ’Approve’).

HLHEIRSEICIN The state within a workflow or a parallel cluster that is the last step of this workflow or parallel
cluster. A final state cannot have any outbound events as there are no available transitions from
the state. Note that for parallel clusters, final states are used to auto-progress the workflow
when all concurrent parallel clusters have reached their final state.
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BIHEIRSIEIEE The first state that is activated within a workflow or within a parallel cluster of a workflow.

Task The work and/or action that must be completed within a specific workflow state (whether by a
user or via automation).

IECL dREIREE Fields (attribute, reference, workflow variable) that are available within a specific state for the
system or a user to access (view and/or populate). Task fields may or may not be included in
the view.

Parallel A set of states that form a sequential branch of dependent states which may run parallel to
cluster other independent branches within the same workflow.

State A step within a workflow to which a specific user, user group, or system can be assigned to
complete the task(s) associated with the state. Also see User State and Automated State.

Transition The change of tasks from one state to another.

UECETESI EVCE State that requires a user to complete a task before marking the state complete. May include
some automation that happens on entry or exit of the state, but requires a user to trigger the exit
from the state (indicating completion of the associated task).

The set of specific data points that are presented to the user in the STEP Workbench when a
task is selected. Views are configurable by state and are only applicable for user states that will
be accessed directly from the STEP Workbench. Views are not applicable for automated
states, and states accessed via a Web Ul have interfaces defined via the Web Ul configuration.
Within the STEP Workbench, users can still choose to use the full set of workbench data and
tabs to work on workflow tasks if desired (and permitted via privilege configurations). However,
a view can streamline work processes so that only a small subset of fields that are directly
relevant to the task / state are displayed.

Workflow Business process(es) modeled as a series of states and tasks that can be executed by users
and/or automatic processes within the STEP system. Workflows prompt the next step of a
process to be started, by either creating a task for a user, or sending an alert. Workflows may
contain a number of process steps or tasks, as well as business logic.

Workflow A temporary asset attached to a task, that does not exist outside of the workflow.
Attachment

Workflow A temporary data point (similar to an attribute value) attached to a task, that does not exist
Variable outside of the workflow.
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Workflow Privileges

There are a number of Setup Actions (privileges) directly related to STEP Workflows, both in terms of allowing
users to configure workflows and to work with tasks within workflows. In addition to workflow-specific privileges,
workflows also take into account general privileges. For example, if a user does not have access to a specific set of
objects or data points, they will not have access to them within a workflow either, unless specific access is granted
within the workflow.

For complete information on privileges related specifically to workflows, see the Workflows section of the Setup
Actions topic in the System Setup / Super User Guide documentation.

For information on editing general privileges to provide access to data or objects specifically within a particular
workflow state, see the Editing Privilege Rules section of the System Setup / Super User Guide
documentation.
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Initial Setup for Workflows

In order to create workflows in STEP, some basic configuration must first be completed. Specifically, the STEP
Workflow Type basic object type must have a Setup Group parent assigned, and a System Setup object of the
proper type must have been created to hold the workflows.

In most cases, this setup will already be complete on a system and is only required if a Workflows folder (or other
setup node enabled to workflow children) is not present on the System Setup tab, as shown in step 7 below.

The setup described below is only required to be completed once on any system, but may be carried out multiple
times if it is desired to separate workflows for organizational purposes.

Enabling a Setup Group for Workflows

1. Go to System Setup and select Object Types and Structures > Basic Object Types and verify that STEP
Workflow Type exists. If not, contact your system administrator for assistance.

(P (& Obiject Types & Structures

|j Alternate Classifications

-- Assets

b (¥ Basic Object Types

H-Z& Attribute Group

- Attribute Transformation
iﬁ‘ Business Action Type

{7 Business Condition Type
{%‘ Business Library Type
{7 Change Package

{7 Setup Entity user-type root
-7 Status flag type

{7 STEP Workflow Profile Type

{2 ETEP Workflow Type|

System Setup

Bookmarks

2. Right-click on Setup Group type root under Object Types & Structures to create a new New Object
Type from the context menu.

[ Publication group types

l%’ Publication section types

Iﬁ‘ Publication types

=1 Setup Group .
{%’ Change Pa L& New Object Type
- Completene
- Event Proce
{ﬂ’ Gateway En
-2 Global Busin ~
-z Inbound In Paste
@’ Integration
- Match Codes . Delete

Update Object Type From

Copy

3. EnteranID and a Name, and click Create.
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s+l Publication types

% El Dirr

! :

7]

‘f Create Object Type

g

7 ID Workflows

(¥}

Name

9 . .

EI Dimension Dependency [ ] country

E [ ] Language

(=]

i

Create Cancel

[ =]

4. Returntothe STEP Workflow Type node in Object Types & Structures > Basic Object Types. In the
corresponding editor, select the References tab and select Add Parent to link this to the folder created for
workflows under Setup Group type root. This enables workflow objects to be created as children to the
Workflows setup group root.
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=-{Z Object Types & Structures
rj Alternate Classifications
-- Assets

= Basic Object Types

- Attribute Group

-G Attribute Transformation
{72 Business Action Type
{72 Business Condition Type
%‘ Business Library Type
{E‘ Change Padkage

Search

& Objects of this Object Type

?
2.

Add Parent

Log

Select Mew Parent

[#-{Z3 Collection Group
{7 Completeness Metric
{7 Context
-7 CP-Link-Type
{7 Event Processor
@‘ Gateway Integration Endpoint T
-2 GD5N Data Pool Publisher
(-2 GDSN Data Pool Receiver
{7 GOSN Recpient
@‘ Inbound Integration Endpoint T
- InDesign Document

=& Setup Group type root

Iﬁ‘ (ClericalReviewWorkflows)

[ﬁ (GDSNReceiverRestBusinessActions)
& Asset Analyzer

@’ Asset Import Configurations

Iﬂ‘ Asset Import Configurations

W Asynchronous Services

[+ AutoTestSetupGroup

{2 Key @’ Business Rules Only
Eg..g :sﬁf;'a;ues Group Type @J Change Packages
mns a n E H
.

%‘ Matching Algorithm . ﬁ WEb Uls

--{7% Outbound Integration Endpoint " Wiki Setup Group Type

@‘ Flanned Page @ Workflows
& & XoLT
- {2 Table Column Type Group . s

&= Details
Select Cancel
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5. To create the parent node for workflow instances to be created under, go to the Maintain menu, navigate to

Insert, and select Setup Group Root.
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Maintan 0 WowHelp

=10 ! .

Link i B New Publication...
e X B New Publication Group
B MNew Publication Section...
. Delete BB NewPage Template ..
Force Delete & Purge &5 Orphan Attribute Cirl - Shif+0
Unlink Object Type Asset Ctrl+ Shift+ A
B2 Duplicate Ctriey | T Attribute Chleshift=T
EE  DuplicateRecursively T Attribute Group Sl
Bl List of Values Ctrl+5hift+L
Make Revisicn . Dimension Ctrl+ Shift+ D
Approval [ . Dimension Point Ctrl +Shift+M
Enable group for workflows ‘i1 Workspace Ctrl+ Shift+W
B Action Set Ctrl+Shift+5
Revive

Mew Image Conversion Configuration...

Revive Recursivel
al Create Transformation Lookup Table

o

Mew Event Queue

Mew AssetPush Event Queue

Truncate log...

Mew Business Condition

tup Group Type Mew Business Action

3 Mew Business Library
IIE Setup Group Root... I

6. Selection of Setup Group Root opens the 'Create Setup Group Root' dialog. Select the workflow object type
that was created in Step 3, enter an ID and Name, and click Create.
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te Setup Group Root

~ Object Type
() SufficiencyAccess1 -

O Uncategorized Setup Group Type

() valGenBF

() valueGens

() web UIs

O Wiki Setup Group Type

() workflow Profiles

(@ Workflows

() XSLT Stylesheets v

1D Waorkflows

MName | Workflows

Create Cancel

7. This creates a folder in System Setup that a user can then create individual workflows under by right-clicking
and selecting Create STEP Workflow.

i -[75] Match Codes and Matching Algorithms
-[75] Outbound Integration Endpoints

----- [(5] Status Flags

----- [f5] Uncategorized Setup Group

- (5] Web Uls

-5 Workflow Profiles

..... Derived Mew Setup Group...

El@ Object | Mew Business Action
[T Alte
® Mew Business Condition

47 Ass
=N Easl@ Create STEP Workﬂowl

Start Background Process to Monitor Deadlines  Ctrl+Shift+D

m

Cut Ctrl+X

[ STEP Workflow ” Bookmarks ]w
[+ o[-

Copy Ctrl+C
Paste Ctrl+V

il i 3K

Pt

Delete
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Creating a Workflow

This topic describes how to create a basic workflow, which requires the following steps:

Create a new workflow

Create states in a workflow
Create transitions between states
Add events to transitions

Set assignees

Set validity

7. Setworkflow options

L

Each of the steps is described in detail below, guiding users through the creation of a simple workflow, as shown
below.

Sample Workflow tSarﬁpleWurkﬂuw:istateJ (Y,

s

r
Pruqé}ed Reject
A"

#
#

Do Wiork &

Progeed

L

Finizh

D

In addition, a new workflow can be created via duplication of an existing workflow, so that topic is also covered in
this section.

Prerequisites

In order to create a workflow, the system must first have a place established to house the workflow. This setup
only needs to be completed once on any system, and is likely to have already been completed. However, if the
System Setup tab does not have a folder that allows workflow children (as shown in the Step 1: Create a New
Workflow section below), then this initial configuration needs to be completed before any workflows can be
created. The steps for the configuration are detailed in the Initial Setup for Workflows topic.

Preconsiderations

Steps 1 - 3, and step 5, of workflow creation must all be completed in a single session in order to save the workflow
configuration. Therefore, care should be taken during initial configuration to ensure that the steps can be
completed and work is not lost.

Each of the items below must be true in order to save a workflow configuration:
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« Aunique ID must be specified for the workflow

There must be an Initial and a Final state on the outer level
All states must be reachable (e.g., there must be at least one incoming transition for each state)

» State IDs must be unique within the workflow
« All states must have an associated assignee, or a default assignee must be assigned to the workflow

Step 1: Create a New Workflow

1. Right-click the folder established to house all workflows, and select Create STEP Workflow.

i-[75] Status Flags

- (5] Web ULs

Match Codes and Matching Algorithms
[fi; COutbound Integration Endpoints

.[F] Uncategorized Setup Group

[fﬁi Workflow Profiles

m
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/5| Derived | (21
=¥ Object
r_=l Alte

MNew Setup Group...
Mew Business Action

Mew Business Condition

Create STEP Wurkﬂuwl

-7 Ass
_é B“I%
-
-G

[ STEP Workflow ” Bookmarks ]w

ol (i 32

X

LRNRER

Start Background Process to Monitor Deadlines

Cut

Copy
Paste

Delete

Ctrl+5hift+D

Ctrl+X
Ctrl+C
Ctrl+V

2. The STEP Workflow Designer will open. Additional information about the designer can be found in the STEP
Workflow Designer topic. For now, enter an ID and Name for the workflow.

STEP Workflow Designer - SampleWorkflow*

File Edit View

Workflow Properties

ID SampleWorkflow

MName | Sample Wnrkﬂnﬁ

Waorkflow Variables/attachments
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At this point, a 'container' has been created, to which states and transitions must be added to build the actual
workflow.

Step 2: Create States in a Workflow

A state represents an assignment to be completed, whether by a human or a system. When a new workflow is
created, it must have a single initial state at the outermost level, which is where any task entering the workflow will
begin. In addition, a single final state must be present at the outermost level to indicate completion of the workflow.
The indication of 'initial’ or 'final' for a state is considered a characteristic of the state. States can also have 'parallel'
or 'cluster' characteristics, which are required when workflows have parallel states and/or when a set of states
should be grouped together within a workflow (comparable to a mini-workflow within the overall flow).

For this example, we will create a basic workflow using three states: an initial state, a standard state, and a final
state. However, further descriptions of state characteristics, including more complex examples using parallel and
cluster states can be found in the State Characteristics in Workflows topic of the Advanced Workflow
Topics documentation.

1. To create the Initial State, right-click the canvas area and select Add > Initial State from the menu. The
Initial State is the first state that any object started in the workflow is placed into.

STEP Workflow Designer - SampleWorkflow*

File Edit View
Workflow Properties =

Sample Workflow

ID SampleWorkflow

e
Name | Sample Workflow [y Add Sl
: Initial State
Workflow Variables/Atachments 'E Edit Workflow |,\\¢
Final State
Recursive Auto-Layout Cluster State
Auto-Layout Parallel State

2. Inthe State Editor that appears, type the desired ID and Name of the state. Make sure that Initial under
Characteristics is checked, and close the dialog box by clicking the X" in the top right corner.
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State Editor

Edit

Comments Web UI Screen Mapping Mandatory Data
State On Entry On Exit Assignee Deadline/Escalation

ID Start

Name |Start
- Characteristics

Initial

[ ] Final

[ ] Cluster

[ ] Parallel

Show Edited State

Note that IDs can be revised as needed before the workflow is saved. However, because workflow business rules
are tied to state IDs, all state IDs are locked upon saving of the workflow.

State names are editable at any time, and can also be localized, allowing users to see differing names for the same
state based on locale. More information on this can be found in the Localizing Workflow State Names and
Events section of the Workflows documentation.

3. Create a second state by right-clicking the canvas and selecting Add > State.

[} Add > State
Initial State
S&] Edit Workflow
Final State
Recursive Auto-Layout Cluster State
Auto-Layout Parallel 5tate

No Characteristics need to be checked in the State Editor dialog box for states in between the Initial and Final
States.
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Edit

|
Do Wark
l

i :

ID

Ma

State

r Characteristics
[ ] mitial
[ ] Final
[ ] Cluster
|:| Parallel

Web UI Screen Mapping
Deadline/Escalation

On Entry On BExit

DoWork

me Do WnrH

Mandatory Data
Comments
Assignee

Show Edited State

4. Forthe last state, right-click the canvas area and select Add > Final State. In the State Editor box, fillin the ID

and Name accordingly, making sure that Final is checked under Characteristics. Close the dialog. The
workflow should now appear as pictured below.

=

Sample Workflow (SampleWorkflow)

[ Do Warlk ]

Finish

You have now created a basic workflow with three states. However, in order for tasks to be able to move through

the workflow, transitions must be added

between the states.
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Step 3: Create Transitions Between States

Transitions are needed between states in order for the workflow to be valid. Each state (with the exception of final
states in the outer level) should have at least one transition to allow tasks to proceed through the workflow. States
may have more than one transition, meaning there are multiple options for exiting the state. For example, users
may need the option to move a task to a subsequent state in the workflow, as well as returning it to a previous state

(e.g., to proceed or reject).

1. Hover over the center of the Initial State so that the cursor changes into a hand icon and a green box appears
around the state. Click and drag to the center of the next desired state until a green box encircles that state.

Release the mouse click to create the transition, which is then displayed as an arrow between the states.

2. Repeat step 1, but going in the opposite direction (e.g., click the second state and drag to the first).

Now there are two transitions going in opposite directions in the workflow. This allows objects to progress
forward in the workflow if approved or to be rejected and sent back to a previous state if needed.

3. Though they appear as a single arrow at this point, each transition is actually unique, which can be seen by
adding corners to each transition. To do this, right-click on the arrow and select Add Corner.
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S&] Edit Transition

> Delete

Add Corner

A green box will appear on the transition.

Click and drag the box to the right or left.

4. Repeatthe above steps to add a corner to the other existing transition, and to add a new transition between the
second and third states. When complete, your workflow should appear as shown below.

Sample Workflow (SampleWorkflow)

Do Work

e
Finish
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Step 4: Add Events to Transitions

While not strictly necessary, adding events to transitions can increase usability of workflows as the event names

are displayed to the end users. When a meaningful event name is applied, it provides an indication to the user of

what is occurring when they select to Submit a task in the workflow. When multiple transitions are present from a
single state, it is especially useful to have events applied so that a user can choose which selection to make (e.g.,
Proceed vs. Reject).

Events also enable advanced workflow options, such as applying business rules and logic to specific events. More
information on advanced functions is available in the Advanced Workflow Topics section of the documentation.

To add an event to a transition, follow the below steps.

1. Double-click the transition, select the Events tab in the Transition Editor dialog that appears, and then click the
Add Event icon button. Name the event accordingly and click OK.

= Sample Workflow (SampleWorkflow)

[ 1 Transition Editor e
Edit

Do Wark

| Finish

Events Condition On Transition Mandatory Data
Add Mew Events

Event | proceed 9

oK Cancel

Show Edited Transition

Note that if a space is put in the event name, the Designer will automatically replace the space with an
underscore within the editor. However, when the event is displayed to end users in the workbench or Web Ul,
the underscores will render as spaces.

2. Additional events can be added to the same transition, which can be useful when adding business rules to a
workflow. However, for this simple example, we will use only one event per transition so the Transition Editor
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should be closed by clicking the X in the upper right corner. Once closed, event names can be dragged on the
canvas to improve visibility if needed.

3. Repeat the above steps to add an event to each remaining transition, resulting in a workflow comparable to the
one shown below.

Sample Workflow (SampleWorkflow)

Note that multiple events within the workflow may have the same name.

You have now created a basic workflow, but in order to make it valid (which is required to enable saving of your
work), an assignee must also be specified for the workflow.

Step 5: Set Assignees

Each state in a workflow requires an assignee to be set, regardless of whether the state represents a human task
or not. The object-in-state relation must always be assigned to a STEP user or user group. This can be done one
of two ways: individual assignees to each state or a single assignee to the overall workflow. If states do not have
an assignee defined locally, they will by default always inherit the assignee defined by the workflow.

As the primary purpose of workflows is to assign tasks to varying actors in a controlled manner, each workflow
state that requires human interaction will generally have a different assignee (rather than using the workflow
default). In contrast, states that represent a system action or an automated state will often use the workflow
default, which can be set to an administrator user group.

There are several options for setting assignees in a workflow, including to set assignee dynamically based on
information on the object or previous actions taken in the workflow. For this example, the basic functions of
specifying a user or group assignee are described. More advanced assignee options are described in the
Assignees in Workflows section of the Advanced Workflow Topics documentation.

Once assignees have been set, the workflow should be saved:
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-=
ki Export .. =
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Save
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Save and Exit
nments
Exit
|

Set an Assignee for a State

All states with user interaction should have an assignee specified. To set the assignee locally for a state, double-
click the state, select the Assignee tab in the State Editor dialog that appears, click the Select User / Group
radio button, click the ellipsis button (|...)) to open the Assignee Selection dialog, select a user or user group, click
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Select to close the selection dialog, then click the X in the upper right corner to close the State Editor dialog.

=

Sample Workflow (SampleWorkflow)

ox

| | State Edito
Edit
Proteed Comments
State On Entry

() workflow Default

o E Do Work
‘ll' Assign Task to the

Web UI Scr
0On Exit

n Mapning
Assignee

Assignee Selection

Search

Mandatory Data
Deadline/Escalation

[ Finish 9 @ Select User/Group

Assign Task to selg

() Fetch from Variable
Assign Task to Use

O Executing User
Assign Task to the

Advanced

% Asset MGR

@ Brand

--@|Brand Managers}
-ﬁa Buyer Group

-%i Catalog Flagging
<

= Details

@ Select

Cancel

current State

When a user group is selected, all users in that group can access tasks in the state. When a specific user is
selected, only that user (or a workflow administrator) can access tasks in the state. It is most common to assign
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states to user groups rather than to individual users so that tasks can continue to be processed even if a specific
user is unavailable, for example when sick or on holiday.

When a state has an assignee, the letter 'A" with a circle around it will appear in the state:

If the assignee indicator does not appear, go to the View menu in the STEP Workflow Designer and check the
View Content Indicators option.

STEP Workflow Designer - SampleWorkflow

File Edit | View
Workdlow Pr . View Content Indicators E
ID SampleVWorkrow I

The above actions can be repeated until an assignee has been designated for each state in the workflow.
Alternatively, an assignee can be set for the complete workflow. When each state has an assignee (via individual
assignment or the workflow default), the workflow can be saved via the Save option on the File menu.

Set an Assignee for the Workflow

In order to save a workflow, all states must have an assignee specified. All states that do not have an assignee
explicitly specified will inherit the workflow assignee. Therefore, it is often helpful to have a default assignee
specified to ensure that the workflow can be saved at any point. In addition, it is common to use the workflow
assignee for states that are automated and/or the work occurring in the state is done by the system rather than a
user as in these cases the assignee is not a meaningful designation. Typically the default workflow assignee will be
an administrator user or group.

To set the default assignee for a workflow, double-click the title bar of the workflow, click the Select User / Group
radio button, click the ellipsis button (|...) to open the Assignee Selection dialog, select a user or user group, click

Select to close the selection dialog, then click the X in the upper right corner to close the State Editor dialog.
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!i Sample Workflow (SampleWorkflow)

[ 1 Workflow Editor @ e
Edit

Assignee  Status Flags
Workflow Default
Assign Task to the default Assignee specified for the Workflow e

ceinnee Salortis
g @) Select User/Group Assignee Selection

i

Assign Task to selected Soarch
Fetch from Variable o :ﬁi & [ -
Assign Task to User or -ﬁa Suppliers =,
i Systern Users v
() Executing User {: @ L 5
Assign Task to the Use : current State
& Details
Advanced
. e Select Cancel | —

When each state has an assignee (via individual assignment or the workflow default), the workflow can be saved
via File > Save.

Step 6: Set Validity

Before a workflow is fully functional, it must be made valid for the object type(s) that will use it. For example, ifa
workflow was made specifically to review and approve packaging objects and data, it might be made valid for
Each, Box, Carton, and Case.

To set validity, select the workflow from the System Setup tab, click the Validity tab, and check the appropriate
object type(s). Any number of object types can be selected within the same flipper.
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H Marmal » | STEP Workflow Editor |BGELLISM | Log | Status

-1 Order Process
@ Page Planner Flow
@ Pen Workflow
[E Pen Workflow Two
|1 Product Awaiting Asset
[E Publications
-] Publication Sections
EE}--@ Sales Item Creation
EE}--@ Sales Item Creation - original All
- 18] Sample Workflow Box
+-| 3| Sample Workdl
D% mPle au(d Business Unit Root
[ 13] Shipment Order Process r Buy Side
[+ 13| WF_Adding_Logic _
(B WF1 Case
@ Workflow3 il Discontinued Products
=P
aq | i I 3 Each

Step 7: Set Workflow Options

The final step in creating a workflow is to set the options available on the STEP Workflow Editor tab. These
settings are not required to be changed, but they provide valuable options for governing the behavior of the
workflow and should be considered as part of any workflow design.
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| System Setup < sample Workflo

E]"@ Ttem Creation o SR LT BTN T | alidiey || Log || Status
E]--@ Lead Pipe Plumbing Check Name s | » |Value
+}-| 13| Lead Pipe Plumbing Chedk 3
= %L Fad Fipe Flumbing Lhe > D SampleWarkflow3state
0 Law
@ MultiLineMsg Workflow * Name Sample Workflow
&[] My Workflow > Revision 0.5 Last edited by USERS on Mon Jul 18 11:14:34 EDT 2016
0 Norm > [Initiate automatically
E]--@ Order Process : :
@ Page Planner Flaw » Listen on updates from import [l
@ Product Awaiting Asset _ 1| * Use executing user's write privileges [l
@ Publications » Disable transitions on terminated Workspaces [l
@ Publication Sections E s Etort Condit
E]--[E Sales Ttem Creation rt-onditien
E]--@ Sales Item Creation - original ' Used Local Business Rules
E]"@ Sample Workflow | "ﬁﬂe » |513te > IS'I'EP Workflow Compon... » |Descriph'on » ‘
Bampile
() | Used Gobal Business Rules
e {5 Sample Workfow(2 . t State P Workflow C Descripti
> > ] > >
[+ 3| Shipment Order Process i | ’-ﬁ N | FTE oretiow Lompen. .. | =serption ‘
| m | F 'y

Initiate automatically - If checked, objects of the specified validity for the workflow are automatically initiated into
the workflow upon creation. This option is only applicable for object types for which instances of the objects can
existin the Tree (e.g., products, classifications, assets, entities, publications, publication sections, or planned
pages, but not for attributes or lists of values). This is useful for onboarding / creation workflows that are intended
to process new objects as the objects are automatically placed in the workflow upon creation, without any manual
initiation required.

Listen on updates from Import - If checked, the system will listen for updates on objects of the type specified by
the validity of the workflow and take action as needed. Specifically, an object can be transitioned from one state to
another upon update of the object via import. This is especially useful when completion of a workflow requires
information from another source system. As soon as that information is received, the task can be automatically
sent to the next state in the workflow. This function is only available for assets, classifications, entities, and
products and requires additional configuration to enable. Complete configuration is described in the Triggering
Workflow Events from Imports section of the Advanced Workflows Topics documentation.

Use executing user's write privileges - Option related to the execution of business rules in the workflow. If
selected, a user triggering the execution of a business rule will be prevented from making any changes or
accessing any data in the system via the business rule that he / she is not normally privileged to. For example, if the
user is not privileged to change a certain attribute value on an object, and the business action is configured to
make such a change, a privilege exception will be thrown and the action will not be carried out. Caution should be
used with this option as it can prevent desired business rules from being carried out and/or result in errors that the
business rule should be written to handle gracefully. If the option is not checked, business rule are run with full
access to carry out all indicated rules.

Disable transitions on terminated Workspaces - If selected, it will not be possible to perform transitions in
terminated workspaces (e.g., the Approved workspace). Typically this option should be checked as it will prevent a
user from submitting objects while in the Approved workspace. This is important as data cannot be modified in the
Approved workspace, submission of a task to a state often involves business actions, and workflow actions are
executed from the current workspace. Therefore, if a user is viewing data in the Approved workspace and
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attempts to submit an object from a state where submission involves the use of a business action, the user will
receive an error. Checking this option makes the submission unavailable, and therefore prevents the user from
receiving an unnecessary error.

Start Condition - Option available to specify a business condition that needs to be fulfilled before the workflow
can start. For example, if some basic data is required to be populated prior to initiation, a condition can be selected
to ensure that the required data is present. If the condition is not met (e.g., does not evaluate to true), the object will
not be allowed to enter the workflow.

Important: If users will be working with tasks within the workbench (rather than Web Ul), views and mappings
should also be configured following creation of the workflow. Instructions for this configuration are available in
the Views and Mappings section of the Getting Started with STEP Workflows material.

Duplicate a Workflow

Another way to create a workflow is to duplicate an already existing workflow. While there may be a number of
reasons for duplicating an already existing workflow, some of the reasons may include:

« The need to make changes to a workflow already in use. In duplicating the workflow, it is possible to make
changes to the new workflow and test these changes while still leaving the old workflow intact.

« The need to create a new workflow similar to an existing workflow.
Duplicating a workflow will result in the basic workflow structure and associated business rules being copied.

However, the global workflow options (Step 7 in the previous material) will not be copied and should be set
manually on the duplicated workflow. In addition, workflow-specific privileges are not carried over in a duplication.

To duplicate an existing workflow, go to System Setup and right-click on the desired workflow for duplication.
Select Duplicate. In the dialog that appears, populate the ID and Name, and click the OK button. The 'Duplicate
references' option is not applicable for workflows and can be left checked or unchecked.
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STEP Workflow Designer

This topic provides an overview of the STEP Workflow Designer, including descriptions of the various sub-editors
and visual indicators within the designer. It is intended to orient you with the interface and provide general
information for where to accomplish things in the designer, rather than to complete any specific task itself. When
applicable, links to more detailed task-oriented materials are provided.

Prerequisites

Itis expected that the reader is familiar with the Creating a Workflow topic.

Overview
The STEP Workflow Designer has the following primary areas:

Properties panel for setting ID and Name

Area for defining Workflow Variables/Attachments
Area for displaying Validation errors and warnings
Overview / zoom area

o s~ b=

Canvas where States and Transitions are defined

STEP Workflow Designer - ltemEnrich

File Edit View
Workflow Properties o = ttem Enrich (temEnrich) & ~
1D ItemEnrich
Mame | Item Enrich|
Workflow Variables/Attachments 9
StatusFlagDoWork! abe e
Statisrlgprh (_wweio ]
StatusFlagstart’ abi:
E‘ .x, Submit
+ ] E 9 k1 _—FRe-Submit—_
A : T K
Validation errors: Rejected
Enrich -
/] = -
e -
. Reject f,f’
Approve T
\l’
Fimal
Ll W
- >
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There are a number of dialogs that have many additional options and features that aid users in editing workflows.

Each dialog and the general functions of the included tabs are described below.

Workflow Editor

To edit in the Workflow Editor, double click the canvas region. The workflow editor is used to make changes that
are global for the workflow, including setting the default assignee for the workflow and enabling status flags for the

workflow.

Worlkflow Editor

Waorkflow Default
Assign Task to the default Assignee specified for the Workflow

(®) Select User/Group |Super Users (Super user) ||Z|
Assign Task to selected User or Group

Fetch from Variable
Assign Task to User or Group read from Workflow Variable,

i) Executing User
Assign Task to the User performing the Transition into the current State

| Show Edited State
Tab Available Functions
Assignee Tab Modify the assignee for the entire workflow. See Workflow State Editor Assignee Tab
Options.
Status Flags Status Flags can be added and removed. See Status Flags.
Tab

State Editor

The State Editor is launched when the user right-clicks on the canvas to add a state, or when a user double-clicks
on an existing state. This editor enables users to make changes specific to a particular state.
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State Editor

Edit

Deadline [Escalation Comments Web UI Screen Mapping Mandatory Data
State On Entry Oin Exit Assignes

D State-2
Mame |Enrich

- Characteristics
] Initial
[ ] Final

[] Cluster

[ Parallel

Show Edited State

Tab Description

Assignee Assignees can be added / removed / modified per state. See Assignees in
Workflows.

Comments Comments can be added / removed / modified. Comments have no explicit function and

are not viewable outside of the designer. However, they can be useful to make notes for
designers regarding a particular state (e.g., intended function, considerations when
modifying, etc).

Deadline/Escalation | Setdeadlines and add / modify / delete associated escalation business rules. See
Deadlines and Escalations.

Mandatory Datatab | Set attributes, attribute groups, and/or references that are required to be populated
before a task can leave the state. See Mandatory Attributes and References in
Workflows.

On Entry Add/ modify / delete business actions that are run on entry to the state. See Business
Rules in Workflows.

On Exit Add/ modify / delete business actions that are run on exit from the state. See Business
Rules and Workflows.
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Description
State Change the name or characteristics of the state. See State Characteristics in
Workflows.
Web Ul Screen Provides a link to the Web Ul to map the state to a specific Web Ul screen. From the
Mapping dropdown, select the Web Ul that should have access to the workflow, and click the Edit

button. This will launch the login page of the Web Ul. The user must have privileges to
edit Web Ul configurations and if so, logging in will open the designer to the Screen
Mapping properties with conditions to map to the workflow state pre-populated. The
user can then select an existing screen to map the state to. More information on
mapping Web Ul screens can be found in the Main Properties topic of the Web User
Interfaces documentation.

Transition Editor

The Transition Editor is launched when the user double-clicks on an existing transition. This editor enables users
to make changes specific to a particular transition.

Transition Editor

Add New Events
Submit

| Show Edited Transition |

Tab Description

Condition | Add/remove / modify business conditions on the transition. See Business Rules and
Workflows.

Events Add/ remove / modify events on the transition. See Auto Routing Tasks in a Workflow.

Mandatory | Set attributes, attribute groups, and/or references that are required to be populated before a task
Data can take the transition. See Mandatory Attributes and References in Workflows.
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Description

On Add/remove / modify business actions on the transition. See Business Rules and Workflows.

Transition

Visual Indicators in STEP Workflows

Several visual indicators are present to allow users to quickly gather information about the workflow without
having to open a particular state or transition.

Indicator Description

transition line

‘Al A assignee has been specified for the workflow or state. See Assignees in Workflows.

'D' A deadline has been selected for the state. See Deadlines and Escalations.

I' An 'On Entry' action is present on the state. It may help to remember this as'l' for 'In’' (e.g.,
into the state). See Business Rules and Workflows.

'O An'On Exit' action is present on the state. It may help to remember this as 'O’ for 'Out'’ (e.g.,
out of the state). See Business Rules and Workflows.

'P' Specific user privileges have been granted for the state. See Editing Privilege Rules.

Dotted A condition has been placed on the transition. See Business Rules and Workflows.

Rounded end An action has been placed on the transition. See Business Rules and Workflows.
on transition
Blue color The state has the Final characteristic. See State Characteristics in Workflows.

Dark gray color

The state has the Initial characteristic. See State Characteristics in Workflows.

Light blue / gray
color

The state has the Cluster characteristic, or no characteristics (e.g., standard state). See
State Characteristics in Workflows.
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Views and Mappings for Workflows

While not strictly necessary, if users are going to work with workflows in the STEP Workbench, it is generally
recommended to create views and mappings for the workflow. This ensures that users have access to the right
information to complete their tasks and streamlines the work process. However, users can also use the standard
editors available on objects in the Tree if desired, using the Workflow navigator only to submit tasks rather than to
review and edit data.

When a workflow state is selected in the STEP Workflow navigator tab, the information that displays is called a
view. The act of applying that view to a particular state in a workflow is called mapping. When configuring a
workflow it is important to decide what data is visible for objects (views), and define which states to display
(mappings). Without views and mappings configured, all states in the workflow are displayed on the STEP
Workflow navigator tab (including parallels, clusters, and final states). Additionally, just the ID of the objects in the
selected state display in the STEP Workflow ltems editor or the Task tab on the object.

Upon mapping views to states, only the states for which a mapping exists will be displayed in the STEP Workflow
navigator tab. The configured views will be used in the STEP Workflow Items editor and on the object's Tasks tab.
This allows for customization, so if a user wanted to show only human-related tasks, they can leave out mappings
for any states, parallels, or clusters that are not human tasks. Additionally, the sequencing of mappings determines
the order in which the tasks are displayed in the STEP Workflow tab.

STEP Workflow L 4 STEP Workflow Items
Prafile SRR GT T GITR L S | Producks || References || Reference
—-—rq:r-.-:rrm—
@ Product Awaiting Asset ~ » |Mame » \Description Source > |D)
©- pSupplier Workflow Edit
@ publications 207144 > 135828 207144 Editor! xmL
2= publication Sections
o =g B view: Start
= \ &) Aspect: id

= Sales Item Creation - original &) Aspect: name
== sample Workflow 20714-D > (135831 207140 i ™ [T Attribute group: ItemDescriptionInformation
'? Sample Workflow |:| & view: Do Work
@rtalisa) S

----- - [27] Attribute group: ItemPricingInformation
Filter |3 Collection 0714E » 1135832 20714E = . View: Finish

----- in Aspect: name
Start & ;
- s [F7) Attribute group: ItemDescriptionInformation
Do Work C— 1 L B3] Attribute group: ItemPricingInformation
Finish L | | e e S B I "@ Mapping : Start-»5tart
@ Shipment Order Process 20714+ » 135833 20714-F E Mapping : Do Wark->Do Work

@ [leer Weh M Warkfow (| E Mapping : Finish->Finish

Note that while views and mappings can be applied to a blank workflow canvas, it does not generally make sense
to do so. Therefore, it is expected that a workflow has been created prior to any views or mappings being applied.
See the Creating a Workflow topic for detailed instructions on workflow creation.

Before creating views or mappings, it is important to be aware of the following points:

« The views and mappings configured in the STEP Workflow Designer only apply to workbench and not Web
Ul. Views in Web Ul are defined by the configuration of the screen. If users will not be interacting with
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workflows in the workbench, it is not necessary to configure workbench views. Instead, see the Workflows
in Web Ul section of the Web User Interfaces documentation.

« A view can contain both object and workflow-specific data. This means that a view can contain attributes,
attribute groups, and aspects information specific to the object (such as name, ID, approval status, etc) as
well as elements like workflow assignee, deadline, workflow variables, and workflow attachments.

« Aview can be mapped to multiple states. For example, if a state is assigned to a particular user or group
early on in the workflow to edit data, and again later in the workflow to review data, it is possible that the
same data points should be available to them in each state. In this case, the view only needs to be configured
once, and that view can then be mapped to each applicable state.

« Once aview or mapping has been started for a workflow, even if they are then deleted to be completed at
another time, no states will show in the STEP Workflow tab until views and mapping are completed.

The details for configuring views and mappings are covered in the subsequent topics, Configuring Views for
Workflows and Configuring Mappings for Workflows topics.
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This topic details how to configure views for states. Without views configured, end users will only see the ID of
objects in a workflow when accessing tasks via the STEP Workflow navigator tab or the Tasks tab on the object.
Therefore, if users will be interacting with the workflow in the STEP Workbench, it is recommended to have views
in place so that the user can easily see the data points relevant for their tasks in that state.

The steps below describe how to create views for a workflow accessed in workbench, and provide reference
material for the various view options.

1. Tobegin creating views, select the desired workflow in System Setup, and open the STEP Workflow Designer
by going to Edit > Edit Workbench Views and Mappings.

STEP Workflow Designer - 11123

Edit Workbench Views and Mappings
Localize State Mames and Events
Edit Event Mandatory Settings

Edit Audit Action

File  Edit View
Wor 1= Undo yment Order Process (11123) & -‘*
iln]
ﬂ Redo
Marr
45 Cut
War Procesd 1
s IE Copy
stats Paste | Error
T
stat o -
Delet
' EIEte Confirm data
o
Y Select All Proceed_3
Select Mone

2. When the View Editor opens, it will be blank. Right-click on the left side of the panel and select Add View.
Provide an ID for the view.
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View Editor
Edit
Editor = xmL
Add View {
Edit
Editor xmL
----- View: Initial Data View
ID |Initial Data]
Sorton |0

[] Sort Columns Automatically
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3. Once aview has been created, columns can be added by right-clicking on the view, selecting Add Column,
and choosing a type of data to add to the view. As many columns can be added as needed to provide all
necessary information to the user.

View Editor
Edit
Editor xmL
..... View: Initial Pot= [ i
Add Column * Attribute
Attribute Group
Delete
[ Aspect
Component

The Attribute, Attribute Group, and Aspect options are all for displaying object data, while the Component
option is for displaying data specific to the workflow task (e.g., a workflow variable, attachment, assignee, etc).

The below sections describe the various view options in more detail, as well as how to reorder columns within a

view.

Important: For views to take effect, each view must be mapped to one or more states. For details on mapping
views, see Configuring Mappings for Workflows.
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Attribute

The 'Attribute’ column type is used to insert a single attribute into the view. The validity of the attribute must match
the validity of the objects in the workflow, or else the attribute will not be displayed in the view. Additionally, if
working with specification attributes on products, the attribute must also be linked appropriately in the hierarchy to
be valid for the workflow objects.

An attribute can be configured as 'Read Only' and/or 'Mandatory'. Attributes marked as 'Read Only' are not
editable on the STEP Workflow Items or Tasks tabs. The 'Mandatory' setting will give a visual indication that the
attribute is required by showing an asterisk (*).

To add an attribute to a view, right-click on the view > Add Column > Attribute. Click the ellipsis button (E) to
select an attribute, and mark the Read Only and/or Mandatory options as needed.

View Editor

Edit

Editor ML STEP Workflow Items [ Products ” Refel

=& view: Initial Data .
: _ Attribute |Date Ti te
i EE Column:Object (DeDuplicatio. .. o | ate Time (Date) ||Z|
EE Column: whn.ﬂ.pmued'«' (Workflow [ ] Read Cnly
1 b
----- o EE Cnlumn WQrkﬁnwDeadllne {Wark [v] Mandatory
£ >

It is worth noting that if a field is highlighted in red, this means that the value is mandatory for approval of the object,
independent of the workflow or state. This type of mandatory is set on the attribute by setting Mandatory = Yes. As
with the mandatory indicator in the view, this does not force the user to populate a value within the state.

STEP Workflow Items

STEP Workflow Items R0 s | ReFerencesl Referenced By

* |Name ¥ |Description, Webh  >|PvP = * |Multiplayer
80's Slasher Game » 131542 80's Slasher Game 1 1 Mo
Space Adventure Game * (131536 Space Adventure Game -16 Players Mo

Attribute Group

The 'Attribute Group' column type is used to insert all attributes in a group into the view. The same considerations
apply as for a single attribute, described above.
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Aspect

Via the Aspect option, it is possible to insert columns for ID, name, object type, revision, and other basic data for
the object.

To add an aspect to a view right-click on the view > Add Column > Aspect. Click the appropriate radio button for
the desired aspect. A full description of what each aspect option is can be found in the table below.

View Editor
Edit
Editor xmL
EI-- View: Aspect
i i-El Ty @id
() name
() object type
() revision
(O path
() approved
() translation

() indesign_template

() quark template

Aspect Description

id Displays the ID of the object, which is not editable.

name Displays the STEP Name of the object, which is editable if privileges allow.

object type Displays the object type of the object. If privileges allow for editing, a dropdown
is present from which valid object types can be selected.

revision Displays the revision number, as well as when the object was last edited and by
whom. The field is not editable.

path Displays the path of where the object exists in STEP. The field is not editable.

approved Displays the approval status of the object and date / time of last approval if

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 44



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

Aspect Description

applicable. The field is not editable.

translation Displays the translation status of the object, for example: Up to date, In
Progress, Not Translated, etc. (not editable). For more on translations, see the
Translations documentation.

indesign_ Displays the STEP Publisher product template being used for print. By clicking
template on the hyperlink, the user is brought to the template.

quark Legacy option that should not be used in current implementations.

template

Note that Unique Key is not a selection option. If it is required to display the key value of an object, the attribute(s)
driving the key should be selected using the Attribute or Attribute Group options.

Component

The Component option gives access to a list of data specifically related to workflows, including assignee, workflow
attachments, workflow variables, etc.

To add a component to a view right-click on the view > Add Column > Component.

Populate the Title (header for the column in the view), select Read Only or Mandatory as appropriate, and select
a component from the dropdown. Note that selection of a component may result in additional selection options.
For example, selection of Workflow Variable yields an additional dropdown to select the specific variable to be
used. Each component option is described in detail below.

View Editor
Edit
Editor xpL
EI-- View: Companent
€ [column:Reason for Rejecti... | Title |Reason for Rejection
[]read Only
[ Mandatory
Companent | WaorkflowVariable w
Variable = ReasonForRejection L
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Read Only and Mandatory fields are not applicable on all components and are disabled in that case. When
available, fields marked as 'Read Only' are not editable on the STEP Workflow ltems or Tasks tabs. Checking
'Mandatory' means that an asterisk (*) is shown with the Title to indicate to users that the field should be populated.
However, it does not enforce that the field is populated prior to the task exiting the state.

DeDuplication

Adding the DeDuplication component to a workflow view allows a user to see if there are any objects in the system
that have been flagged as potential duplicates by a matching algorithm.

View Editor

Edit

Editor xmL

=& view: Initial Data

- EJ& Column:Object (DeDuplication)

- Ej& Column:Wha Approved? (WorkflowVariable
[T Attribute: Date

- Ej& Column:Workflow Deadline {WorkflowDead
- Ej& Column:Attachment 1 (WorkflowAttachmer
- B Column: (WaorkflowaAssignes)

- 2 Icolumn:DeDuplication (DeDuplication)
_E_. View: Review Data

Component
Title

Component

DeDuplication

Read Only

Mandatory
DeDuplication
Mo Configuration Required

If potential duplicates have been identified, a Duplicates button is present that the user can click to access a list of
possible duplicates for the selected object in the workflow. Clicking the Differences button opens a Compare
screen where the user can view differences and confirm or reject duplicates.
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STEP Workflow Items

Praofile PRV T TR B | Multi Editor || References || Referenced By

°'_ WarkflowVariable (Variable=MatchingAlgorithmID) > [DeDuplication > [Name >
o CantactOnboardng for SelFSenviee. | | ; Indviduabatching Dupicstes | Samanthabooman | o
@ Suppler Mantenance for Centralzed SefServie || 1oguiguatratch
s IndividualMatching Robert Mccafery
- Duplicates
& [ Resalve possible duplicates. e
(=
(@ (251030) is possible duplicated by these objects, Please resolve manually.
&~ 252248 (252248) 54 | oifferences

=k

|Fi|ter by Collection

K3

Matching Algorithm Criteria Close

Clerical Review

— Mame > |Score (%) »

o CercaReveworgonaaten | s

>
oomRemisee e e

> Total 54

E Jonathan m Schultz

- (231030) (252245) E Rose Morales

=1 [All Elements] .
& D 251030 252248 Details... E Susan Lotock y
& Iﬁ Name Details... |
e |- Attributes

- | - Bl References

dy

| ExpandAl | Collapse Al |

[ Hide 1dentical Rows

| Confirm Duplicate || Reject Duplicate || Cancel |

For additional information on deduplication workflows, see the Matching, Linking, and Merging documentation.

DTP Task Info Provider

Component that can be used if a user wishes to show task data in the InDesign plugin tasks tab. It will not be
rendered in the workbench. The Variable ID will be used for value-name and the column Title will be description.
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Editor xmL

mmmmm

£

=1-[=] View: Initial Data

- EJ8 Column:Object (DeDuplication)
- E Column:Wha Approved? (WorkflowVariable]
(] Attribute: Date
- E8 Column:Workflow Deadline (WorkflowDeadli
- Ej8 Column:Attachment 1 (WorkflowAttachmen
- Column: (WorkflowAssignee)

- Ej8 Column:DTPTaskInfoProvider

E- . View: Review Data

|- view: Confirm data

EI-- View: Approve Data

EI-- View: Items packaged

- & view: End State

-2 Manninn : Tritiate Nata-=Tnitial Nata

Component
Title

Compaonent

Variable

OTPTaskInfoProvider

[] Read Only
[ Mandatory

COTFTaskInfoProvider w

This column will not appear in the Workbench View. When
applicable the Variable value wil be send as Task info to a OTP
system. The Variable ID will be used for value-name and the
column Title will be description.

Pluginable Cell Debug
Experimental debug option that generally should not be used.

Pluginable Cell Primary Image

Component for displaying the primary image of the object.

Edit

View Editor

Editor XML

£

[=E . View: Initial Data

- EJ8 Column:Object (DeDuplication)

- E Column:Wha Approved? (WorkflowVariable]
(] Attribute: Date

- E8 Column:Workflow Deadline (WorkflowDeadli
- Ej8 Column:Attachment 1 (WorkflowAttachmen
- Column: (WorkflowAssignee)

- EJg Column:PluginableCellPrimaryImage

[ . View: Review Data
[+-=] View: Confirm data

Component
Title

Compaonent

PluginableCellPrimaryImage
Read Only
Mandatory

FluginableCellPrimaryImage -
Mo Configuration Required
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Approved * [Translation Primary Image
Comfy Bed twin x Last Approved on Tue... Mot Translated
Comfy Bed double x Mever Been Approved Mot Translated
Comfy Bed California King x Mever Been Approved Mot Translated

The component displays a thumbnail of the primary image. Note that the image and reference are both not
editable (e.g., images cannot be added or removed using this component).

The reference type used to identify the primary image is set in System Settings (System Setup > Users & Groups
> Primary Image Type). The STEP ID of the reference type that should be used must be entered in the Value field.

System Setup
[+-[5] Event Processors
r-[[5] Gateway Endpaints
- (55] GDSN
H-[5] Global Business Rules
r-[5] Inbound Integration Endpoints
- [75] Match Codes and Matching Algorit
rl-[75] Outbound Integration Endpoints
H--[F5] Web UIs
F-[75] Workflow Profiles
H-[55] Workflows
-] Derived Events
]%’ Object Types & Structures

]% Tags

g I o O R o RO oy A sy B oy I sy O g |

Reference Types

H-fifj/] Table

rl- {5 Keys

:IIi Event Queues

|- (B Component Models

7575 Recyde Bin

[y OO O s OOy O OO e ] ey e OO s O

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021)

o System Settings Log

m
‘

Value

imaryProductimage

I * Primary Image ReferenceType
L

49



Vendor

T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

Vendor is used to display the name of the vendor / supplier that the object is assigned to. This is typically used for
systems that have a Supplier hierarchy in place. More information on this setup is available in the Supplier Web
Ul Setup Guide in the Web User Interfaces / Web Ul Getting Started documentation.

Yiew Editor

Edit

Editor xpL

ITI

=& view: start

ifj Aspect: id

ifj Aspect: name

-[Z31 Atiribute group: ItemDescriptionInformatior
-[231 Atiribute group: Subscriber

- EJ§ Column:Status Flag (Workflowvariable)
&%) Aspect: object type

ifj Aspect: revision

ifj Aspect: path

ifj Aspect: approved

ifj Aspect: translation

- EJ§ Column:Primary Image (PluginableCellPrimar

. B2 [Column:Vendor (Vendor)]

-2 view: Do Work

Component
Title [vendor

Read Only
Mandatory

Component Wendor

Mo Configuration Rjuzc

STEP Workflow Items

R VET G DIV B | Producks || References || Referenced By |

Translation ¥ |Primary Image Wendaor
Comfy Bed twin * Mot Translated Products Galore
||
Comfy Bed double * Mot Translated
Comfy Bed California King * Mot Translated

The component displays the name of the supplier classification folder that the object is linked to (object will be in
the Products sub-folder), using the reference type indicated in the 'Link type for vendor classification to product
link' system setting.
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System Setup < System Settings
# £3 Atrbute Groups [ system settings [JE0

5 At rarsfomators COmsfawndemdysenss
w-[#2] Action Sets
F1- ] Contexts ©-Image &Document Settings

nesign Quee G- Assetpushattrbute macrokeys
Lists of Values fLOVs
-] Change Packages © Calaated Attribute Setngs
() Complateness Metrics - Cryptographickeys
(+I-(f5] Event Processors
- (] Gateway Endpoints C-Validation Templates
o cosn @ Product Information Manager Default Settngs
[+-(75] Global Business Rules
F#}-(5) Inbound Integration Endpoints © Translation Settings
o o Cotes o ot st 1| e ESatigs
@ COutbound Integration Endpeints
-2 web Ui Swebsees
@ Workflow Profiles
- £ Workflows @ Webursettings
Derived Events Mame * |Value
{ﬁ’ Object Types & Structures » Default context Contextl
% Tags » Default workspace Main
- unis e _
% E > |WEb LI supplier dassification object type Suppliersfoot
.’h Reference Types > Web UL supplier products dassification object type SuppliersProducts
+ 43 Workspaces > |Assets dassification object type SuppliersAssets
g :;:HE » Batches dassification object type
- Y8
Ii Event Queues * Batch dassification object type
E Component Models » Excel-template asset QuickSheetTemplate
-7 Recyde Bin * Proof view stylesheet attribute
» Step-users Web UI batches folder SuppliersBatches
* Step-users Web UI assets folder SuppliersAssets
* Context Help metadata atiribute Attribute Description
* Link type for vendor dassifiction to product link SupplierLink
* Enable all-view for users that are a member of multiple mpplierﬂ\"
Workflow Assignee

Used for displaying the current assignee and/or letting users with the STEP Workflow Administrator privilege re-
assign the current task to another user / group.

If to be used for re-assigning, either the User Groups or Users parameter (or both) must be populated.
Selections will be the available assignees.
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If the Expand User Groups checkbox is selected, all users in the selected user groups will be available for

selection / assignment (as well as the user group itself). Note that when a privileged user selects a user / group to
re-assign the task to (in the STEP Workflow Items editor or on the object Tasks tab), the re-assignment will occur
immediately, and the task might disappear upon refresh.

The Output Var parameter can be used to select a workflow variable to write the public ID of an assignee. If a
selection is made, when an end user populates the cell, no reassignment takes place and no special privileges are
required. The use for this is that a user is able to select a 'future’ assignee - the actual assignment must be done
later by a business action that looks up the assignee using GroupHome / UserHome. If the same ID is used on
both a group and a user, the component will use the group, as it's found first.

Yiew Editor

Edit

Editor xpL

=[5 view: Initial Data

- Ej& Column:Object (DeDuplication)

- Ej& Column:Who Approved? (Workflowvariable)
(] attribute: Date

- EE Column:Attachment 1 (WorkflowAttachment)
- EJ& Column: (Workflowassignee)

- EE Column:Workflow Deadline (WorkflowDeadiine]

- B [Column:WorkflowAssignee (WorkflowAssignee

-&] view: Review Data

-& view: Confirm data

-&] view: Approve Data

- & view: Items packaged

& view: End State

----- E Mapping : Initiate Data-=Initial Data

----- E Mapping : Review Data->Review Data
----- E Mapping : Confirm data-=Confirm data
..... ‘El Mapping : Approve Data->Approve Data
----- 15 Mapping : Items packaged->Items packaged
----- 5 Mapping : End State->End State

mmmmm

Component
Title

Component
Output Var

User Groups

Users

WorkflowAssignee
[ ]Read Only
[ ] Mandatory

WorkflowAssignee

[ ] Expand User Groups
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STEP Workflow Items [ Products ” References " Referenced By

ary Image * [Vendor * |Assignee >
Comfy Bed twin Products Galore Group : Super Users -
Comfy Bed double > I ser : user -
Comfy Bed California King » Lser : USER
ser @ User 2
IJger : User 3 | ﬂ
User @ User 4
ser @ User 5
ser @ User &
User @ User 7 57

For more on Assignees and the description of the various options for the Workflow Assignee component, see the
Assignees in Workflows topic in the Workflows documentation.

Workflow Attachment

A component that lets users add, open, download, and delete Workflow Attachments. Use of this requires that a
Workflow Attachment has been previously set up in the STEP Workflow Designer (and saved) so that it can be
selected in the Attachment dropdown.

STEP Workflow Designer - SampleWorkflow3state™

File Edit View
Waorkflow Properties . .
P View Editor
D SampleWorkflow3state .
Edit
Mame | Sample Workflow (3states) Editar ML
Workflow Variables/Attachments =-& view: Start Component
-] Aspect: id
IAtIBchment' i ﬂl % Aspect: name Title |Attachment
StatusFlagDoWerk' abe -3 Attribute group: ItemDescriptionInformation []Read Only
e - |'='_°|_ Attribute group: Subscriber [ Mandatory
- Eg Column:Status Flag (Workflowvariable)
StatusFlagStart’ b v b
=g=tar = &) Aspect: object type Component WorkflowAttachment v
in Aspect: revision
. Attachment |Attachment
B [X] = Gapectpatt P -
&% Aspect: approved
Validation errors: i}j Aspect: translation
- Ej& Column:Primary Image (FluginableCellPrimaryIn
- Eg Column:Vender {Vendor)
- Eg Column:Assignee (WorkflowAssignee)
- Eg Column:Attachment (WorkflowAttachment)
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STEP Workflow Items =i
A ISR DITR T BN | Products || References || Referenced By
Prirmary Image * Vendor * |Assignee *Jattachment H
red ¥ Group : Super Users | ... |;|

T-Shirt M Burgundy Relaxed Fit * Group : Super Users | ...

ALRM-01 45676 >

| Burgundy Tshirt

File name: |E'.urg|un|d1,r Tshirt.png | | Open

E Files of type: | all Files >

:

For more information on Workflow Attachments and the features in this component, see Workflow Attachments
in the Workflows documentation.

Workflow Deadline

Users with the STEP Workflow Administrator privilege will be able to set, edit, and delete task deadlines. Users
without the privilege will see different icons depending on whether the deadline is reached or not. Deadlines will be
displayed when a user hovers over the icons.

Note that the editability of the deadline field is determined solely by privileges, and therefore the Read Only setting
is not applicable for this component.
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View Editor

Edit
Editor xmL

=& view: Initial Data

- EJ§ Column:Object (DeDuplication)

- EJ§ Column:Who Approved? (WorkflowVariable
-] Attribute: Date [|Read Only
- EJ§ Column:Workflow Deadiine (WorkflowDead

Component
Title | WorkflowDeadline

- EJ§ Column:attachment 1 (WorkfowAttachmer [ Mandatory
- EJ& Column: (WorkflowAssignee) Component |WorkflowDeadline o
- ElE buhlm sWorkflowDeadline (WorkflowDeadli

- . uErew Review Data g Mo Configuration Required

£ >

STEP Workflow Items

) LR G G TR | Producks || References || Referenced By |

* |Assignes » |Attachment » |Deadline ¥
Comfy Bed twin * | iGroup : Super Users |;|
Comfy Bed double * | Group : Super Users
Comfy Bed California King » | JGroup : Super Users "'.1.' Date Picker

Year: Month:  Day:

2016 s jul | |27

Hours: Minutes: Seconds;

11 45 a3

Cancel

For more on this see Deadlines and Escalations in Workflows in the Workflows documentation.

Workflow Linked Name

Component for displaying the object name as a link to the configured object editor. When the component is
selected, default values are populated, which takes the user to the standard editor for each super type of objects
(e.g., the Product tab in Tree view for "blue" objects in STEP). However, these default values can be edited so that
the user is directed to another tab when clicking the hyperlink in the view (e.g., to the References tab or Images &
Documents).
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Wiew Editor
Edit
-] View: Initial Data Component
- Column:Object (DeDuplication]) Title |WorkfowLinkedName
- E& Column:Wha Approved? (WarkflowVariable
(] attribute: Date Read Only
- Eg Column:Workflow Deadline (WorkflowDead
- Eg Column:Attachment 1 (Workflowattachmer Mandatory
€ Column: (WorkflowAssignee) Component | WorkflowLinkedName v
- E [Column:WorkAowLinkedName (WorkfiowLin
Gl . View: Review Data Product Editor |Product
(#-[=] View: Confirm data Classification ™ | Classification
[-[= view: Approve Data
i1-&] view: Ttems packaged Asset ™ | Asset
[+-[& View: End State Entity ™ |Entity
----- E Mapping : Initiate Data-=Initial Data _ _
----- 5] Mapping : Review Data->Review Data Attribute * | Attribute
----- 5= Mapping : Confirm data->Confirm data Y | Planned Page ™ Plan
£ >

For example, to change the default landing page to be the References tab of the product editor, go to the desired
editor, choose the desired tab, and look at the STEP URL field. In this example, the tab is named
'ProductReferences’.

| | Context | English US

- g 6 c URL |ct?editor=ProductReferencesfcontextid=Context

r—
EI r_=| Primary Product Hierarchy (Prc = Product || Sub Products PUAEEENEE Referenced By | Images & Documents || Commercial [

E} 7] Products {ProductsRoot) @ Index Words
- ) Apparel (18200) | [inherited From > lIndex >

Type 'ProductReferences' for the Product Editor parameter and save the changes to the workflow.

Wiew Editor
Edit
Editor xpL
=] view: Initial Data Component
+ EE Column:Object (DeDuplication) Title |WorkflowLinkedMame
- EJ& Column:Who Approved? (Workflowvariable
~[1F Attribute: Date Read Only
- B8 Column:Workflow Deadline (WorkflowDead
- Ej& Column:Attachment 1 (WorkflowAttachmer Mandatory
- Bl Column: (WorkflowAssignee) Component | WarkflowLinkedName e
- EJE bni.lm sWorkflowLinkedMame (WorkflowLin _
& . View: Review Data Product Editor |ProductReferences
i-[=] View: Confirm data Classification ™ |Classification
_EEI-- View: Approve Data

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 56



1STIBOSYSTEMS

e MASTER DATA MANAGEMENT

Display the STEP Workflow Items tab and click the name link to display the configured tab within the
STEP Workflows editor.

[ Products ” References ” Referenced By ]

>JLink >

Comfy Bed twin ¥

Comfy Bed double >
Comfy Bed California King

Commercial |Tables Eategury Profile |

| STEP Worlflow Items ” Praoduct ” Sub Pr:;ducts ] R-:I"-:r-:;m-:s [ Referenced By ” Images & Documents ]

& Dronedrodcblonenencs) 4
?

Reference Type w| * [Target =
* |Supplier Link +
> |website Link + ol

® PoamentReferencss)

Workflow Note Column

Component for displaying the most recent Process Note or Transition Message. If not configured as Read Only, a
new note can be added, and will persist throughout the workflow. If the field is hovered over in the end user view,
the configured number of recent entries entered in the Max Entries field will display. Along with the message, the
user info and time-stamp will also show.
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Wiew Editor

Edit

Editor  xmL

Eé Column:Vendor {Vendor) A | Component

E; Column:Assignee (WorkflowAssignee) Title | WorkfowNoteCalumn|
- E|g Column:Attachment (Workflowattachment)
- E]g Column:Deadine {WorkflowDeadline) [L]Read Only
- E]& Calumn:Link (WorkflowLinkedame)

- E]g Column:WorkflowNoteColumn (WarkflowhNor
- € Column: (WorkflowPlannedPage) Component | WorkflowNoteColumn v
- E|g Caolumn: (WorkflowvariableUserList)
- E|g Caolumn: (WorkflowTaskColumn)

E; Column: (Workflowvariable) [] Show Transition Messages
- E|g Column:Release Date (Workflowvariable)
- & Column:WFVarUserListWithoutGroup (Work v Show Process Notes

< >

Mandatory

Max Enfries |5

WorkflowMoteColumn (... * [WorkflowPlannedPage > WorkflowVariableUserLi... * WorkflowTaskColumn » WorkflowVariable (Varia. ..

Meed to check price
against quantity - sold 't]

Pink & Blue Owl Party Hat * as pack of 12 but price L™ ~ o

seems to be for each
12:29:40 24 Oct 2016 USERE : Meed to check price against quantity - sold as pack of 12 but price seems to be for each
12:28:57 24 Oct 2016 USERE : Primary colors listed are incorrect, please resolve
12:28:15 24 Oct 2016 USERE : Please review the image for whitespace

The Show Transition Messages and Show Process Notes parameters are used to define the types of notes
displayed. Care must be taken when making these selections as they significantly impact the user experience.
Typically, only one option will be selected, as appropriate for the intended use.

« Show Transition Messages: Check this if a message is provided at the time the task is submitted, and the
next user should see that message. If no message is provided at the time of transition, a transition is still
logged, though without a message (e.g., time, date, and user can be seen upon hover but no corresponding
message is displayed). The intent of this is for serial workstreams where one user will need to see a
message entered from the immediately preceding user, but is unlikely to need to see previously entered
messages from those further upstream. Therefore only the message entered by the last user is displayed in
the view.

o Show Process Notes: Check this if users will enter notes while working with tasks, and the notes should be
visible to the next user. The intent of this is that the current user needs to pass information to one or more
subsequent users, and they enter the message while working with the task (e.g., prior to submission). The
most recently entered note will always be available in the direct view, with additional notes available upon
hover.

« Both: Use caution when selecting both parameters in the same column. The most recent transition
message is always displayed in the view (if no message was entered, the view displays no value). Any notes
entered outside of the submit message are only available upon hover (even if a transition message was not
provided). If a transition message is always provided, this can be a valid setup. However, if transition
messages are not guaranteed, it can appear to the end user that no messages are present, when in fact
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process notes have been provided. If both process notes and transition messages need to be available, it is
recommended to add the column to the view twice with only one parameter checked in each so that both
process notes and transition messages are shown independently.

Workflow Planned Page

Component that can be used in workflows valid for Planned Pages. It will show a thumbnail of the plan, Sticker
book, or Mounted pages (as directed by the View choice parameter), and links directly to the selection when
clicked.

Yiew Editor

Edit

=1-[& view: Initial Data Component

E% Column:Object (DeDuplication) Title |wWorkflowPlannedPage
- EE Column:Wheo Approved? (WaorkflowVariable
-[]T Attribute: Date [[]Read Only
- EE Column:Workflow Deadline (WorkflowDead
- EE Column:Attachment 1 (WorkflowaAttachmer
- EJ& Column: (WorkflowAssignee) Component | WorkflowFlannedFage o
- B IColumn:WorkflowPlannedPage (WorkfowP|
View: Review Data View choice: |Pian =
View: Confirm data

View: Approve Data

View: Items packaged

& view: End State

----- E Mapping : Initiate Data-=Initial Data
----- E Mapping : Review Data->Review Data
E Mapping : Confirm data->Confirm data

Mandatory

E|..
E|..
E|..
E|..
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€ STEP Workflow Items -~

Party Hats >
Party Hats >

Flastic Toppers  »

STEP Woarkflow Items m Planned Page || Plan Motes || References || Status || State Log || Tasks
Flatplanner

H E R EE | Ef |Z={: L |"."'.": H:
Party Hats
2 3
1] 1]
[rellow & Pink | [Purple & White [Pink & Green P | [Cosmic Party |
[Politics Party |-I [Pink B Green H [Christmas Parbl [Streamers - Py

Workflow Task Column

Component for letting users claim / release a task. Users will not be able to work on tasks not assigned directly to
them, so if a task is assigned to a user group they are a member of, they have to claim it in order to work with it.
When a task is claimed, it is possible to release it again, assigning it back to the latest group assignee. If the task
has never been assigned to a user group, the task is assigned to the default assignee for the state.

This component is especially useful for states where the assignee initially is a user group and the desire is to let
users in that group claim and complete tasks.
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View Editor

Edit
=& view: Initial Data Component

-+ El2 Column:Object (DeDuplication) Title | Workflow Task Column
- EJ§ Column:Who Approved? (WorkflowVariable
-[]T Attribute: Date [ ] Read Only
- E|g Column:Workflow Deadline (WorkflowDead
- E|g Column:Attachment 1 (WorkflowAttachmer
- € Column: (WarkflowAssignee) Component | WorkflowTaskColumn e
- EJ§ Column:Workflow Task Column (WorkflowT

- & view: Review Data

- & view: Confirm data

& view: Approve Data

-] View: Ttems packaged

-] view: End State

----- E Mapping : Initiate Data-=Initial Data

----- E Mapping : Review Data->Review Data

E Mapping : Confirm data->Confirm data hd
£ >

Mandatary

Mo Configuration Required

ITIITIITIITIITI

[ Producks " References " Referenced By
WorkflowTaskColumn

Comfy Bed California King > é:]

Comfy Bed King > ﬂ':]

Comfy Bed double > ﬂ':]

Comfy Bed twin > ﬂ':]

For more on task ownership, see the Assignees in Workflows topic in the Workflows documentation.

Workflow Variable

Component for viewing and editing Workflow Variables, which requires selection of the Variable that should me
made available. If the selected variable is bound to an attribute and the component is configured to not be Read
Only, the cell editor matching the validation base type of the attribute will be used (e.g., a date picker for attributes

with a type=Date).

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 61



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

View Editor
Edit
L:_I-- View: Start Component
& Aspect: id Title | Status Flag
ih Aspect: name
-3 Attribute group: ItemDescriptionInformation Read Only
-[23] Attribute group: Subscriber
- 2 [Column:Status Fiag (WorkfiowVariabie) | [] Mandatory
i) Aspect: object type Component | WorkflowVariable w
ih Aspect: revision
EE‘ Aspect: path Variable | StatusFlagStart w

STEP Workflow Items Q=TT s | References || Referenced By

Status Flag >

Comfy Bed double »
Comfy Bed California King

Critical

W

For more on variables, see the Workflow Variables topic in the Workflows documentation.

Workflow Variable User List

Component for letting the user select from a list of users. The typical use case for this component is one where a
user, as part of one task, selects who should handle a subsequent task. The ID of the selected user is then stored
in the workflow variable specified in the Output Var parameter. From there, it can be used to apply an assignee in
a subsequent state using the Fetch from Variable assignee option in the State Editor Assignee tab.

An existing workflow variable must be selected in the Output Var parameter. This is used to store the selection so
that it can be accessed later in the workflow (e.g., at the time of task assignment in a subsequent state).

One of the three selection parameters must be configured (Group, Group Var, Config Prop). The three properties
are evaluated in the order shown. Therefore, if Group is populated, it will be used, and Group Var and Config Prop
will not be evaluated.

An existing User Group may be selected in the Group parameter, and the users in that group will then be available
for selection by the end user. This is used when users will always choose a user from within the selected group. If
the user group that users need to select an assignee from can vary based on other factors, then the Group Var
parameter should be used. From this, an existing workflow variable must be selected, and it is expected that at
some point in the workflow (prior to the state for which the view is being configured), the variable has been
populated with the ID of a User Group. The system then reads the ID from the workflow variable on the task and
makes the users from the corresponding user group available for selection. A Config Prop option is also available
where the ID of a configuration property can be supplied and the user group will be read from there. This is
typically only used in conjunction with extensions.
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Edit

XML

EE-I Aspect:

EE-I Aspect:

iij Aspect: approved

&%) Aspect: translation

-8 Column:Primary Image (PluginableCellPrima

-8 Column:Vendor (Vendor)

- E& Column:Assignee (WorkflowAssignee)

- Ej Column:Attachment (WorkflowAttachment)

- Column:Deadine {(WorkfowDeadline)

- Ej& Column:Link (WorkflowLinkedName)

- Column: (WorkflowNoteColumn)

- E& Column: (WorkflowPlannedPage)

- E|g |Column: (WorkflowVariableUserList) |

- E& Column: {WorkflowTaskColumn)

- E& Column: (WaorkflowVariable)

--Ej& Column:Release Date (WorkflowVariable)

- Column:WFVarUserListWithoutGroup (Work
- E& Column: (WaorkflowVariable)

EI" View: Do Work

EI" View: Finish

----- 5 Mapping : Start->Start

----- E Mapping : Do Work-=Do Wark

----- 5 Mapping : Finish->Finish

object type
revision
path

Component
Title

QOutput Var
Group

Group Var

Config Prop

i=l-.-I51

Companent | WorkflowVariableUserList

[ |Read Only

[ ] Mandatory

Assignee
Regulatory Group (RegulatoryGroup)

Only one of the settings above will be used for determining
assignee, The settings are evaluated in listed order, i.e. if
Variable is empty and Group is supplied then Group var. and
Config prop. will be ignored.

STEP Workflow

Profile
“=FPublication Sections

<

STER

S RGBT TR S EM | Products || References || Referenced By

WorkflowVariablelUserLi,., *

Comfy Bed California King
2= Sales Ttem Creation - original

Comfy Bed double

* |Regulatory User 2

@ Sample Workflow (3 states)
|

s> &

Comfy Bed King

Filter by Collection
Start

Do Work

Finish

Comfy Bed twin

-
4
1 s
0

i

Regulatory User 1

Regulatory User 2

W

Fegulatory User 1

@ Sample Workflow (3 states)(2)
== Sample Workflow with Parallels
2= Shipment Order Process
E= ser Web UT Workflow

For more on variables, see the Workflow Variables topic in the Workflows documentation.
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For more on Assignees, see the Assignees in Workflows topic in the Workflows documentation.

View 'Sort On' Option

The Sort On option allows tasks in the workflow to have a default sort order specified by a particular column. An
integer can be entered to indicate the column that should be used for sorting (1= first column, 2= second column,

etc.). An example is below.

With no sort order specified, the items are in no particular order in the STEP Workflow Items tab.

Profile

= 5ales Ttem Creation - original
= sample Workflow

== Sample Workflow(2)

© shipment Order Process

ele

Filter by Collection

Initiate Data
Review Data
Confirm data
End State

oo m ot

STEP Workflow Items

Products || References || Referenced By
Ohject )||Who Approved? > |Date »
> Flashlight Bulbs 4 (SPO) 03-mar-2016
» Flashlight Bubs 5 (5PC)  fUserL D5-apr-2016
» Flashlight Bulbs 3 (SPO) Juserz 03-jun-2016
> Flashlight Bubs 1 (SPO)  fUserL D3-apr-2016
> Flashlight Bulbs 2 (SPO) r.Jser s 07-may-2016

Edit

AN

- . View: Review Data
-] view: Confirm data
#-=) View: End State
E Mapping : Initiate Data-=Initial Data
E Mapping : Review Data-=Review Data
Mapping : Confirm data->Confirm data

-5 Mapping : End State->End State

Editor | xML

=  Wews rvsa ot =
..... Ei Cnlumn Object (WorkflowLinkedMame) 1D | Initial Data
----- EE Column:Who Approved? (WorkflowVariable)
..... DI Attribute: Date Sorton |0

[ ] Sort Columns Automatically

However, when a number is put into the Sort On option to distinguish what column the view should be sorted by,
the items are sorted in ascending order. Notice that in the View Editor, in the first view the object name appears in
the first column. To sort by this, the user types in 1 to represent the first column in this view.
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-5 view: Review Data

-5 view: Confirm data

-5 view: End State

----- E Mapping : Initiate Data-=Initial Data
----- E Mapping : Review Data->Review Data
----- E Mapping : Confirm data-=Confirm data
----- 5 Mapping : End State->End State

STEP Workflow

Profile |

@ Sales Item Creation - original -
& Workflow

& Workflow(2)

7 Shipment Order Process
G| P

Filter by Collection

Initiate Data
Review Data
Confirm data
End State

Lo I e TR S N 5

View
E Column:Object (WorkflowLinkedName) | 10 | Initial Data
i Bl Columm:Whao Approved? (WorkflowVariable)
----[II Attribute: Date Sorton |1

[ ] 5ort Columns Automatically

e MASTER DATA MANAGEMENT

Object Whao Approved? >
» WFlashlight Bulbs 1 (SPQ) ser L U}may—mlﬁ
» WFlashlight Bulbs 2 (SPQ) ser 5 07-may-2016
» WFlashlight Bulbs 3 (SPQ) ser2 03-jun-2016
» [Flashlight Bulbs 4 (SPO) 03-apr-2016
» WFlashlight Bulbs 5 (SPQ) ser L N5-apr-2016

roced 1« st |

If the option Sort Columns Automatically is checked, the Title parameter for each element of the view is used
and columns are sorted in alphabetical order based on this value, excluding aspects. To clarify, all columns of the
'Aspect' type (e.g., ID, Name, Revision, etc) appear first in the view, followed by all other elements listed in

alphabetical order by Title.
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View Editor

#-& view: start View
=-[=)] View: Do Work

iﬁ Aspect: name
- B Column:Mote (WorkflowNoteColumn) | Sorton |0

&) Aspect: id I Sort Columns Automatically:

ID Do Wark

- [IT Attribute: ListPrice

-/ view: Finish

..... 15 Mapping : Start->Start

----- E Mapping : Do Work-=Do Work
..... 15 Mapping : Finish->Finish

STEP Workflow Items

Product ” Sub Products " References " Referenced By
D * |Mame * |List Price * |Mote >
“omfy Bed > D2155 Comfy Bed 1299 § E]

Ordering Columns in Views

It is possible to reorder the data selections in a view by right-clicking on any element of the view and selecting
either Move Up or Move Down, depending on what options are given according to the current position. The order
of columns in the View Editor determines the order in which they are displayed to the end user so care should be
taken in the ordering.

Yiew Editor

= Component
i EJE Columni:Object i :
~.[JT Attribute: Date Move Down |~ Tite [Obiect
Read Cnly
Delete
Mandatory

Companent | WorkflowLinkedMame  »
Product Editor |Product
Classification ™ |Classification
Asset ™ |Asset
Entity ™ |Entity
Attribute ™ | Attribute

Planned Page ™ |Plan
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Using the XML View Editor

In addition to the Editor tab on the View Editor dialog, there is also an XML tab. This tab shows an XML
representation of the defined views and mappings, allowing users to create and configure views via XML rather
than right-clicking. This can be especially useful when a number of similar views need to be configured and
workflow designers need to indicate only a few differences between them. In addition, the XML editor can be used
to copy views across workflows, which is helpful when multiple workflows use a similar view, but the workflow itself
differs and should not be copied (e.g., onboarding and maintenance workflows).

View Editor

.. BE Column:Who Approveds |Editor) XML
:l-- View: Review Data
- =] view: Confirm data
-[&] view: End State

|<?xml vergion="1.0" encoding="UTF-53" =standalone="yez"2>
<nsZ:workflowViews xmlns:nsZ="http:/ /uuw.stibo.com">

|

..... "% l‘lmg:llitiatenala—ﬂm <wiew id="Initial Data®™ defaultlorcColumn="0" automsticforc="false':>

..... ’El Mapping : Review Data-»Re <columh hame="Chject”™ readoinly="false™ wanhdatory="falsef:>

----- E Mapping : Confirm data->C <plugin pluginID="TorkflowlLinkedame ">

""" E Mapping : End State->End 3 <parameter id="ClassificationEditor" walue="Classification"/>

<parameter id="FlannedPageEditor” value="Flan"/ >
<paramweter id="ittributeEditor™ wvalus="Attribute™/ />
<parameter id="AissetEditor™ wvalus="As=set"/>

<paramweter id="EntityEditor™ wvalus="Entity"/ />
<parameter id="ProductEditor”™ value="Product™/>
</plugin:
</ column:
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Configuring Mappings for Workflows

This topic details how to map a view to a workflow state (or states), as well as how to map views to specific users
or user groups. Without views and mappings configured, all states in the workflow are displayed on the STEP
Workflow navigator tab (including parallels, clusters, and final states). When a workflow includes automated,
system, parallel, and/or cluster states, and users will be interacting with the workflow in the STEP Workbench, it is
recommended to have mappings in place so that only the user states (e.g., states in which a human must interact)
are present on the STEP Workflow tab.

Prerequisites

A workflow has been created and one or more views have been created for the workflow. This is required because
the mapping task serves to connect any given view to a particular state or set of states. Therefore, for the exercise
to be meaningful, both the view(s) and the state(s) must already exist. Also note that the views must have an ID
assigned, else they will not be available for selection in the mapping. For more on creating views, see the
Configuring Views for Workflows topic.

Configuration

1. Toadd mapping to a view, right-click the editor panel on the left hand side anywhere, and select Add
Mapping.

View Editor

Edit
Editor xmL

=& view: Initial Data

E& Column:Object (WorkflowLinkedName)
- [|F Atribute: Date

Add View

Add Mapping %
Add Mapping Group

2. Intheright-hand panel in the View Editor window that appears, select the state from the dropdown for which
you want to apply a view.
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View Editor
Edit
Editor ¥ML
=& view: mitial Data Mapping
EE Column:Object (WorkflowLinkedMName) Ctate | Initial y
- [IF attribute: Date
"5 Mapping : Initial->Initial Data View | oo nae
End State
Review Datz
4 >

3. Fromthe View dropdown, select the view that you would like to apply to the state.

View Editor
Edit
Editor xmL
=- & view: Initial Data Mapping
E|g Column:Object (WorkflowLinkedName) State | Initial "
[T atribute: Date
"I Mapping : Initial->Initial Data View | Initial Datz &
Initial Data
< >

4. Repeatthe above steps as many times as needed so that each state requiring human interaction has a view
assigned to it. Note that the same view can be applied to multiple states.

5. Sequence the mappings in the appropriate order by right-clicking on a mapping and selecting 'Move Up' or
'Move down'. Sequencing of views is important as this defines the order in which the views are presented to the
user on the STEP Workflow navigator tab. Mapping sequence is typically assigned alphabetically or
sequentially (e.g., the first state in the workflow is sequenced first).
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View Editor

Edit
Editor xmL

EI View: Initial Data

[T Attribute: Date

1= Mapping : Initiak->IDandName
Mapping : Review Data->Review Data

IS Mapping : ConftasesConiimecs
T8 Mapping : End. SD‘-"E Up
Move Down

Delete

6. Save the workflow, exit the STEP Workflow Designer, and go to the STEP Workflow navigator tab.

7. Select the workflow for which view and mapping is being created and expand the flipper. When the flipper is
open for the workflow, only the states for which a mapping was created are visible.

%' Order Process

Clk i) sa)|

Filter by Caollection E]
0
Q
0

Initial
Review Data
Confirm Data

Workflow User / Group Specific Mappings

It is possible to create mappings that only apply to specific users or user groups. The mappings of a particular
workflow could be configured so that only users in a specific group can see a given state (e.g., only administrator
users have access to automated and system states to intervene in case of errors), or so that users in a specific
group could see tasks within the same state with different views (e.g., an end user may need to see different data
than an administrator).

1. To create user/ user group specific mappings, right-click the left panel in the View Editor, and select Add
Mapping Group.
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View Editor

Edit
Editor  wmML

" View: Initial Data

#- & View: Review Data

" View: Confirm data

#- & View: Approve Data

- [& View: Items packaged

- & View: End State

E Mapping : Initiate Data->Initial Data
Mapping : Review Data->Review Data
E Mapping : Confirm data->Confirm data
E Mapping : Approve Data->Approve Data
E Mapping : Items packaged->Items packaged
I8 Mapping : End State->End State

Add View
Add Mapping

Add Mapping Group [}

2. Selectthe user(s) and/or group(s) you want the mapping to apply for. Note that there are separate fields for if a
group is added verses a single user.
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[ 1 View Editor pd
Edit

Editor ¥xmL

" View: Initial Data Mappings

" View: Review Data
" View: Confirm data
" View: Approve Data
" View: Items packaged
' " =| View: End State Include all sub groups
Mapping : Initiate Data->Initial Data . . ]
Mapping : Review Data->Review Data Search
Mapping : Confirm data->Confirm data =%, AdminPortal A
Mapping : Approve Data->Approve Data @ Asset MGR
Mapping : Items packaged->Items packaged @ Brond

M : End State->End Stat :
apping : End State->End State A% Brand Associate

Groups I Include all sub groups

Mappings: (empty) Users rﬁi Brand Managers
:ﬁi Buyer Group v
< > v
&= Details -
Select Cancel

If the Include all sub groups is checked, any subgroups within the group, as well as direct users in the group
will have access to the view.

Mappings

Groups [V iinclude all sub Qroups:

User Group E]

In the example below, if the Include all sub groups option was checked and User Group was selected, this
would include User Group 2, its child User 3, as well as User 1, and User 2.
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Include all sub groups

Search

=% User Group A
- |- User Group2
. @ User_3

Select Cancel

If the Include all sub groups box is unchecked, only the top level users directly in the group have access to
the view. For example, with User Group selected, only User 1 and User 2 would have access to the view as

they are the only direct user children of the selected group.

Include all sub groups

ovse |ETE
=% Suppliers A

= % User Groip) +——

[+ % User Group2

0 Userl
- f User2
UserPerm hd
>
Select Cancel

3. When all users or groups are added, right-click on the Mappings: empty node and select Add Mapping from
the context menu.
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View Editor

Edit

Edito xMLvL

" View: Initial Data Mappings
- & View: Review Data
" View: Confirm data
i+ & View: Approve Data User Group
i+ & View: Items packaged
-" View: End State
E Mapping : Initiate Data->Initial Data
Mapping : Review Data->Review Data
Mapping : Confirm data->Confirm data
Mapping : Approve Data->Approve Data
Mapping : Items packaged->Items packaged
Mapping : End State->End State
Mappings: (empjp=2

Groups I Include all sub groups

) Users
Add Mapping

Move Up >

Delete

4. This will bring up the States and Views dropdown menus to choose from (as with configuring a standard
mapping). Select the appropriate state and view for the user or groups to have access to. Close the View
Editor and save the workflow.
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View Editor

Edit

Editor ¥xmL

. View: Initial Data Mapping
' ~ EE Column:Object (WorkflowLinkedName)

-~ EE Column:Who Approved? (WorkflowVariable) State | ReviewBas .
- [IT Attribute: Date View | Review Data ™
~ E& Column:Workflow Deadine (WorkflowDeadli
~ EE Column:Attachment 1 (WorkflowAttachmer Approve Data
EE Column: (WorkflowAssignee) Eugﬂrm dats
- B Column:Vendor (Vendor) IEnr:ﬁju[;:em
. View: Review Data Items packaged

- +-[& View: Confirm data M}

i+ & View: Approve Data

- B View: Items packaged

# B View: End State

E Mapping : Inttiate Data->Initial Data

Mapping : Review Data->Review Data
Mapping : Confirm data->Confirm data
Mapping : Approve Data->Approve Data
Mapping : Items packaged->Items packaged
Mapping : End State->End State

EI E Mappings: (1 state)

Mapping : Review Data->Review Data

Itis important to note that when a state is mapped to a view both inside and outside a mapping group, and a user
logs in who is either directly specified on the mapping group, or member of a group that is specified, the mappings
will be evaluated from the top down and the first one that matches will be used. In other words, if the same user is
in two different groups with different privileges, but both groups are mapped to the same state, then whatever
group comes first in the mapping dictates the allowable privileges for that user. Thus, the order of mappings and
mapping groups is significant and mappings must be sequenced appropriately.
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Working with Tasks in Workflows

This set of topics focuses on the end user, e.g., the user working with tasks in a workflow in the workbench, rather
than the user configuring and/or designing a workflow. After reading these topics, a user should be able to access
workflow tasks, edit data on objects in a workflow, and submit tasks through the assigned states in a workflow.

Topics covered in this section are:

» Moving Tasks through a Workflow in Workbench
o The State Log Tab
o Workflow Search Criteria

While concepts remain the same across workbench and Web Ul, the interfaces differ. For information specific to
Web Ul, see the Workflows in Web Ul section of the Web User Interfaces documentation.
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Moving Tasks through a Workflow in Workbench

In order to move an object or task through a workflow in workbench, it first must be initiated into the workflow. This
then allows the task to be addressed accordingly through each state in the workflow.

Should a user wish to initiate a task in a workflow in Web Ul, see Moving Tasks through a Workflow in Web Ul
in the Web User Interface / Web Ul Setup and User Guide documentation.

Supplier Users

In a workflow, supplier users can only see objects that are directly linked to their supplier classification. Objects
that are children to blue folders within a classification folder are not available to supplier user workflow tasks. For
example, in the following image, the speaker products are not available for workflow tasks because they are child
objects to the 'Surround Speakers - Zeta' product folder. The 't-shirt' objects can be worked as tasks because they

have a direct link to a classification folder.

=[] Suppliers

rj Acme Company
E]|j Products Galore
|'_=| Aszets

=Hill Surround Speakers - Zeta
E Front Left Speaker

a Front Right Speaker

For more information about a supplier item Web Ul, see the Supplier Web Ul topic and the Supplier Web Ul
Setup Guide topic, both in the Web User Interfaces / Web Ul Getting Started documentation.

Initiating the Object into the Workflow

The below process describes how to manually initiate an object into a workflow. However, it is important to note
that oftentimes workflows will be configured to automatically initiate objects of a certain type or types into the
workflow upon creation of the object. In addition, workflows can be initiated by a variety of other actions or
processes (both automated and manually initiated), such as business rules, imports, or bulk updates.

To manually initiate an object into a workflow:

1. Navigate to the Tree tab and select the desired object. Right-click and select Initiate in STEP Workflow.
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EHIT] Lumber

rj Pressxl
[T Sealers/Fillers
+-[[7| Electrical & Electre

+-[[7] Food and Beverag

E
E
=-[I7] Kitchen
£
£

[L]r_=| Furniture Unlink product
[T Bedroom
=[] Beds g8 Cut
E}- Beds ] Copy
. ﬁ . Paste
Paste Link
¥ Delete
+-[7] Automotive B2 Du plicate
‘]r_:l Building Products B2 DuplicateRecursively

Add Children To Override

Remowe Child From Owverride

Approve Object
Partial Approve...
Check Approve

Approve Recursively

Search Below

+-[I7] Wedding
+|-[[7] Party Supplies ik Export Data Below
LIS Discontinued Products  lynitiate in STEP WaorkFlow
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2. Inthe dialog that appears, select which workflow to initiate the object into. Note that only workflows that the
object is valid for appear, and any workflows that are disabled indicate that the object has already been initiated

into those particular workflows.

Initiate in STEP Worlkflow

(7 Workflow

Sample Warkflow (started)

Process Mote

Cancel

If desired, the user can enter a Process Note when starting the workflow. This note is posted to the object's State

Log.

See the State Log Tab section of the Workflows documentation for more information.
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Processing Tasks in a Workflow

Once an object is initiated in a workflow, it is available in one or more states of the workflow. Each instance of an
object in a state represents a task to be completed. Each state is assigned to a particular user or group who has
the responsibility of completing the tasks in that state. Because of this, tasks are most often accessed via the states
themselves, rather than via the objects in the states. The STEP Workflow tab allows users to see tasks in the
states to which they have privileges to access. The Tasks tab on an object allows users to see all tasks for a given
object, across multiple workflows. Both options are described below.

STEP Workflow Tasks Tab

STEP offers a task list in the workbench that shows all tasks assigned to the current user (either directly to the user
or to a group of which the user is a member). This is the primary interface for working with workflows in the
workbench and displays all workflows that the user has the '"View and use STEP Workflow' privilege for. When
any workflow flipper is expanded, a list of the configured states is displayed, with an object count displaying the
number of tasks in the state that the user has access to.

STEP Workflow

Profile

Review Data
Review Images
Gather Data
Gather Images
Rewview

Start

|Fi|ter by Collection ||Z|
3

V]

3

13

V]

41

Note that only tasks that are available for the user are displayed. For example, a user who is not part of a group
that can process tasks in the Review Data state will see a count of zero (0) rather than three (3).
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To work with tasks via the STEP Workflow tab:

1. Navigate to the STEP Workflow tab, expand the flipper for the desired workflow, and select the appropriate
view. There are three options to choose from:

@ sample Workfow
& P CNEANS
|Fi|ter by Collection "ZI

o Show All (triple user button): All tasks are displayed. This button is only available if the user has 'STEP
Workflow Administrator' privileges for the workflow.

o Show Group (double user button): Tasks assigned directly to the current user or to a User Group of
which he /she is a member are displayed.

o Show User (single user button): Only tasks assigned directly to the current user are displayed.

Additionally, a user can further refine the task view by using the 'Filter by Collection' option. If a collection has
been previously set up, click the ellipsis button (D) to select that collection will filter the task list to display only

tasks for objects contained in the collection. For more on creating collections, see the Collections
documentation.

2. With the appropriate view selected, click the link for the state in which tasks should be accessed. This will
display the tasks in the state according to the view configured by the workflow administrator, allowing users to
review and/or edit data as needed. Cells in yellow are read-only, while white cells can be edited. Red cells may
be present and are considered mandatory and should be populated prior to submission, though the system
may or may not prevent transition of the task if they are not populated (based on how the designer has
configured the workflow).

Some workflows require tasks to be claimed before they can be updated by a user. This can be verified by the
presence / absence of a task claiming icon (| o] ). Ifthis is present in one of the columns on the STEP

Workflow Items tab, see the Claiming and Releasing Tasks in Workflows section of the Advanced
Workflow Topics material for additional information.
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STEP Workflow Items

Profile SRV LT A VRSB | Products || References || Referenced By

L —— —

& _ Ly » [Mame » [Description, Table > |DescriptionLong »
80's Slasher Game > 131542 80's Slasher Game

@ e ThD | e | Cosmic Horror Game > (131530 Cosmic Horror Game

5 Adventure G * 131536 Adventure G

|Fi|ter by Collection "ZI pace Adventure Game Space Adventure Game

Review Data 3 <

Review Images ] Approve - || Submit

o mbhen M- =

3. Submitting a task to a subsequent state indicates that work on the task is complete. Unless the user has access
to a subsequent task for that object, it will no longer be accessible for them in the workflow. To submit a task,
select the task (multi-select is enabled using Ctrl + click), choose the appropriate selection from the dropdown
(if applicable) and click Submit. The available options for selection are configurable based on the design of the
workflow. In some cases only a single selection will be present and therefore it is not required for the user to
select a specific transition.

STEP Workflow Items

STEP Workflow Items [T a0 | 2= ETR= e = | Referenced By

> |Name * |Description, Table * |DescriptionLong *
80's Slasher Game ¥ 131542 's Slasher Game

Cosmic Horror Game >

Space Adventure Game * (131536 ce Adventure Game

4. A dialog will appear, allowing the user to input a comment, which will be recorded in the Notes field on the State
Log tab of the object. Note that if multiple objects were selected, the same comment will be applied to all. From
the dialog, click the Submit Now button to complete the task, or click Cancel to return to the STEP Workflow
Items editor.
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Submit tems

Submit message
Description |STEF‘ Warkflow |
Subrmit Mow

5. Clicking the Refresh button in the Task pane will update the task list.

STEP Workflow

Profile
A Warkflow

STEP Workflow Items

STEP Workflow Items |t | References || Referenced By

* Mame » |Description, Table >
80's Slasher Game > 131542 80's Slasher Game
Space Adventure Game * (131536 Space Adventure Game
Filter by Collection "ZI
Review Data
Review Images U]

Tasks Tab on an Object

From an object in Tree, the Tasks tab displays all tasks across all workflows for that object, subject to the user's
privileges. Only tasks that the user has rights to address are visible.
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Tasks

e Adventure Game rev.0.7 -

Commercial || Tables || Category Profile || Proof View || Status || State Log

Space

Product ”

Sub Products

" References ” Referenced By [_

7

2= sample Workflow/Review Data (Super user)

Space Adventure Game

D

131536

MName

Space Adventure Game

Description, Table

DescriptionLong

Feature Bullet 1

Feature Bullet 2

Feature Bullet 3

Feature Bullet 4

Feature Bullet 5

Feature Bullet &_Mot Dim Dep

Footnote

Sales Item Short Description

Description, Web

PP

2-16 Players

Multiplayer

MNo

Co-op

WEOW W W W W W W W W W W W W W W

2-6 Players

Mo Images .. Submit

The interface and interactions are comparable to that of the task list, with the only difference being that users can
expand or collapse flippers to access tasks in various states and workflows.
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State Log Tab

Any object type for which a workflow can be configured has an editor tab named State Log. This is useful for
tracking the recent history of an object across all workflows that include the object. Initiating an object into a new
workflow creates a flipper under which recent history is housed for that particular workflow.

All transitions, assignments, notes, and status flags are displayed with a row in the table. For each entry there is a
timestamp, a log type, and the name of the user causing the entry. Note that only the latest 50 entries per workflow
are displayed.

The following checkboxes filter the state log, allowing a user to view only the necessary information for the object
in the workflow indicated by the flipper. At least one checkbox must be checked for the workflow information to be
displayed.

Show transitions: when checked, the 'transition' log type entry is displayed, adding data for the 'To State'
column, in addition to the 'From State' column.

Show assignments: when checked, the 'assignment' log type entry is displayed in the 'Assignee' column,
showing the user to whom the task has been assigned.

Show notes: when checked, any notes entered while transitioning from one state to another are displayed in
the 'Note' column.

Show status flag changes: when checked, the 'statusflag’ log type entry is displayed, adding data for the
'Status Flag' column.

Hide Parallel and Cluster States: when checked, any states in a workflow which has Parallel or Cluster
states are displayed. Since entering and leaving parallels and clusters result in a lot of entries, this option allows
you to reduce the number of rows displayed for those types of workflows.

The log does not reset with every new workflow instance. Thus, if an object has been removed from a workflow
and then later initiated into the same workflow again, entries from the first instance continue to display.
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State Lt]g B orplete

Product || References || Referenced By || Images & Documents || Commercial || Tables || Category Profile || Proof View || Status |BELGLE T [_

@ Show transiions [/ Show assignments  [] Shownotes  [»] Show status flag changes [ ] Hide parallel and duster states
Time > |liser *» Event * |From State * [To State * |Mote * |Agcignes > |Status Flag * |Log Type >

* | 2017-04-19 09:23:27  USER] Lead Free LSER] assignment

» | 2017-04-19 09:253:27  LUSER] Proceed Feview Data Lead Free transition

» | 2017-04-1909:23:27  |JSERJ Lead Free Low statusflag

> 1 2017-04-19 09:23:09  LSER] Review Data LSER] assignment

» | 2017-04-19 09:23:09  USER] Proceed Gather Data Review Data transition

> | 2017-04-19 09:23:09  USER] Review Data Low statusflag

| 2017-04-19 09:23:03  USER] Gather Data IUSER] assignment

» | 2017-04-19 09:23:03  USER] Proceed Start Gather Data transition

» | 2017-04-19 09:23:03  USER] Gather Data Low statusflag

| 201704-19 0%:09:20 USER] Start IISER.] assignment

* | 2017-04-19 09:09:20  USER] Start transition

» | 2017-04-19 09:09:20  USER] Start Low FEtuSﬁag

QReassign

[] Show transitions ~ [/] Show assignments  [/] Shownotes  [] Show status flag changes [] Hide parallel and duster states
Time ¥ |l ser * Event * |From State * [To State » Note > |Assignee  » [StatusFlag * [Log Type =

> | 2017-04-28 12:10:54  LSER] Wark LSER] assignment

» | 20170428 12:10:54  USER] Start Wark Eﬁx gﬁenfls";;r: added transition

» | 2017-04-28 12:10:54  |JSER] Wark Low statusflag

* | 2017404-23 12:10:29  USER] Start LISER] assignment

» | 2017-04-253 12:10:29  USER] Start transition

» 1 2017-04-28 12:10:29  LISER] Start Low statusflag
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Workflow Search Criteria

The STEP Workflow Search criteria lets a user search for:

1. Objects that are in a specific state in a specific workflow

2. Objects that are in a specific workflow but could be in any state

3. Objects that are valid for a given workflow, but are notin it

These options are helpful because they allow users to interact with workflows more efficiently. For example, if a
user wants to update a group of items that are already in a specific workflow, they can use search to identify the
items in a particular state and perform a bulk update on all objects. Additionally, if a user wants to see which items

are valid for a particular workflow and which have not yet been initiated they can do so. All of these options assist
users when working with workflows.

Performing a Search with Workflows

Below is an example of how the Search tab can be used for workflows.

1. Navigate to the side Search tab and click on it. A dropdown is present to specify search criteria.

Search
= Advanced T
EEE [ Reset ] [ Search ]
Show Details
| Mame > |

2. Click onthe dropdown and select STEP Workflow.
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Search

Object Type

Search Below

Referenced Assets

Revised Objects Changed Since
Document Content

Search from List

Javascript search

Missing Mandatory Values
Unapproved

Product Override Search

Search in Publication Hierarchy
Referenced By

References

STEP Workflow

Sample Result
Translation 5tatus

Unpushed or Failed Assets

Search
10w Details

]

Bl
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3. When the STEP Workflow criteria is selected, two parameters are available for a user to specify workflow and
state. A workflow must be selected, but selection of a state is optional. Also note the bracketed options in the
State parameter - allowing for users to identify all objects currently in the workflow, or all objects valid for the
workflow but not currently active init.

(1) |

BG Processes

|

[any State]

Approve Data
Items packaged

[not in STEP Waorkflow]

ame Initiate Data
Review Data
Confirm data

m

4. When the options have been selected, click on Search to run the search and view any results.
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Search Search Result Profiling

STEP Workflow [
STEP Workflow :Shlpmmt Order Process =) Search Re=sult Prgﬁ"ng
State Review Data =
- . 2 hit(s)
........ =1l Click links to narrow down search
Er Reset |[
Displaying 2 of 2 results Show Details .
Name Results by Object Type

a. — Blue Hat [D = 20805 Product {2} - exclude
* i Yellow & Pink part for flashlight D = 73500 E item (2)
2t - exclude

Results by Position in Tree Hierarcl
Results by Parent

|jF'rnduc15 f'1] - exclude
[C1Templates (1) - =xcluds

Il Flashlights ltems (1) - ssxclude
Bl Hats and Caps ltems (1) - =xclude

If a user is checking to see what tasks are in a state, they can also verify the results by going to the Tasks sub
tab in the STEP Workflow tab. See the Moving Tasks through a Workflow in Workbench section of the
Workflows documentation for more information.

P Workilow [tems

(A [ ) - L
3 1
Profile | STEP Workflow Items R0 s | References || Referenced By

& Shipment Order Process Waorkflow Task Column > |Assignes >

i Yellow & Pink part for flashlight * | o Group @ User Group
L+

Filter by Collection E]
22

2

7

3

1

1

Blue Hat > gﬂ Iser : User L

Initiate Data
Review Data
Confirm data
Approve Data
Items packaged
End State

-
\i 1 i

Proceed 2 Submit

- s0neButton1 &7

5. Ifthe search is not as refined as needed, a user can add additional search criteria by pressing the green +
button, , and further filtering the results. For example, the workflow criteria could be combined with the
Search Below criteria to isolate objects in a particular category.

For more information on the various search criteria and/or the actions that can be taken with a set of search
results, see the Search and child topics in the Getting Started / User Guide documentation.
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Managing Workflows

When a workflow is selected from the System Setup tab, various settings for the workflow can be viewed and/or
edited (if applicable) on the different tabs. These settings help in giving valuable information in regards to the
particular workflow such as an overview of the workflow, what the workflow is valid for, a list of users who have
interacted with the workflow or made changes, and any revision history.

To view the workflow tabs, go to System Setup, expand the workflows node, and select the relevant workflow.
This opens the workflow in an editor. Note that workflows viewed in the Approved Workspaces are read-only.

STEP Workflow Editor Tab

The STEP Workflow Editor tab displays basic information about the workflow, as well as providing some global
configuration options for the workflow.

 Stee workiow Eitor |E) R I

s |
MName »| > |Value

D Sampleworkflow
Mame Sample Worlkflow
Revision 0.65 Last edited by USERS on Wed Jul 13 10:42:18 EDT 2016

Initiate automatically
Listen on updates from import

Use executing user's write privileges
Disable transitions on terminated Workspaces
Start Condition

Ooog@E

|-Ovvvvvvvv

Title > |State > [STEP Workflow Component > [Description >
* (acn-4b3d2546-ff7d-4081-99b2-d5ed1a703b8a) Review Data - Gather Data On transition Execute var inst;inst = node.getWorkflowInstan...
> (acn-613c2626-78854abd-90ac-4151991b0d2)  Enrich Data On exit Execute var inst;var task;

» (an-6e357627-6267-4a%-8649c-6d83f%e1e?) Gather Data -= Review Data On transition Execute var instjinst = node.getWorkflowInstan...
@ UsedGebalBusnessRules
Title > |State > [STEP Workflow Component > [Description >
* Multiplayer Condition Review Data Conditionally mandatory Attribute True if if(attr == "Yes™) {return true;

e
Applies to > [Action Set > |Attribute G... * |Object Type * |Group > |Language > (Country >
Add Privilege

For more information on the basic settings, see Creating a Workflow in the Workflows documentation.

The STEP Workflow Editor tab also has two flipper areas that show an overview of the business rules used in a
workflow: 'Used Local Business Rules' and 'Used Global Business rules'.

The Workflow Privileges flipper displays state-specific privileges for the workflow, which can be edited from the
Privilege Rules tab on a User Group, or from this interface. This functionality is useful when a particular user group
should have access to data only when an object is in the indicated state. For example, a user group may have
rights to edit certain data only when accessing the data from a particular state or an onboarding / creation workflow
or a maintenance workflow, but can only view the data for objects not in the editable workflow states.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 89



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

To edit the workflow privileges, click on the Add Privilege link, and select the state that the particular privilege is to
apply to from the drop-down menu in the pop-up window.

Edit Privilege Rule

Workflow state Gather Data

St

Action Set: Images, Approve (ImagesApprove) | ...
Attribute Group:

Walid for Object Type:

Apply to Group: Image Group (ImageGroup)

Dimensions:

Language <ANY = i

Country <ANY = ~
Save Cancel

Once the state has been chosen for which the privileges should be applied, it is then possible to set up the various
options to set the privileges for that particular state. Complete configuration information for workflow privilege rules
is provided in the Editing Privilege Rules section of the System Setup / Super User Guide documentation.

Note that if workflow privileges are applied to a state, a'P' indicator will appear on the state within the workflow

<

Validity Tab

The Validity tab allows for specification of which object types the workflow is valid for. Only objects of the selected
types can be initiated into the workflow. Notice that while a workflow can be made valid for multiple object types of
a specific node type, it cannot be valid for object types of different node types. For example, a workflow can be
valid for multiple types of entities, but not for both entities and classifications.
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| sTEP Workflow Editor | [EILLaN | Loo || Status |
C-Valid for Attribute Types
€ Valid for Classification Types
@ Valid forEntity Types
All

Account

Address

Address Root

All Customers

Contact

Log Tab

The Log tab is a list of dates and times when changes were made to the workflow. Listed with each time stamp is
the user who made each change.

STEP Workflow Editor || Validity Status

Showing page 1of 1

2015-12-11 10:57:53 "USER":
2015-12-11 10:57:53 "USER":
2015-12-11 11:15:38 'USER":
2015-12-11 11:15:38 'USER":
2015-12-11 11:18:03 "USER":
2015-12-11 11:18:03 "USER'": Modified
2015-12-11 11:29:31 "USER'": Modified
2015-12-11 11:29:31 "USER'": Modified

Modified
Modified
Modified
Modified
Modified

2015-12-11 14:54: 14 "USER": Madified
2015-12-11 14:54: 14 "USER": Madified
2015-12-11 15:01: 56 "USER": Modified
2015-12-11 15:01: 56 "USER": Madified
2015-12-11 15:54:05 "USER": Madified
2015-12-11 15:54:05 "USER": Madified
2015-12-22 14:05:42 "USER": Modified
2015-12-22 14:06:42 "USER": Modified

Status Tab

The Status tab provides an overview of the revisions of the workflow, including the user who changed the object
and when the change occurred.
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> WF1 rev.1.1 - Status
STEP Workflow Editor || Validity [E]w
QRevisons
Fevision * |Created * |Edited * |Major * |User ¥ |Comment ¥

> (L1 Sun Jan 04 20:29:47 CET 2015 Sun Jan 04 20:29:48 CET 2015 STEPSYS  Workflow updated

> 1.0 Thu Dec 11 12:35:47 CET 2014  Thu Dec 11 12:35:47 CET 2014 o STEPSYS I made a major revision

* 0,14 Thu Dec 11 12:34:53 CET 2014  [Thu Dec 11 12:34:53 CET 2014 STEPSYS  Workflow updated

* 0,13 Thu Dec 11 12:34:06 CET 2014  [Thu Dec 11 12:34:06 CET 2014 STEPSYS  Workflow updated

> 0,12 Thu Dec 11 12:26:55 CET 2014  ThuDec 11 12:26:55 CET 2014 STEPSYS  Workflow updated

* 0.11 Mon Dec 01 14:55:05 CET 2014  Mon Dec 01 14:55:05 CET 2014 STEPSYS  Changed Warkflow Definition

* 010 Mon Dec 01 14:52:15 CET 2014 Mon Dec 01 14:52:15 CET 2014 STEPSYS  JAuto Generated

* 0.9 Mon Dec 01 14:44:55 CET 2014 Mon Dec 01 14:44:55 CET 2014 STEPSYS  Complete approval

> 0.8 Mon Dec 01 14:39:11 CET 2014 Mon Dec 01 14:39:11 CET 2014 STEPSYS  Changed Workflow Definition

» 0.7 Mon Dec 01 14:39:08 CET 2014 Mon Dec 01 14:39:08 CET 2014 STEPSYS  Changed Warkflow Definition

* 0.6 Mon Dec 01 14:33:53 CET 2014 Mon Dec 01 14:38:53 CET 2014 STEPSYS  Changed Workflow Definition

* 0.5 Mon Dec 01 14:37:34 CET 2014  Mon Dec 01 14:37:34 CET 2014 STEPSYS  Changed Workflow Definition

> 0.4 Mon Dec 01 14:37:08 CET 2014 Mon Dec 01 14:37:08 CET 2014 STEPSYS  Changed Workflow Definition

* 0.3 Mon Dec 01 14:35:35 CET 2014  Mon Dec 01 14:35:35 CET 2014 STEPSYS  Changed Warkflow Definition

* 0.2 Mon Dec 01 14:34:41 CET 2014 Mon Dec 01 14:34:41 CET 2014 STEPSYS  Changed Workflow Definition

* 0.1 Mon Dec 01 14:34:41 CET 2014 Mon Dec 01 14: 34:41 CET 2014 STEPSYS

cHdenvaes
GDiagnostics

Revisions are created when the workflow has had edits made to it in the STEP Workflow Designer, and the
designer is saved and closed. Minor revisions are made automatically when various users interact with the same

obj

ect.

Major revisions can be made on both the object initiated in the workflow or the workflow itself. It is recommended
to make a major revision for a workflow each time a set of changes has completed. For example, it may be useful
to make a major revision when UAT begins for a workflow so it is clear what is being tested, and again upon
completion of UAT so that itis clear what has been released for production. To do so, click on the workflow in
System Setup, and select Make Revision from the Maintain menu.
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doc-dev - userl@https://doc-dev.stibo.com - STEPworkbench

File Edit View Mavigate Format Maintain | Window Help
[T context |engishus \ Insert >
System Se Link >
2 =- (5 Workflows S \
2 -8 (acn-672af43b-25%4 .
—— g (Mew Collection)
5 [ 2021 Planning To Dos 7~ Delete
3| | @Bl Business_Action Force Delete & Purge
= | 3] Clerical Review Waorkfl _ _
@ &[] Clerical Workflow 2 e
2| {5 Collection _
b &[] Construction of Produ B2 Duplicate Ctrl+)
%I E}'@ Contact Workflow Bl Duplicate Recursively
] EE}--@ Contract Agreements
— -~ Critical .
) Make Revision
g -5 Demo Workflows
e}
T - 13| Discontinued State
n @ . Approwval H

Previous versions of STEP Workflows can be viewed by selecting the revision on the Status tab, right-clicking on
the row indicator (>), and selecting View STEP Workflow.

| STEP Workflow Editor || validty || Lo ||ESGGH
& Revis
Revision » [Created » |Edited >
* 0.3 Tue Mar 22 09:45:23 EDT 2016 [Tue Mar 22 09:45:23 EDT 2016
e> 2 This Mar 03 09:33:17EST 2016 Thu Mar 03 09:33: 17 EST 2016

18 Cut Ctrl+X  |Mar 03 09:32:51E5T 2016 [Thu Mar 03 09:32:51 EST 2016
¢ Copy Ctrl+C
0 [B Paste Ctrl+V

= Paste Link Ctrl+L

Purge
] View STEP Workflow 9

Purging Workflow Revisions

Any revision can be purged, but once a revision is purged it cannot be recovered.

To purge a revision, right-click on the row indicator (>) next to the desired revision and select Purge.
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| STEP Workflow Editor || validty || Lo ||ESGGH
Y —
Revision » [Created » |Edited >

* 0.3 Tue Mar 22 09:45:23 EDT 2016 [Tue Mar 22 09:45:23 EDOT 2016
) Thi Mar 03 09:33:17EST 2016 Thu Mar 03 09:33: 17 EST 2016
138 Cut Ctrl+X  \Mar 03 09:32:51E5T 2016 [Thu Mar 03 09:32:51 EST 2016
P Copy Ctrl+ C
i [B Paste Ctrl+V

Paste Link Ctrl+L

Purge 9
B View STEP Workflow

For more information on the Status Tab and revisions, see Revisions in the System Setup / Super User Guide
documentation.

Deleting Workflows

To delete an entire workflow, right-click on it from the System Setup tab and select Delete.

5] Clerical D 2 |

| @ Clericz Edit STEP Warkflow

) @ Condi
&[] Conta
[ Contr
1 =B contr
- Critica
@ Discar
0 Errar

Cut Ctrl+ X
Copy Ctrl+C
Paste Ctrl+V

ol P 3 [90§

Delete

"X

Deleted workflows will be available in the System Setup Recycle Bin until they are purged (permanently deleted)
or revived (restored to their previous location).

Compeonent Models
El'ﬁ Recyde Bin
- InitonEntry

>[E Customer Web UL Workflow
[E Lead Pipe Plumbing C

| 1-[73] Newsnaner Aitn o X Purge
4 i

Revive
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Advanced Workflow Topics

This portion of the material covers more advanced workflow configurations, going beyond the basic setups
described in the introductory material. Users should be familiar with all material in the Getting Started with
STEP Workflows documentation before attempting to configure and/or utilize more advanced workflow
functionality.

Most real-world workflows will utilize many of the functions described in the advanced topics, but none are
required in any particular workflow. The topics generally do not build on one another and completing one
configuration typically does not require knowledge of any other, outside of the basic workflow setup.

In other words, the advanced workflow documentation is function and topic based, meaning that each topic
describes a particular function a user may wish to carry out (e.g., send email from a workflow or remove objects
from a workflow) or a particular topic a user may wish to read about (e.g., workflow attachments or workflow
deadlines).

Therefore, there is no suggested reading order and users should approach the material in the order that seems
most relevant for their workflow.
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Assignees in Workflows

In workflows, an object cannot be in a state without an assignee being set. This regardless of whether the state
represents a human task or not. The assignee must be an existing STEP User or user group.

An important thing to notice when working with assignees is that users who do not have the 'STEP Workflow
Administrator' privilege for a given workflow only will be able to see tasks assigned to themselves or a group they
are a member of. Furthermore, they will only be able to work with tasks assigned directly to themselves and have
to claim a task (i.e., assign it to themselves) to be able to edit workflow related data and perform transitions. Users
with the 'STEP Workflow Administrator' privilege can view and work with all tasks regardless of who they are
assigned to.

There are multiple ways of setting the assignee for a state. In the sections below, the options in the Workflow
Designer State Editor are described.

For setting the assignee using the On Entry tab in the State Editor, see the Assigning Tasks Using Business
Rules topicin the Advanced Workflow Topics section of the Workflows documentation.

For more on retrieving user IDs who work with tasks in workflows, see the Retrieving the ID of an Assignee
Completing a Task in a Workflow in the Advanced Workflow Topics section of the Workflows documentation.
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Assigning Tasks Using Business Rules

While the assignee always will be set using the option selected on the State Editor's Assignee tab when entering a
state, it is sometimes necessary to overwrite the assignee using a business action configured to run in the State
Editor on the On Entry tab.

Edit

| state OnEntry On Exit  Assignee  Deadline/Escalation Comments Web UI Screen Mapping Mandatory Data

' Business Rule (Local business rule to be saved with workflow) N | |E| ﬁ *
Name

Description

Type Action

Scope Local

Edit Operation

| Run as privieged [ ]

| Operations pependencies Applies if [ Bxeate Javascript ¥
. . Binds: ¥ Binds
b Merge_nia |Variable name > |Binds to

i 1 ]
Messages: T Messages
\Variable name > |Message > | Translat|

Ay

JavaScript: 1

Edit externally

l Save Cancel

!IAI:II:I new Business Action

Show Edited 5tate
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Overwriting the Assignee in Workflows with JavaScript

If the user has the ID of an assignee in a workflow variable, it is of course recommended that the user use the
'Fetch from Variable' option described in the Workflow State Editor Assignee Tab Option section of the
Workflows documentation. If, however, the user wishes to do it with a script On Entry, it can be done with
JavaScript, which can be found in the online version of this topic.

Edit Operation

[ Execute JavaScript T

Binds: ? Binds

Variable name * |Binds to
node Current Object
step STEP Manager
workflow Current Workflow
®l
Messages: ? Messages
[Variable name * |Message * [ Translations
wl

1 war instance = node.getlWiorkflowInstance (workflow);
2 war userObj = step.getUserHome().getUserById(instance.getSimpleVariable("WorkflowVariableHoldingID"));
3 instance.getTaskByID("MyState”).reassign(user0Obj);]

JavaScript:

Edit externaly

Save Cancel

A user should have STEP Workflow Administrator privilege to use this 'reassign()' APl method, however only if the
'Use executing user's write privilege' option on the Workflow Object editor is selected.

[ steP workilow citor |FPE g Qe Fry

Mame = > |Value
* ID 11123
» Mame Shipment Order Process
» Revision .73 Last edited by USERL on Mon May 23 10:45:27 EOT 2016
» Initiate automatically [l
* Listen on updates from import [l
» Use executing user's write privileges ]
* Disable transitions on terminated Workspaces [l
» Start Condition

¥ Used Local Business Rules
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Reassigning to Previous Users in a Workflow

If a task is rejected back to a previous state, and needs to be worked on by the same user who initially worked on it
in that particular state, this business rule can be used in combination with On Exit actions to return the correct
assignee.

In the example below, a user picks up a task in the Edit sate, completes the assignment and submits it to the
Review state. An On Exit business action is in place on the Edit state to store the data of who last worked on the
task in a workflow variable. For more about On Exit scripts see Retrieving the ID of an Assignee Completing
a Task in a Workflow in the Workflows documentation.

Once in the Review state, a different user looks at the task and does not think it is ready to move forward. They
sends it back to the Edit state to be re-evaluated by the user who originally submitted it.

Sulm  Reject

Review

]

Acgept

To do this On Entry action of overriding the workflow default assignee back to the user who originally worked on it
in the Edit state, the following script with the corresponding binds need to be putin place:
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] -SZE'\L—" Editor X |
Edit

| smte OnEntry On Exit  Assignee  Deadline/Escalation Comments Web UI Screen Mapping Mandatory Data

Edit Operation

Execute JavaScript

Des Binds: ® Binds

Typ Variable name * |Binds to

Scop node Current Object
! Run step STEP Manager
f workflow Current Workflow
! Ope

AN

E_ Messages: & Messages
[Variable name » |Message » | Translations
A3
JavaScript: | 1 var task = node.getWorkflowInstance(workflow).getTaskByID("MyState”);
2 var reassignUser = node.getWorkflowInstance (workflow).getSimpleVariable( "WorkflowVariable");
2 if(reassignUser!=null)
4 var user = manager.getUserHome().getUserById(reassignUser);
5 if(user!=null){
6 manager.executeWritePrivileged(function() {
7 task.reassign(user);
8 )
s}
10}
Edit externally
£ >

iA d Save Cancel

For the JavaScript example, see the online version of this topic.
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Retrieving the ID of an Assignee Completing a
Task in Workflows

In a workflow, it is common to have more than one user interact with different tasks in a particular state. As a task
progresses through the workflow, it is then helpful to know which user last interacted with the task. To help with
this, there is an automated process that can be set to retrieve the ID of the last assignee to a task. This way, should
there be an error with the task and it needs to be sent back to the previous state, it can also be determined on who
the last user was while in that state.

There are two script options that can be used according to user preference. Both are placed on a State Editor on
the 'On Exit' tab. Both scripts can also be combined with a condition to guarantee the user ID is returned, if
desired.

Using Manager Interface to Return the User ID in a Workflow

In the script below, the ID of the user who performs the transition is obtained via the Manager interface ("step"is a
shorthand for getting the Manager). This script retrieves the ID of an assignee and stores it in a workflow variable
which is being represented by "WorkflowVariable" in this case.

var assigneeld = step.getCurrentUser () .getID();

node.getWorkflowInstance (workflow) .setSimpleVariable ("WorkflowVariable",
assigneeld) ;

For the example below, the workflow variable is called 'MyVariable'.
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Deadline Escalation Comments Web UI Screen Mapping Mandatory Data
State On Entry On Exit Assignee
Business Rule {Local busin|

Edit Operation
Mame

*Exeurbe Javaboipt ™
Description Binds: @ Binds
Type Variable name » |Binds to >
Scope node Current Object
Run as privilege workflow Current Workflow
. ste STEP Manager
Operati Dependencies A ﬁp L
Eﬁerge into
Messages: ¢ Messages
|b'ariable name > |Message > I'Franslaﬁnns >
Add new Business Action JavaSeript: | 1 war assigneeld = step.getCurrentUser().getID(); ~
2 node.getWorkflowInstance(workflow).setSimpleVariable("Myvariable™, assigneeld);
]
Edit externally

Save Cancel

To implement this, open up the desired workflow, right-click on the desired state and select Edit state > On Exit >
Add new Business Action > Merge into > Execute JavaScript. Add any necessary binds for the workflow.

One aspect to be aware of is that a user with the 'STEP Workflow Administrator' privilege potentially could have
completed the task while the workflow was assigned to a group, resulting in the group ID being returned instead.
Use the condition mentioned at the end of this topic if returning the user ID only for the workflow variable is a
concern.

Using Task Interface to Return the User ID in a Workflow

Alternately, the ID of the Assignee can also be obtained via the Task interface. This too is implemented by opening
up the desired workflow, right-clicking on the desired state, and selecting Edit state > On Exit > Add new Business
Action > Merge into > Execute JavaScript. Again, replace "WorkflowVariable" with the variable for the workflow,
and add any necessary binds for the workflow.

var instance = node.getWorkflowInstance (workflow);

var assigneeld = instance.getTaskByID("MyState") .getAssignee().getID();

instance.setSimpleVariable ("WorkflowVariable", assigneeld);

Again, an aspect to be aware of is that a user with the 'STEP Workflow Administrator' privilege potentially could
have completed the task while the workflow was assigned to a group. This could result in the ID of a user group
being stored in the Workflow Variable, versus the individual user ID.

For this reason, adding a condition on the transitions out of the state in conjunction with the script on the Task
interface will guarantee that the ID stored in the variable will be an individual user and not the group ID.
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Condition to Aid in returning User ID in Workflows

Below is the condition that can be added to the Transitions Editor on the 'On Transition tab' out of the state that is
retrieving the user ID. This condition in conjunction with the script, will make it impossible for a task to exit the state
if the assignee is a group ID. To implement the condition, right-click on the transition > Edit Transition > Condition
> Add new Business Condition > True if value for Attribute™ "null" > Execute JavaScript. Add any binds needed
for the workflow.

var instance = node.getWorkflowInstance (workflow) ;

if (instance.getTaskByID ("MyState") .getAssignee () instanceof
com.stibo.core.domain.Group) {

condition = false;
resultMessage = "Please claim the Task before submitting.";
}
else {
condition = true;
}
Transition Editor
On Transition Mandatory Data
Business Rule (Local business rule tobezyad pith ark 8o [Ba] L2
Edit Operation
Mame
b ot telar Evzheate JavaSaipt ¥
escription
- Binds: § Binds
Type Condition Variable name * |Binds to
Scope Local node Current Object
Run as privileged 4] worrkflow Current Waorkflow
Operatiop®Dependencies Applies if h3!
>
%] True if value for Attribute ™ ™ Messages: ¥ ! :
[variable name > |Message » [Translations
Add new Business Condition JavaScript: | 1 wvar instance = node.getWorkflowInstance(workflow);
2 ifi{instance.getTaskByID("Review").getAssignee() instanceof com.stibo.core.domain.Group) {
Shoy 3 condition = false;
4 resultMessage = "Please claim the Task before submitting.™;
5
¢ else {
7 condition = true;
8|}
Edit externally
< >
Save Cancel

If a user wishes to send a task back to a previous state and re-assign it to the user who worked on the task in that
state, see Assigning Tasks Using Business Rules topic in the Workflows documentation.
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Workflow State Editor Assignee Tab Options

Every state in a workflow needs an assignee in order for the workflow to work. An assignee can be set for any
state by opening the State Editor and navigating to the Assignee tab. On the State Editor's Assignee tab the
following options for setting the Assignee are available:

State Editor

Edit

State OnEntry OnExit Assignee  Deadline/Escalation  Comments Web UT Screen Mapping Mandatory Data

Assign Task to the default Assignee specified for the Workflow

(") Select User/Group
Assign Task to selected User or Group

() Fetch from Variable
Assign Task to User or Group read from Workflow Variable,

() Executing User
Assign Task to the User performing the Transition into the current State

Advanced

Show Edited State

Workflow Default
If this option is selected, the state will get the assignee specified as the default for the entire workflow.

The original Workflow Default for the entire workflow is specified by right-clicking the canvas and selecting 'Edit
Workflow', by double-clicking the canvas, or by double clicking the header bar showing the Workflow ID/Name. As
the user will notice, in the dialog that appears on the Assignee tab, it is not possible to select the "Workflow Default'
option. This is because a user or user group needs to selected in order for there to be a default option for any
states in the workflow.
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State Editor

Edit

State OnEntry OnExit Assignee  Deadline/Escalation  Comments Web UL Screen Mapping Mandatory Data
() Workflow Default
Assign Task to the default Assignee specified for the Workflow

(®) Select User/Group | Super Users {Super user)
Assign Task to selected User or Group

() Fetch from Variable
Assign Task to User or Group read from Workflow Variable,

() Executing User
Assign Task to the User performing the Transition into the current State

Advanced

Show Edited State

While the user does not necessarily have to specify a default assignee for the workflow, if any of the states are
configured to use it, the workflow will not save until a Workflow Default assignee is established.

Select User / Group

Use this option to pick a specific user or user group to function as the assignee.

Fetch from Variable

Using this option it is possible to set the assignee based on the value of a Workflow Variable. When an object is
transitioned into a state with this setting, the variable value must hold either a STEP URL for a user or a user
group, or the ID of a user or user group (If there is a user and a group with the same ID, the user will be selected).

If STEP cannot find a valid assignee from the variable value, the transition into the state cannot be performed and
the user will get an error. As the 'Fetch from Variable' option requires a Workflow Variable to be set before
entering, it is not available when setting the workflow default and neither is it available for Initial states not inside
clusters.

The variable to read the assignee from could be populated by the "WorkflowVariableUserList' view component
(see the Views and Mappings for Workflows section of the Workflows documentation) or could be setin a
business action. An example could be when leaving a state, the assignee for that state is stored. See Retrieving
the ID of an Assignee Completing a Task in a Workflow in the Workflows documentation for an example.

Executing User

Using this option will set the assignee to be the user who performs the transition into the state. Typical use case is
when the individual who created the workflow wants the user who starts a task in the workflow to become the
assignee for the first state. Beware of the fact that if the option is selected for the entire workflow, the user will be
resolved each time a state configured to use the Workflow Default is entered. That is, for each state the assignee
will be set to the user performing the transition into the state, not the user who originally started the workflow.
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Advanced Options

Via the Advanced button on the Assignee tab it is possible to let the assignee be set by an assignee Provider
plugin. These plugins can be customer specific but three are present in the STEP core:

State Editor

Edit
DeadlineEscalation Comments Web UI Screen Mapping Mandatorv Data
State =t Clo Do Assignee
() Workfiow Defaulf Configure Assignee
Assign Task to th Provider
(® Select User/Grou| p_.- o oy |Z|
) upplier Assignee
Assign Task to se Key  |SupplierLinkAssignee
() Fetch from Variat VariableAssignee -
Assign Task to Us |
(") Executing User RX ¥
Assign Task to th State
== / | OK | Cancel |
Advanced ?
| Show Edited State |

Component Returned Value

SupplierLinkAssignee | Provider plugin for getting a supplier group assignee via a classification link. Only
works for products.

SupplierAssignee Legacy version SupplierLinkAssignee.

VariableAssignee Legacy version of the 'Fetch from Variable' option described above.
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Claiming and Releasing Tasks in Workflows

As noted in the Configuring Views for Workflows section of the Workflows documentation, when using the
WorkflowTaskColumn View Component, it is possible for users to claim and release tasks directly from the STEP
Workflow Items editor or the object's Tasks tab. This is important because it allows users to 'check out' a task to
work on, thus preventing other users from taking the task and working on it as well.

For example, when a user clicks the icon in the column labeled Workflow TaskColumn on a task assigned to a
group, in doing so the user has now assigned the task to themselves and opens it for editing.

|[ Products H References ” Referenced By ]

Workflow Task Column > |Assignee » lobject * |Primary Color > [ID >
ellow & Pink part for flashlight > 62] Group : Super Users ellow & Pink part for flashlight 135008
Blue Hat > ét] | User : User L Blue Hat Gray 20805

This implicitly makes the task invisible to the other users in the group, assuming that they do not have the "STEP
Workflow Administrator"” privilege.

For normal users that do not have a special 'STEP Workflow Administrator' privilege, the following apply:

« The users can only see tasks assigned to them or a user group they are a member of
« The users can only complete tasks assigned directly to them
» The users can only edit workflow specific data for tasks assigned directly to them

Itis important to notice that an object will not be locked when it is active in a workflow. That s, if a user normally is
privileged to edit an object, the user can still do this regardless of how many different flows the object is active in.
Thus, the assignee related restrictions mentioned above only apply to workflow data and functionality.

When a task is claimed, it is possible to release it again, assigning it back to the latest 'Group Assignee'. If the task
has never been assigned to a group, the task is assigned to the default assignee for the state.

Both the claim and release operations are also available through the API Task interface (Task.claim() and
Task.unclaim()).

Claiming a Task in a Workflow
In the following user group, there are two users, User L and User M.

[#--#h Restricted User
cﬁ SDK and API users
-- Stibo Users
=% Super Users
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User L signs in, opens the workflow, and navigates to the state where he / she can claim tasks. In this case itis the
Review Data state.

STEP Workflow
Profile

?

STEP Workflow Ttems

» E E @ Category Profile || Proof View || Status || State Log || Tasks

|Fi|her by Collection E] STEP Workflow Items Product " Sub Products " References " Referenced By ]
Initiate Data 0 T workflow Task Column > [Assignee > [object > [Primary Color

Review Data 1 ‘fellow & Pink part for flashlight > | o'ﬂ Group : Super Users ‘ellow & Pink part for flas...

Confirm data 0

End State a

For User L to claim the state, they click on the Claim icon, o) , claim the task, @, and the assignee automatically
changes to the user who has signed in, in this case User L.

| STEP Workflow Items [ Product " Sub Products ”
Workflow Task Column  * |Assignee >
Yellow & Pink part for flashlight » @'ﬂ Ilser : User L

Once a task has been claimed, itis no longer visible to other users in the same user group.

Releasing a Task in a Workflow

Torelease a task, click on the Release icon, m'fl, and the Claim icon, ﬂ'j , reappears. The Assignee column
changes back to the user group the user is a part of, and another individual in the same user group can now see
the task and claim it if needed.

STEP Workflow

§ ShpmentOrderprocess  [. -
o @ E E STEP Workflow Items
Category Profile || Proof View || Status || State Log || Tasks
|Fi|her by Collection E] STEP Workflow Items [ Product " Sub Products " References " Referenced By
Initiate Data 0= Workflow Task Column > |Assignee > lobject > |Primary Color
Review Data 1 ‘fellow & Pink part for flashlight > o'ﬂ Group : Super Users ‘ellow & Pink part for flas...
Confirm data 0
End State a
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Workflow Re-assignments

Sometimes it is necessary for an individual user or user group to be assigned a task in a workflow to complete
before the task can move on to the next state. For example, a task may be assigned a 24 hour deadline to be
picked up by a particular user. If the task is not picked by the user in that time period, then a business rule can be
configured in such a way that when the deadline is met, either an email can be sent to a manager to re-assign the
task to other user in the user group, or it can be programmed to automatically assign the task to a different user in
the group.

Re-assignments might also be helpful if a task needs to be reassigned from one user to another user when a task
moves from one state to the next.

There are two ways that a re-assignment of a task can take place. Re-assignments can be performed by a user
with the STEP Workflow Administrator privilege either from view and mapping via the '"WorkflowAssignee'
Component or via the API Task interface (Task.reassign(assignee)).

Users without the STEP Workflow Administrator privilege will only be able to complete and edit workflow data for
tasks assigned directly to them. Thus if a task initially is assigned to a user group but a user needs to work with it,
the user must be provided with an option for claiming the tasks, and reassigning it to themselves.

For tasks handled in workbench, a special task view component called "Workflow Task Column’ exists for this
purpose. The component lets users claim a task and also assign it back, or release it, to the initial group assignee.
More information about this is provided in the Claiming and Releasing Tasks in Workflows topic in the
Workflows documentation.

STEP Workflow Items

STEP Workflow Items |IERMlaes | References || Referenced By

Workflow Task Column  * |Assignee > I:bjeu:t ¥ |Primary Color > |ID >
‘fellow & Pink part for flashlight » ﬂ'j Group : Super Users Iellnw & Pink part for flashlight 135008
Blue Hat 2 Pl User : User 2 v [lue Hat Gray 20805

Group @ Super Users

User : User L

Discussed below is the setup for STEP Workflow Administrators to perform when configuring re-assignment via
the views and mappings option.

For more on API task re-assignment see the STEP API documentation, accessed by clicking the STEP API
Documentation button on the STEP Start Page.
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Administrator Privilege Setup for Workflow Assignee

For a user with STEP Workflow Administrator privilege to assign the tasks to different users in a user group, the
component "Workflow Assignee' should be added in the view and mapped to the required workflow state.

For more on views and mapping see Views and Mappings for Workflows in the Workflows documentation.

1. Navigate to System Setup and select the desired workflow. Right-click the workflow and select Edit STEP
Workflow > Edit Workbench Views and Mappings.

View Editor

View: Initial Data

& view: Review Data

&= View: Confirm data

&= View: End State

----- E Mapping : Initiate Data-=Initial Data
----- E Mapping : Review Data->Review Data
----- E Mapping : Confirm data->Confirm data
T Mapping : End State->End State

-] View: Initial Data Component
=B view: Review Data Title
- Eg Column:Workflow Task Column (WorkflowTaske
- g Column:object (WorkflowLinkedName) [|Read Only
- |1 Attribute: PrimaryColor
EDE‘I Aspect: id Y [ | Mandatory
-] Aspect: name Component v
- Eg Column:Who last Edited? (WorkflowVariable)
Eg Column:Rejection (WorkflowVariable) DeDuplication ”
- EJg Column: CTPTaskInfoProvider
PluginableCellDebug
EEI-- View: Confirm data PluginableCellPrimaryImage
+-[=) view: End State Vendor
----- E Mapping : Initiate Data-=Initial Data W
----- E Mapping : Review Data-=Review Data Workfiow Attachment hd
----- E Mapping : Confirm data->Confirm data

----- &) Mapping : End State->End State
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3. Add any user groups and Users to the component as needed, and title appropriately.

View Editor
Edit
Editor ymL
- View: Initial Data Component
=-E View: Review Data Title | Assignee
- EJ& Column:Workflow Task Calumn (WorkflowTaskColumn)
- E]g IColumn:Assignee (WorkflowAssignee) | [ |Read Only
- EJ& Column:object (WorkflowLinkedMame)
-[I3 Attribute: PrimaryColor (| Mandatory
EEI Aspect: id Compeonent | WorkflowAssignee ~
iﬁ Aspect: name
- E|g Caolumn:Who last Edited? (WorkflowVariable) Output Var | Who approved? -
Elg Column:Rejection (WorkflowVariable) [ Expand User Groups
-] View: Confirm data
& View: End State Super Users
----- E Mapping : Initiate Data-=Initial Data >4
----- E Mapping : Review Data-=Review Data -
----- E Mapping : Confirm data->Confirm data
----- E Mapping : End State-=End State fUser Groups
Izer 2
Izer L
>
Llsers

Itis important to note that if the option ‘Read Only’ is checked then the Workflow Assignee column will be un-
editable, and the user with STEP Workflow Administrator privilege will no longer be allowed to assign the task to

other users.
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View Editor
Edit
Editor xmL
-] View: Initial Data Component
|_:_| 'l.l"IIEw: Review Data Title |HSS]QFIEE
- E& Column:Workflow Task Column (WorkflowTaskColumn)
- EJE IColumn:Assignee (WorkflowAssignee) | Read Only

- Eg Column;object (WorkflowLinkediame)
(13 Attribute: PrimaryColor

%) Aspect: id Component | Workflow nee b
@™ Aspect: name | H# |

[ Mandatoky

STEP Workflow Items

ST GRS B | Productks || References | Referenced By [ 1

Workflow Task Column Assignee object >
Yellow & Pink part for flashlight > ﬂ':] roup : Super Users ellow & Pink part for flas...
Blue Hat * ey ser & User 2 lue Hat

Re-assignment Procedures for STEP Workflow Administrators

To assign a particular task to a user, the user with STEP Workflow Administrator privilege can do so manually on
the STEP Workflow tab and the object's Tasks tab, or by creating a business rule. For task reassignment using
business rules, refer to the document Assigning Tasks Using Business Rules in the Workflows
documentation.

STEP Workflow Tab
1. Goto STEP Workflow Tab and select the relevant workflow.

2. Click on the particular state in the workflow, and navigate to the 'Assignee' column in STEP Workflow ltems
tab.

3. Once on the 'Assignee' column, click on the dropdown so that assigned user will be visible.

STEP Workflow STEP Workflow Items
Profile Products || References || Referenced By
> > j
@ 55 - oridinal . . Eﬂ{urkﬂuw Task Column * |Assignee object .
& Sample Workf Yellow & Pink part for flashlight * ﬂﬁ Group : Super Users Wellow & Pink part fo
@ sample Workfow(2) Blue Hat > dﬁ User ; Liser 2 » Elue Hat

2 Shipment Order Process

- oo l ‘ Group : Super Users

|F|Iter by Collection

Liser @ User L
Initiate Data 12
Review Data 2
Confirm data ]
End State a0
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Select the user from the dropdown in parallel with the task to be assigned.

Object's Task Tab

Similarly to how an assignment to a user is performed on the STEP Workflow tab, a task can also be assigned on
an object's Tasks tab.

1. Todo so, click on the object and navigate to the Tasks tab.

2. Once on the tab, locate the workflow the object is in that needs a task assignment. Select the user it should be
assigned to from the 'Assignee' column.

Yellow & Pink part for flashlight rev.0.2 - Tas

T RRL
aFlashIightEuIbsa & Commercial || Tables || Category Profile || Proof View || Status || State Log ﬂ‘
ed By I

aFlashIightEulbs 8(2) STEP Workflow Items ” Product ” Sub Products " References ” Referenc

™ Flashlight Bulbs 3 @ Shipment Order Process/Review Data (USER)

a Flashlight C Batteries ellow & Pink part for flashlight
™ Red flashlight

E Yellow & Pink part for fiashlight Warkflow Task Column » ﬂ':‘
-7 Flashlights SalesItems Assignee —

[+-{I7] Displays object >

B#1-7] Furniture Primary Color d Group : Super Users

[#-[T] Automotive D * |user : User 2

[+-{I7 Building Products Mame : * JUser : User L

[-[[7 Electrical and Electronics = WI—!“ Ia.st Edlted?‘ *

[+-[{7] Food and Beverage Rejection -

-5 Kitchen N Proc=dzon)
1 | LLLJ r Headers marked with asterisk {*) spedifies workflow mandatory values
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Auto-Initiation of Tasks in Workflows

Automatic initiation is used to automatically initiate an object into the desired workflow, otherwise a manual action
is required. With auto-initiation, items can be pushed through automatically, making it much simpler and more time
effective.

Two common scenarios for auto-initiation are:

1. Once a user creates an object in workbench or Web Ul, the object can be initiated automatically in the specific
workflow.

2. When new objects are imported, the object can be initiated automatically in the specific workflow.
For example, if a workflow is valid for Products, Classifications, Assets, Entities, Publications, Publication
Sections, or Flatplanner Planned Pages, it is possible to have an instance of a given workflow created whenever

an object of the valid object type(s) is created. In other words, a workflow is automatically started when the object
is created.

Setting up Automatic Initiation of Tasks in Workflows

1. To set up auto-initiation, select the System Setup tab and expand the folder that houses workflows.

2. Select the desired workflow (in this example, Shipment Order Process will be used) and check the 'Initiate
automatically' checkbox on the STEP Workflows Editor tab.

System Setup Jhlpmunt Order Process rev.0.81 - STEP Workflow Editc

EH-E] Workflows Sl sTEP Workflow Editor [T, Status
@ Sales Item Creation
1|13 Sales Item Creation - original Name Value
@ Sample Workflow > ID 11123
% Sample Workflow(2) > Mame Shipment Order Process
..
» Revision 0.81 Last edited by USERL on Thu May 26 11:24:45 EOT 2016
» Initiate automatically I
* Listen on updates from import
» lse executing user's write privileges
|| || * Disable transitions on terminated Workspaces
» Start Condition
? UsedlocalBusinessRules
Title * |State > |STEP Workflow Component
» (an-92a63753-4a7-448 3-b5c8-d399a IConfirm data -> Review Data On transition
> (acn-dab535fa-4739-4695-803b-5f3173Review Data On entry
'
ite » |State > Warkflow Compon... * |[Description >
4
Applies to > |Action Set  * [Attribute G... * |Object Type * |Group » |Language > |Country
I add Priviege

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 114



1STIBOSYSTEMS

e MASTER DATA MANAGEMENT

Whenever an object of a type valid for the workflow is created, a workflow is started. This could happen via
workbench, Web Ul, web services, or through an import.

Initiating an Object Automatically in Workflows

Before creating an object, it is important to know what the desired workflow is valid for, otherwise the object will not
be able to automatically initiate. To check the validity type, view the workflow and select the Validity tab. In this
example, the Shipment Order Process workflow is valid for products that have one of the three object types below.

|| Discontinued State *
F.] Error

@ Flatplan group assignment

- 5| Bhipment Order Process| All

Item
TtemFamily

ItemFolder

Create and Initiate from Workbench

Once the validity type is verified, a product can be created in the workbench by entering an ID and name, as well
as any other required data. The following image shows that a Supplier Part Number is required to create an item.

< Shipment Order Process - Validity

STEP Workflow Editor |[caa | Loa || Status
?

Create Product

~ Object Type

(@ Ttem

() Item Folder

~ Attributes
MName | * |Value >
> Supplier Part No. 1za

ID 179835

Mame Ski Hat

Create Cancel
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For more information on creating new objects see the Creating Objects in Tree topic in the User Guide /
Getting Stared documentation.

There are a number of ways to verifying that the product was automatically initiated into the desired workflow. A
few are:

« Onthe Search tab, search the workflow to verify the object is displayed as a resullt.

STEP Workflow

STEP Workflow :Shlpmmt Order Process ! Search Result Profiling

Initiate Data
state fatea 1 hit(s)
Click links to narrow down search

Er . .
Displaying 1 of 1 results Show Details -

Name || Results by Object Type
ﬁﬁkj Hat ID = 179835 Product (1) - e=clude

EHEH"I (1} - exclude

m

Results by Position in Tree Hierarchy
Results below child nodes of Hats and Caps [tems
B8 skiHat (1) - sxcluce

Results by Parent

Operations on Entire Result Il Hats and Caps ltems (1) - ssxclude

=

1

« Navigate to the STEP Workflow tab, open the workflow, and verify that the object appears in the first state in
STEP Workflows ltems tab.

STEP Workflow STEP Workflow Items
Profile | Products || References || Referenced By

2 Shipment Order Process <& Object Who Approved? » Date

Cli jislia) |~
=
1
2
0
0

W

Filter by Collection

Initiate Data

Review Data

Confirm data

End State

= Workflow3

- Workflow 4 ¥

Proceed 1 v | Submit
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« Navigate to the item's Task tab and verify that the object appears in the desired workflow flipper.

L Tree < Ski Hat rev.0.1 - Tasks
Category Profile ProoF‘l.l"ewl Status || State Log

n -
[T Upper Body Wear
Ei Head Wear Referenced By ” Images & Documents Comme

=N {15 Hats and Caps STEP Workflow Items ” Product ” Sub Products
=t il Hats and Caps Items @
- (A777)(2)
E {111778) :
E (120170) . Ohject .
E (120666) E:'aht: Approved? .
- ™ 103308 Proceed 1 v | Submit
ﬁ Blue Hat

ﬁ Gray Hat

E Industrial Hard Hat

e

m | »

Ski Hat

W W

.‘

Create and Initiate from Import

Another way to create and initiate objects into a workflow automatically is to do so via an import, where product
information, such as that below, is uploaded to the STEP Workbench.

4 a | B | C | D
<0bject Type

1 <D= <MName> <ParentlD> MName>

2 (179835 SkiHat 20436 Item

3

To automatically initiate items upon import, in the Import Manager wizard, under 'Advanced Settings' check the
Auto-Initiate STEP Workflow on Item Creation option.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 117



Import Manager

T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

Steps Advanced Settings
1. Select Configuration Context English US V| A
2. Select Data Source
Import Process Template: Importer
3. Select Format
4. Map Data Match Units By Mame ~
5. Identify Objects Approve Import Changes ]
6. Identify Destination Auto-Inidate STEP Workflows on Item Creation
TofzEmiiorI M Trigger STEP Workflow import events on Item Updates [ ]
8. Advanced Settings
Suppress Re-Translations
Auto select Import Mode @
Force Database Import )
Force Domain Import O
Remove Options r Remove Un-Mapped Value
Attribute Group ]
| * | Select Attribute Group(s)
r Remove Un-Mapped Data Containers
Data Container Type * W
Back Mext Cancel
When the import is run, a background process is created and the user can see the object(s) initiated into the
workflow in the background process.
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) Execution Report

Retrieval started (Tue May 31 12:15:48 EDT 2016)
Retrieved 9402 bytes (Tue May 31 12:15:48 EDT 2016)
Conversion started (Tue May 31 12:15:48 EDT 2016)
Converted 1 objects (Tue May 31 12:15:48 EDT 2016)
Logged an

Mapping started (Tue May 31 12:15:48 EDT 2016)
Mapping completed (Tue May 31 12:15:48 EDT 2016)
Import Started (Tue May 31 12:15:48 EDT 2016)

Logged On

Using import mode "domain”™

Starting first import pass (creating system setup objects)
Starting second import pass (imporing data)
Started 1 objects in Workflow "11123 (0 failed).
Imported 1 new products, 0 new classifications, 0 new entities and 0 new assets.

Processed 1 existing products, 0 existing classifications, 0 existing entities and 0 existing assets.
Skipped 0 products, 0 classifications, 0 entities and 0 assets.

Deleted 0 products, 0 classifications, 0 entities and 0 assets.

Found 0 warnings

Found 0 errors

Import completed (Tue May 31 12:15:48 EDT 2018)

For more details on the Import Manager functionality and the Import Manager wizard, see Creating a Data
Import in the Data Exchange documentation.

Disabling Auto-Initiation

If a user has the 'Disable STEP Workflow Auto-initiation in Imports' privilege for a workflow, he/she is allowed to
disable auto-initiation in the Import Manager (column based Imports) or directly in the XML for XML imports (by
setting Autolnitiate="N" in the STEPProductinformation tag as shown below).

<?xml version="1.0" encoding="utf-8"7=

<STEP-ProductInformation ContextID="Contextl"” wWorkspaceID="Main" AutoInitiate="N">
<Products ID="179859" DefaultParentID="20436" DefaultUserTypeID="Item"=
<Product />

</Products>

</STEP-ProductInformation:
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Auto-Routing Tasks in a Workflow

In workflows, there may be cases where the system (via business rules) should make the decision for the path a
task takes through the workflow, rather than a user. While there are many use cases for this, a simple scenario is
the'if X, then Y' reasoning. For example, a user may have a workflow set up that evaluates each product that
passes through a particular state to see if there is lead in it. If so, special handling instructions need to be applied,
whereas this is not required for items that are lead-free. Therefore, tasks are automatically routed to differing
states based on the presence / absence of lead, which is determined by an attribute value.

This topic describes the preferred method for basic auto-routing of tasks, and allows for users to submit a task
without requiring any knowledge of where it needs to go next, as this is evaluated and determined via a series of
conditions on the available transitions. There are additional methods available for auto-routing of tasks, including
via use of the Scripting API Task interface and the triggerBylD() and triggerLaterByID() methods.

Auto-routing using conditions requires that all transitions from the state have the same event name applied. It is
also important to remember that all conditions return either true or false, and that a condition evaluating to true on
a transition means that the transition can be taken, while a condition evaluating to false means that the transition
cannot be taken.

This setup can be used to skip states, as well as to select between one of two states. Therefore, either of the below
workflows could utilize it, and in both cases the outcome will be that the task is sent to the Has Lead state from the
Review Data state, if needed. Note that in all cases, all transitions out of the Review Data state have the Proceed
event. With this setup, the end user will see only a single selection option (Proceed) when submitting the task,
allowing the system to make the decision, while keeping things simple for the end user.

Proceed

Gather Data (1

Proceed

Gather Data (1)

k-
—

lr—-"'
Review Data ([ Procesd
—

L

F‘ruceecit ..I.'-""Fﬁ‘ceg_d Review Data
Has Lead e Proceed .- T Proceed
L P "

- ¥ .
-
w x"x H\“u‘ ,a"'ﬁf
yE yE
Final Review AR0I0 _ £R0r0
(oo ]

Approve

Prog

Finish

Df
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In order to determine where the task should go, an attribute with ID=HaslLead is evaluated. If the value is Yes, the
task must go to the Has Lead state. If the value is No, the task must take the other transition. We could setup a
"Yes" condition and a "No" condition, applying one to each transition out of the state as appropriate, and that would
accomplish the end result. However, if an object did not have the HasLead attribute populated, it would not have a
viable transition, unless we wrote a condition to account for a null value. Assuming mandatory attribute
functionality was applied and we could ensure a value was present, there is however still an easier way to do it
using only a single condition, which evaluates to true if HasLead=Yes. By leaving another transition with no
conditions applied, and instructing the system to always evaluate the conditioned transition first, all tasks with the
Yes value are caught first and appropriately routed, and all tasks with a 'No' or null value take the other
(unimpeded) option.

Detailed instructions and additional considerations for this setup are below.

1. Setthe order in which outgoing transitions are attempted by right-clicking on the state that has the multiple
transitions with the same name coming out of it, and selecting Edit Order of Outgoing Transitions.

%] Edit State

Proceed

> Delete

Has Lead &)

..I

Edit Order of Outgoing Transitions

Approve

5 Recursive Auto-Layout
[

Auto-Layout

2. Inthe dialog that appears, select any entry and use the Move Up or Move Down buttons to set the appropriate
order. Note that the example uses only two transitions, but this method works for any number of transitions.
The '0' transition is evaluated first, and subsequent transitions are evaluated in sequential order. The system
will send the object via the first transition it finds that evaluates as true.
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Gather Data (1

Review Data

Transition Order E...

Procesd .- Proceed
L Move Up Move Down
0: -= Has Lead [Proceed]
Apprwemh Approve 1: -= Lead Free [Proceed]
oK Cancel

‘.I

If multiple transitions will exist with conditions applied, care should be taken to ensure that they are sequenced
properly, that they do not overlap unless intended (and managed via sequencing), and that all tasks have a
way to exit the state. With that in mind, it is generally advised to ensure that conditions are exclusive (e.g., a
task is not likely to evaluate true for more than one transition), and that one transition exists unimpeded (e.g.,
without a condition). However, there are exceptions, so carefully test the design and outcome.

. Set a condition on the transition to be evaluated first. For the purposes of the example, a basic attribute value
comparison will be done, but any condition could be used. Double-click on the order zero transition to open the
Transition Editor. Select the Condition tab and click the Add new Business Condition link. Click the Edit
icon to open the Edit Operation dialog and select Attribute Value Comparison from the dropdown. Select
the appropriate attribute, operator, and value. Click Save to close the Edit Operation dialog, and click the X in

the upper right corner to close the Transition Editor.
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[ 1 Transition Editor e
Edit

Events Condition On Transition Mandatory Data

Business Ruke | (con-2d838242-89c5-48c3-ad49-bc571ceb64es) [l [N (W] || [
Name

Description

Type Condition

Scope Local

Run as privieged [ ]
_ Edit Operation
Operations Dependencie

[ Attribute Value Comparison r.
]| True if value fa
S —

==fp- Has Lead (HasLead) |... = ¥  Yes -

Save Cancel

Add new Business Condition

Show Edited Transition
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Bulk Update Operations for Workflows

The STEP Bulk Update operations is an efficient way of updating multiple objects in a single operation. For
workflows it can be used to claim multiple objects in a specific state in a specific workflow, initiate multiple objects
into a specific workflow, remove multiple objects from a specific workflow, or trigger a specific event for multiple
objects in a specific workflow.

Bulk Update
Steps Operations
12-. {;D:Eﬁf:tr:.; Merge Attribute Values | %
3 Parameters Attribute values 2 | Into | L
4. Preview Data Containers > 0
5. Advanced Data Quality » @lvalues ~
Merge Golden Records > E
Publishing 2
References and Links 2
Workflow ec— > Claim
Run Business Rule Initiate items in STEP Workflow
Send Republish Event Remove items from STEP Workflow
Set Name Trigger STEP Workflow Event
Set Object Type
Add Operation
Back Mext Finish Cancel

For more on bulk updates see the Bulk Updates documentation.

The table below defines how each operation is expected to perform. Additionally, the next proceeding sections of
this document will explain how each operation works more precisely.
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Operation Description

Claim

Assigning a workflow task to a specific user

Initiate items in STEP Workflow

Workflow.

Bulk update is performed on the objects to initiate them into a selected

Remove items from STEP
Workflow

Removes all objects from the selected workflow.

Trigger STEP Workflow Event

Triggers a selected workflow event.

Claiming a Task in a Workflow

The 'Claim' bulk update operation allows the user to claim multiple tasks in a state at one time. For example, if
there are 10 tasks in one state, instead of a user having navigate to the STEP Workflow tab, opening up the

desired workflow and clicking each individual task using the claim button, dﬁ, in the STEP Workflow Items tab, a
user can claim all the tasks at once using bulk updates.

Claiming a Task

To claim tasks, the following steps need to be followed by the user who wishes to claim the tasks. In this case it is

UserlL.

1. Itisimportant to check and make sure that the tasks are initially unassigned to any user in a state.

[ Products " References " Referenced By ]

Yellow & Pink part for ﬂashllght > |E|Iue Hat

IWorkﬂnw Task Column > ﬂf] df]

Agsignee > Group @ User Group Group : User Group
Primary Color > Eraﬁ-I

D » (135008 20805

Mame ¥ fellow & Pink part for flashlight Blue Hat

Who last Edited?* >

Rejection™ > Meeds to be re-stiched

2. Once verified that they are unclaimed, go to the Search tab, and select STEP Workflow from the dropdown.
Next select the desired workflow and state to display the objects present in that particular state, and click the

2
bulk update button, .
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2 | 8 || [STER Workflow 5
X STEP Workflow | Shipment Order Process -
2| State Review Data -
. . .
e

lll 1 JE | Reset ||

Displaying 2 of 2 results Show Details
Mame

. - Blue Hat 1D = 20805
* i Yellow & Pink part for flashlight D = 135005

a4 | ] b

- Operation ntire Result

uw
]
uw
uw
]
[
o
il
]
@
o
5
=
3]
A
E
]
=
=l
I
D
El
=]
&
it

This will create a bulk update for all of the objects in that particular state. Additionally, it is also possible to save the
search results as a collection, and schedule a bulk update by selecting the saved configurations. Note that this also
saves all tasks that show up in the sate in the collection.
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Bulk Update
Steps Operations
1. Configuration i
2 Merge Attribute Values }fri:
. Operations
i | into 4
3 p t Attribute values 2 IZI | ||£|
4. Preview Data Containers P ﬂ

5. Advanced Data Quality » @lvalues “
Merge Golden Records = —v‘

Publishing 2

References and Links 2

Workflow ? Claim

Run Business Rule Initiate items in STEP Workflow
Send Republish Event Remove items from STEP Workflow
Set Name Trigger STEP Workflow Event

Set Object Type

Add Operation

3. Select the workflow and the state from the dropdown.
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Bulk Update
Steps Operations
1. Configuration Claim o
2. Operations STEP Workflow: | Shipment Order Process e
3. Parameters P 5
Current State: iReview Data HEV
4. Preview
5. Advanced
Add Operation
Back Mext Finish Cancel

4. Navigate through the succeeding windows, and click on Finish.
5. Abackground process, BGP, will run and when clicked upon, will display the report of the bulk update process.
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Bulk Update - Background Proce

Background Process JIsTE=1=0 00

@Propertes

Property * Value »
Started by LISERL

Id BGP_180209

Description Bulk Update

Execution Server doc-dev

Status su::ceeded

Created Thu Jun 16 10:51:46 ECT 2016
Started Thu Jun 16 10:51:51 EDT 2016
Finished Thu Jun 16 10:51:51 EDT 2016
Processing Time OmQOs

Time in Queus Om5s

# of warnings ]

#of errors 0

2 Context: Context1
* Waorkspace: Main
Commit Mode: Commit
Auto Approve: No

fu

n

= Collection: BGP_180209 tmp input

Configuration: temporary configuration
% Read bulk update operation configuration successfully (Thu Jun 16 10:51:51 EDT 2016)
= Created temporary collection: BGP_180209 tmp fail (Thu Jun 16 10:51:51 EDT 2016)

@ BxeautonReport

1 Bulk update background process started (Thu Jun 16 10:51:51 EDT 2016)

=)

12 2 objects OK. 0 objects failed.

14 End of Summary

Applying operations to dataset (Thu Jun 16 10:51:51 EDT 20186)
T Summary (Thu Jun 16 10:51:51 EDT 20186)

12 0 info messages. 0 warning messages. 0 Error messages.

If the BGP was successful, navigate to the STEP Workflows tab again and check to see that the items are now
claimed and assigned to the appropriate user, in this case User L.
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STEP Workflow Items |0l | References || Referenced By

Blue Hat » [Yellow & Pink part for flashlight W
Workflow Task Calumn > é:l éﬂ
Assignee * User i User L User : User L
Primary Color > Gray
D > 20805 135003
Mame » Blue Hat Wellow & Pink part for flashlight
Who last Edited?* »
Rejection™ » Meeds to be re-stiched

Initiate Items in STEP Workflows

Whenever new objects / products / items / or tasks are created or on-boarded, it has to be processed via the
workflow. Instead of initiating each item individually, a user can save time by initiating them all at once in a bulk

update.

How to Initiate Tasks in STEP Workflow Using Bulk Updates

The following steps are required configurations to run a bulk update. It is important to keep in mind that a workflow
needs to be valid for the objects / products / items / tasks being initiated into it.

1. First search for the products that are to be initiated into the desired workflow and select the button for a bulk

update.
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Search
Search Below
’VHEF'JS -High: 3" or higher (20654)
EE | Reset || _
Displaying 10 of 10 results Show Details
Mame »

* Qs 20714 1D = 20714

* N 20714A 1D = 135835

* ] 20714-B D = 135575
> e 20714-C D = 135830
* N 20714-D 1D = 135851
* Wi 20714-E I} = 135832
* N 20714-F ID = 13558335
. o Dress Shoes 1D = 135874

* i Heels - High: 3" or higher 1D = 20594
* i Red Pumps D = 20595

-Operations on Entire Result

Alternatively, you could click on the objects in tree and go up to File > Bulk Update > Run Bulk Update.

2. Inthe Bulk Update wizard that appears, navigate to the Operations window and select Workflow > Initiate
items in STEP Workflow. Select the correct workflow from the dropdown, and add a process note if desired.

Bulk Update
Steps Operations
1. Configuration Initiate items in STEP Workflow e
2. Operations Choose a Workflow: | Item Creation o
3. Parameters :
Process Note: Importing Shoes
4. Preview
5. Advanced
Add Operation
Back Mext Finish Cancel
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3. Navigate through the succeeding windows, and click on Finish.
4. A background process, BGP, will run and when clicked upon, will display the report of the bulk update process.

5. Ifthe BGP was successful, navigate to the STEP Workflows tab again and view the items that were initiated in
the workflow. The assignee of all of these items will be the user who is logged in and performed the bulk
update.

STEP Workflow STEP Workflow Items

Profile P Wao 0 = Products || References || Referenced By

§' Shipment Order Process - Jobject » Who Approved? > Date  * \Workflow Deadline >|At13chment1 » [WorkflowAssignee >
o | T I &8 (1 &8 » j20714 | [;]User : User
|Fi|ter by Collection |E] » 07148 | [;]User : User
Initiate Data 10 > 120714-C | [;]User : User
Revi Data 2 > 207140 | E]User : User
Confirm data 1 > 20714-E | [;]User : User
Approve Data 3 > 20714F | [;]User : User
Ttems packaged 1 > 207144 | [;]User : User
End State 1 » |Dress Shoes | E]User : User
= cOneButton1 £ | || * Heels - High: 3" ar higher | [;]User : User
@ Workflow » JRed Pumps | [;]User : User
EF Lser Web UT Workflow

& WF_Addint_Logic i [Proceed 1 v][ Submit ]

Removing Items from STEP Workflow

Should a user want to remove all objects from one state in a workflow, they can do so using bulk updates if they
have the ability to search the STEP workflow tab, and they have the 'Perform Bulk Update' privilege.

For complete directions on how to use bulk updates to remove items from STEP Workflows, see the Remove
Objects From Workflows topic in the Workflows documentation.

Trigger STEP Workflow Event

This function is useful when a user completes multiple tasks and needs to trigger multiple tasks from one state to
another at one time

How to Trigger STEPS Workflow Events

For example, if a workflow has a state called Confirm Data with 7 tasks in it that all need to be moved to the next
state, called Approve Data, the user would follow the steps below to perform this action.
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STEP Workflow L 4 STEP Workflow Items

Praofile A DA YRS | Products || References || Referenced By
& sShipment Order Process - Cbject » [City >[I0 > [Mame >
- 20714-E > 20714-E 135832 20714E
— — — 207148 > 207148 135829 207148
[Fiter by Collection [ [|0725< > [20714C 135830 20714-C
207144 * 207144 135828 207144
Initiate Data 16
- € 20714-F * 20714-F 135833 20714F
L] 2 flashlight case » flashlight case 129666 flashlight case
Confirm data 7 I 20714D » [20714D 135831 20714D
Approve Data 3
Items packaged 1|7
End State 1
= sOneButton1 il Submit

1. Firstgo tothe Search tab, and select STEP Workflow from the dropdown. Next select the desired workflow

%
and state to display the products present in that particular state, and click the bulk update button, .

Search
STEP Workflow: ;]
STEP Workflow | Shipment Order Process -

State Confirm data -

EE Reset || -
Displaying 7 of 7 results Show Details
Mame

4 | i 3

-Operations on Entire Result

2. Inthe Bulk Update wizard that appears, navigate to the Operations window and select Workflow > Trigger
STEP Workflow Event. Select the correct workflow, state, and event to be performed. Add a process note if
needed (process notes are the information for the users in the next state.).

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 133



1STIBOSYSTEMS

e MASTER DATA MANAGEMENT

Bulk Update
Steps Operations
1. Configuration ™ Trigger STEP Workflow Event ot
2. Operations STEP Workflow: | Shipment Order Process o i
3P Confirm data
. ontirrm da e
4. X Current State:
5- M\!‘EI‘IC-B[' E\.,rent: Proceed 3 il
Process Mote: Al are ready for approval

Add Operation

Back Mext Finish Cancel

3. Navigate through the succeeding windows, and click on Finish.
4. A background process, BGP, will run and when clicked upon, will display the report of the bulk update process.

5. Ifthe BGP was successful, navigate to the STEP Workflows tab again and view the items that were moved
from one state to the next in the workflow.

STEP Workflow STEP Workflow Items

Profile VLT DB B | Productks || References || Referenced By
2 shipment Order Process Object > Name ’
207148 > 207148 207148
G P L ] “as || o | 20714C > [20714C 20714C
207144 > [207149A 207144
Filter by Collection
[Fiter by Lo flashiight case > fiashlight case flashiight case
Initiate Data 16 109308 > (109308 109308
Review Data 2 20714E » 20714-E 20714E
Confirm data / 0 Blue and Purple Flashlight » Blue and Purple Flashlight Blue and Purple Flashlight
A Data 10 Silver Flashlight * Silver Flashlight Silver Flashlight
=\ |(20714F > 20T714F 20714-F
Ttems packaged L |[z07140 > [20714D 20714D
End State 1
cwonent - T
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Business Rules and Workflows

When working with workflows, it is very common to use business rules. They can help with a number of functions,
such as sending email, validating data, moving a task through a workflow, assigning tasks in a workflow to
particular users, among many other actions. It is important to know that business actions can take actionsin a
workflow, while business conditions are able only to check and/or validate data.

This topic provides a general introduction to some overall functionality specific to business rules in workflows.
Much more information regarding business rules in general (applicable to rules used both within workflows and
external to workflows) is available in the general Business Rules section of the documentation.

A Simple Example

Below is an example of how a number of business rules can work together to make a coherent and functioning
workflow. Itis possible to define business actions to be executed as part of the workflow on states or transitions,
and to define conditions to be tested before transitions between states are performed.

STEP Workflow Designer - ContractAgreements

File Edit View
Waorkflow Properties A
ID ContractAgreements
Mame |Contract Agreements
Submit
Workflow Variables/atachments
'assignee’ abis [ Edit@@@ },
‘Released_by' abis R/giie‘ct
supmit
SIS o
[ Review ]
Validation errors: v
Accept
¥
[ Done ]
L
< >

For example, a company needs a number of documents signed and agreed upon before they can proceed with
their new business partners. In order to make sure that the documents were reviewed and signed to exact
specifications, the workflow above was created to help with the process.
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For this workflow a document, or task, enters into the Start state where it is picked up by an assigned user, #.
After all assignments are completed they submit the task to the Edit state. Next, a user claims the task, completes
any assignments regarding the task on time, &, and then submits it to the Review state. As they submit it to the

Review state, a business rule captures the ID of the user who submitted the task, ©.

Once in the Review state, a new user claims the task. If however, they do not think that it is ready for review, they
have the option to send it back to the Edit sate. If they choose to do this, as the task enters into the Edit state again,

there are business rules in place to send the task back to the user who originally worked on it in this state, ', and
sends them an email to notify them it was rejected back to them.

However, if the task enters the Review state and the user who picks it up does think it is ready to be delivered, they
can choose to accept it, and submit it to the Done state. Notice that a condition is in place on the transition from the
Review State to the Done state. This condition makes it so that the reviewer has to populate an attribute field on
the task called 'Approved' to 'Yes' in order for it to be submitted to the Done state successfully.

A few aspects to note:

« Ifascript exception is thrown during the transaction, or the assignee for the Edit state cannot be set, the
entire transaction including any changes made is rolled back

« When the On Transition Action is executed the task is not in any state, any attempt to manipulate a task will
cause an error to be thrown, and again the transaction will be rolled back

Applying Rules in a Workflow

Business actions can executed from workflow states at three points:
1. Entering a state (On Entry)
2. Exiting a state (On Exit)

3. Aspart of an escalation when a deadline for a state has been met (see Deadlines and Escalations inthe
Advanced Workflow Topics documentation for more details).
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State Editor

Edit 1 2 3

State OnEntry OnExit Assignee i Deadline/Escalation: Comments Web UI Screen Mapping Mandatory Data

Deadlne

Hour(s) R

Escalation

Business Rule ‘ Ea @ 'K

Mame

Description

Type Action

Scope None

Run as privieged [ ]

Operations Dependencies Applies if

Add new Business Action

Show Edited State

Business actions can also be executed on transitions between states:
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Transition Editor

Edit

Events Conditior N TfEﬂEiﬁﬂEi Mandatory Data
Business Rule . BEEN R

MName

Description

Type Action
Scope MNone

Run as privieged [ ]

Operafions pependencies Applies if

Add new Business Action

Show Edited Transition

Business conditions can be executed only on transitions:
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Transition Editor

Edit

Events fcondiior§ on Transition Mandatory Data

Business Rule o B @ by

Name

Description

Type Condition
Scope MNone

Run as privieged [ ]

Operafions pependencies Applies if

Add new Business Condition

Show Edited Transition

Regardless of the place the rule is applied, or whether it is a condition or an action, a few things are common to the
editors (and specific to the business rule editors within workflows).

To add a business rule to a workflow, click the ellipsis button (|...|) and select an existing rule (1), or click the Add
new Business Action/Add new Business Condition link (2).
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State Editor

Edit

Deadline/Escalation Comments Web UI Screen Mapping Mandatory Datz

State On Enfry On Exit Assignee

Business Rule 1) N\l B & (X
Mame
Description
Type Action
Scope Local

Run as privieged [ ]

Operations Dependencies Applies if

< >
Add new Business Action e

Show Edited State

Defining a new business rule from within the STEP Workflow Designer, creates a local business action (2), while
selection of an existing rule (1) allows users to choose from global rules.

Important: Local business rules can only be used in the workflow where they were created.

If arule could be re-used in multiple locations, it is generally better to create it as a global rule.

If a local rule has been created, it can be promoted to a global rule using the hand icon . This creates a global
copy of the rule so that it can be used elsewhere.

If a global rule is selected, it can be edited using the edit icon , though care should be take with this as it results

in changing the rule in all places where it is used.

If a global rule should be changed, it is often better to make a local copy of the rule using the copy button ,
ensuring that any changes made to the rule will only affect the current workflow.

Local business rules created or edited through the STEP Workflow Designer are saved when the workflow is
saved. Global business rules are saved when changes are saved within the business rule editor.
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Workflow Business Rules in Operation

Each time a business action or condition is configured on a state or on a transition, the workflow has indicators to
signal to the user where these business rules have been applied. The indicators are the following:

Indicator Description

‘Al A default assignee for a particular state (or workflow) has been assigned.

D' A default deadline has been selected.

' Signals the configuration of an 'On Entry' action. It may help to remember this as 'l' for 'In’
(e.g., into the state).

'O Signals the configuration of an 'On Exit' action. It may help to remember this as 'O’ for
'Out’ (e.g., out of the state).

dotted transition Indicates a condition has been placed on the transition.
line

rounded end on Indicates an action has been placed on the transition.
transition

Order of Operation

Itis important to note the order of operation of the various rule types (condition or action) and where they are
applied (entry, exit, transition, or deadline). Consider an object going from a current state to a next state. Business
rules are evaluated in this order:

1. Condition on transition exiting current state

On exit action from current state

On transition action between current and next state

Default assignee on entry to next state (if assignee is set in workflow designer rather than using business rules)
Deadline set in next state

o g bk~ w0 DN

On entry action in next state

More Information

This topic has provided a basic introduction to how business rules can be used in conjunction with workflows.
Topics covering how to carry out all of the functions described in the above example can be found throughout the
Advanced Workflow Topics section of the documentation, in addition to other use cases and topics, including:
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« Assigning Tasks Using Business Rules

» Auto-Routing Tasks in a workflow

» Configuring Status Flags in workflows

« Deadlines and Escalations in workflows

» e-Signature used to re-authenticate in a workflow
« Java API for workflows

« Remove Objects from workflows

« Running Background Processes from workflows
o Send Email from a workflow

» Validate Datain a workflow

As business rules provide robust functionality to meet the individual needs of each customer, it will also be useful to
see the general Business Rules section of the documentation to understand more advanced features, as well as
the Scripting API section of the STEP API documentation, accessed by clicking the STEP APl Documentation
button on the STEP Start Page.
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Deadlines and Escalations in Workflows

In the Workflow Designer a user can define a deadline for a state via the State Editor Deadline/Escalation tab.
This is useful for a number of reasons, one of which might be to notify a supervisor, or task manager, if a deadline
is not met for a particular task in a particular state. This may be important to know because if the task is late, it could
impact many steps that come after it.

Understanding Deadlines in the Workflow State Editor

The deadline is set relative to the time an object enters the state. For example, if the deadline is set to '5 Hour(s)',
an object entering the state at 6 a.m. will get the deadline setto 11 a.m. The available time periods are: Hour(s),
Day(s), Work Hour(s), and Work Day(s). Work hours are hard-coded to be from 8 a.m. to 4 p.m., with work days
being Monday to Friday (bank holidays and the like are not taken into consideration).

State Editor

Edit
Comments Web UI Screen Mapping Mandatory Data
State On Enfry On Exit Assignee Deadline/Escalation
Deadlne

Hour(s) R

Escalatior| Day(s)
Work Hour(s)

Businesd /York Day(s) E ﬁa ﬁ ¥

MName

Description

Type Action
Scope None

Run as privieged [ ]

Operaions pependencies Applies if

Add new Business Action

Show Edited 5tate l
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Setting Up Deadlines for Workflows

1. In System Setup, navigate to the desired workflow, right-click on it, and select Edit STEP Workflow.

2. Right-click on the desired state and select Edit State.

3. Inthe new dialog, select the Deadline/Escalation tab.

On the same tab it is possible to define or select a business action that should be executed if the deadline is met

and the background process for monitoring deadlines is run. To run this background process, right-click the
Workflows folder in System Setup, then select 'Start Background Process to Monitor Deadlines.'

=55 Workflows

5] Mew Setup Group...

ﬁ Mew Business Action

@ Mew Business Condition

@ Mew Business Function

@ Create STEP Workflow

@ Create Status Flag Ctrl+5hift+5

@ Start Background Process to Monitor Deadlines  Ctrl+Shift+D

& Cut Ctrl+X

Copy Ctrl+C
Paste Ctrl+V

¥ Delete

Once selected, the dialog to set the frequency to monitor deadlines displays.

STEP Workflow Deadline monitoring.

Steps Escalating items in states with exceeded deadlines.

1. Escalating items in states with exceeded deadlines. Start

() Now 30 minutes

() Monthly

Start every 30 minutes

Back Mext Cancel
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This background process (BGP), which can be scheduled to run at specific intervals, can be started from any
Setup Group in System Setup that can hold workflow objects. Since this initiation of the BGP happens at the folder
level, this setting applies to all workflows contained in the folder.

Business Actions for the Workflow On Entry Tab

As described in the Views and Mappings for Workflows section of the Workflows documentation. Deadlines
can be viewed and manipulated in views via the 'WorkflowDeadline' Component. In the public API, methods for
getting and setting deadlines are available via the Task interface. Below is an example of how a deadline can be
set to an hour from now in a business action, in an On Entry tab.

var date = new Date();
date.setTime (date.getTime () + 3600000) ;
node.getTaskByID ("Workflow ID", "State ID").setDeadline (date);

As the deadline is set via the Task interface, the above will only work from the state with ID 'State ID'. An example
can be seen in the image below:
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] State Editor o
Edit
Compents Web UI Screen Mapping Mandatory Data
State On EntTy On Exit Assignee Deadline/Escalation

Business Rule rule to be saved with workflow) | ... 'ﬁ IE' Q *

Name | |
Descriptio Edit Operation
T‘y"pE [ Execute JavaScript
Scope ;

P Binds: ? Binds
Run as pr| Variable name * | Binds to

. node Current Object

Operationy

:

Cre

Prd || Messages: ¥ Messages

As \Variable name » |Message > | Translations
Aul

A3

JavaScript: | 1 var date = new Date();
2 date.setTime(date.getTime() + 3600000);
2 node.getTaskByID{"Workflow ID", "State ID").setDeadline(date);
Add news Edit externally
< >

Save Cancel

When viewed in STEP Workflow, if a deadline is not yet met it looks like the image below:

STEP Workflon Items
Profile Category Profile || Proof View || Status || State Log || Tasks
T WF1 ™ Referenced By Images & Documents " Commercial ” Tables
P D D E STEP Workflow Items [ Product " Sub Products " References
WF_Test v
Filter by Collection [: D > 179782
Initial 1 Mame > WF_Test
Enrich MyVariable > BUper user
a 0 Deadline » \
@ Workflow3 | The deadline: 2016-06-03 15:14:30 not reached |
== Workflow 4
Submit
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If a user wishes to remove a deadline from a business rule, this can be done by setting the deadline to null, as
shown below.

node.getTaskByID ("Workflow ID", "State ID").setDeadline (null);

Editing Deadlines through Workflow Views and Mappings

Deadlines can also be set by editing the workbench views and mapping for a given workflow. To do so:

1. Open the desired workflows Designer and go to Edit > Edit Workflow Views and Mappings.
2. Inthe view that needs a deadline added to it, right-click on the view and select Add Column.
3. Inthe Component dropdown, select WorkflowDeadline.

View Editor

Edit

Editor xmL

. View: Inital Data Component
- BE Column:Object (WorkflowLinkedName) Title | Deadine
- B Column:Who Approved? (WorkflowVariable)
1T Attribute: Date [ ] Read Only
- B8 Column:Workflow Deadine (WorkflowDeadline)

= . Mandato

- EE Column: (WorkflowAssignee) [] Mandatory

~ B Column:Vendor (Vendor) Component | WorkflowDeadline I

-~ B8 Column:DeDuplication (DeDuplication) PluginableCellDebug Y

EE Column:Deadline PluginableCellPrimaryImage
l . View: Review Data VE”?{%f
WorkTlowAssignee

I = View: Confirm data \WorkflowAta chment
& View: Approve Data
I . View: Items packaged WorkflowLinkedName
l . View: End State WorkflowNoteColumn W

E Mapping : Inttiate Data->Initial Data
Mapping : Review Data->Review Data
Mapping : Confirm data->Confim data
Mapping : Approve Data->Approve Data
Mapping : Items packaged->Items packaged
Mapping : End State->End State
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Once selected, the deadline can be set manually in the object itself via the object's Task tab, orin the STEP
Workflows navigator tab.

129707 rev.0.4 - Tasks

=il Flashlights Item =« ||| Commercial || Tables || Category Profile || Proof view || Status || State Log

E (179301) Product ” Sub Products ” References ” Referenced By Images & Documents ]
Bz o mimmosmims :
a 179997 129707 W
a 179997 D > (129708

a 179959 Name. > 129707

E 134852 MyVariable > E
a 134353 Deadiine >

-
| " b Mo deadline has been set for this taskl B
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Deleting Objects in Workflows

Itis sometimes necessary to delete a product that is in a workflow. This could be for many reasons, including that
the product is no longer needed or is discontinued. However, if the product is currently in a workflow and a user is
trying to delete an object in a workflow, the user will be prohibited from doing so unless they 'force delete' the
object.

Delete report

Deleted 0 out of 1 objects. 1 object(s) could not be deleted due to the objections stated below.

MName
3 Asiyah Kane(2) 1D = CUS_41283¢

LT

€ ?

- Delete Objectons

"Asiyah Kane(2)" could not be deleted due to the reasons listed below:
step://entity?contextid=Context1&id=CUS5_412830&workspaceid=Main is in STEP Workflow
step://stepworkflow?id=11123.

Force Delete Close

The above message will include the list of workflows in which the product or entity exists. If the user chooses to
force a deletion, it will not only delete the product / entity from the hierarchy but will also take it out from all
workflows it is currently in.

Note: For objects that are not deleted directly, but put into the Recycle Bin, they will not be inserted into the
states they were in prior to the deletion if revived.

A force deletion of a product that is currently in a workflow should only be done when a user is sure that the
product/ entity is no longer required.

Should a user move a product/ entity to the Recycle Bin, this will also take the product / entity out of any
workflows. However, if the product / entity needs to be revived from the recycle bin it should be known that once
revived, it will not automatically go back into any workflows and their states that it was in initially. If it is desired that
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the product/ entity that was revived from the Recycle Bin go back into any workflows it once was in, then the
option 'Initiate automatically' in System Setup on the STEP Workflow Editor tab needs to be checked for all the
workflows that need that particular product / entity again.

System Setup ess_Action rev.0.66 - STEP Workflow Editor
G- 13] Approve Recursively  » | | TRk il e ol | validity |[ Log |[ Status
|| Asset Update
H"@ Busi Acti Mame »| » |Value
,@ {con-d524c5f4-0z » D Business_Action
@ ex > Mame Business_Action
-4 (acn-32611d00-7 = :
# Escalate * Revision 0.66 Last edited by USERL on Mon Jun 20 15:07:07 EDT 2016
g Released_by |I » Initiate automatically
-4 Released_B i i E‘i - — - -
g Send em;il ¥ e Automatically initiate new items in the STEP Workflow when they are created |
- * Use executing user's write privileges
Gt-[12] Business_Action(2)
IEI Clerical Review » Disable transitions on terminated Workspaces
@ Clerical Review 2 » Start Condition

If auto-initiation is turned on for the workflow, a new instance will be created. This means that if a product / entity
has an object type which is valid for a particular workflow, then the product / entity is automatically initiated to that
workflow at the beginning.
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Edit a Workflow in Use

Once a workflow has been created and is in use, it may be necessary to change it. If the workflow is not yetin use
(e.g., there are no active tasks for the workflow, or the workflow is in a test state only and not yet released for
production), editing a workflow is does not require any special considerations.

General information on creating and editing workflows can be found in the Getting Started with STEP
Workflows documentation, specifically in the Creating a Workflow and STEP Workflow Designer topics.

This topic provides guidance specifically on editing workflows that are already in production and/or contain active
tasks.

Important considerations before editing a workflow in use

When there are objects in a workflow, certain changes to the workflow are prohibited as they could cause
disruption to the tasks within them. Thus it is not possible to rename, delete, or change the state characteristics
of any states that have tasks within them. In addition, states with active tasks cannot be moved inside or taken
out of a cluster or parallel, and parallels may not have new clusters added.

Itis best to receive advice and guidance from a STEP expert before making changes to a live workflow.

Itis always recommended to duplicate the existing workflow, do the necessary modifications in the duplication,
test it, and then apply the same changes to the workflow in use.

If the required changes are significant, it may be best to process all existing tasks in the workflow, and make
sure that no new tasks are added, before the changes are made to the workflow.

Already existing business rules should be taken into consideration when editing a workflow. It is possible for a
rule to rely on a state that is deleted, event that is changed, etc that could prevent the rule from working
following updates to the workflow. It is important to evaluate all existing business rules following changes to a
workflow, and to test those that may have been impacted.
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Exporting Workflow Definitions

In order to move workflow configurations between systems and/or to compare workflow definitions using external
source control systems, workflow definitions can be exported using STEPXML and Advanced STEPXML.
Depending on the intended use of the output file, the appropriate method should be selected.

Exporting Workflow Configurations for Loading to Another System

Workflow definitions (including global and local business rules used by the workflow) can be exported in several
ways. The simplest of these is described. Exports carried out in this manner provide an encoded workflow
definition that, while not necessarily human-readable, provides all necessary information to replicate the workflow
on another STEP system.

A workflow definition (including used global and local business rules) can be exported in XML.

1. Right-click on the workflow object in System Setup and selecting Export STEP Workflow from the menu.

>[E Test Workflow
"E]ﬁ JEy B Edit STEP Workflow
- Object Ty
% Tags o Cut
- Units Copy
[+ Users &G Paste

Eh Reference

HEE S oy

41} Workspac X Delete

@ Table Ea Duplicate

- {E= Keys

: @ Export STEP Workflow |

Ii Event Qu
Cnmpuneri Remove iterns from STEP Warkflow

2. Inthe pre-configured Export Manager wizard, proceed to the Select Format step and select STEPXML from
the dropdown.
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Export Manager

Steps Select Format
1. Select Configuration |5'|'Epm - |
= : datai d formati fo that this fo i the leaf prod I i
3 Exports data in a STEP Product Information XML format, Mote that this format ignores the leaf products only setting.
4, Map Data Indude Websites |Nu y | S
> Incude Workflows |,u L |
6. Select Delivery Method
-Publishing hd
Bsk || Net || Fnish || Cancel |
3. Setthe Configuration > Include Workflows parameter to 'All' so that the selected workflow is exported.
4. Setthe Configuration > Include Business Rules (Global) and Libraries parameter to 'Referenced' so that

all global business rules used in the workflow will be included in the export.

5. Navigate through the wizard, making any other required settings, and click Finish.
The exported STEPXML file can be imported on another STEP system via the standard Import Manager.

The same export can also be accomplished using Advanced STEPXML. Following the steps outlined above, but
selecting the '"Advanced STEPXML' format on the Select Format step of the Export Manager will yield a pre-
populated export template that will produce the same results.

Steps to export the workflow in the SCXML format

1. Goto System Setup and locate the workflow

2. Right-click on the workflow and then click on Edit STEP Workflow option

3. Inthe new window, click on File -> Export, and then select the path in which the file is to be saved
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| System Setup
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Exporting Workflow Definitions as Comments for External
Comparison

Workflow definitions can be exported as comments using Advanced STEPXML. These exports can be submitted
to external source control systems for comparison purposes. Exports generated in this manner are not encoded
(as described above), allowing for readability by other systems. However, these exports do not provide the
necessary information to transfer a workflow between STEP systems and use in this manner is not supported.

To export a workflow for external comparison, Advanced STEPXML must be used and the
DefinitionsAsComments tag must be set to 'true’.

On the Select Format step of the outbound tool, choose the Advanced STEPXML format, then copy and paste the
following text into the Template field:

<?xml version='1.0'"'?>

<STEP-ProductInformation DefinitionsAsComments="true">
<STEPWorkflow ExportSize="All"/>
</STEP-ProductInformation>

An example of the output for a workflow definition as comments is shown below:

<STEPWorkflow...>
<!--Definition: [This is the Workflow definition. Removed for brevity.]-->
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[Remaining configuration]
</StepWorkflow>

For more information, see the STEP-Productinformation Tag in STEPXML section of the Data Exchange
documentation.
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Exporting Workflow Statuses

When exporting Products, Classifications, Assets, and Entities it is possible to have workflow related information
included in the exported file.

Workflow status export (STEPXML or Excel) is a kind of meta data information to communicate with the other
systems. For example, in the case of translation XML, the workflow states will act as a flag to match the status in
other systems.

When exporting STEPXML, the option to include the information is found on the Select Format page, using the
Data Objects > Include Workflow Tasks parameter. If set to 'yes', then each object in the exported STEPXML
will have a CurrentTasks element with info similar to what is shown below.

<CurrentTasks>

<Task STEPWorkflowID="Item Introduction" StateID="Technical
Specifications" AssigneelID="Stibo Systems Technical Writers"
AssignedToGroup="true" EntryTime="2012-10-18 11:31:39" Priority="-1"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="A Parallel"
AssigneeID="Super user" AssignedToGroup="true" EntryTime="2012-10-31
12:30:56" Priority="-1"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="Cl" AssigneeID="Super
user" AssignedToGroup="true" EntryTime="2012-10-31 12:30:56" Priority="-
1"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="Cl-Final"
AssigneeID="Super user" AssignedToGroup="true" EntryTime="2012-11-06
12:48:50" Priority="-1"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="C2" AssigneelD="Super
user" AssignedToGroup="true" EntryTime="2012-10-31 12:30:56" Priority="-
l"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="C2-Initial"
AssigneelID="Super user" AssignedToGroup="true" EntryTime="2012-10-31
12:30:56" Priority="-1"/>

<Task STEPWorkflowID="Testing 4-5-6" StateID="Some State"
AssigneeID="Super user" AssignedToGroup="true" EntryTime="2012-11-05
14:45:18" Priority="-1"/>

</CurrentTasks>
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Export Manager

Steps Select Format

1. Select Configuration STEFXML -
2. Select Objects

Exports data in @ STEF Product Information XML format, Mote that this format ignores the leaf products only setting.
3. Select Format
4, Map Data Incude Asset Content Mane w "
5. Advanced

Indude Warkflow Tasks Has -
6. Select Delivery Method

-Configuration v

Back Mext Einish Cancel

The same information can be included in column based exports, but data must be mapped into columns for each
workflow of interest.

To specify which type of workflow related data goes into a column, click the flipper button for the mapped data and
click the transform button for the value part. For details on this setup, see the STEP Workflow Task Info - Data
Source Outbound topic in the Data Exchange documentation.

Exports data in Excel format.

& Column (2 mapped)
@ <ID>ID =

m'llll?r' State ID E =
Header "Shipment Order Process' State ID”
[ D)vaiue 11123 State

Transformations

Target: Value
Source: '11123 State ID
Aspect: State ID e

Multi-value separator:

Assignee ID
_ Assigned to Group
Add Transformation Priority
Save EEEntr}.-'.'I'lmE
Deadline

For more information about exporting in STEPXML format, see STEPXML Outbound Parameters in the Data
Exchange documentation.

For more information about exporting data in Excel format, see Excel Format section of the Data Exchange
documentation.
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Workflows and LOVs

An LOV can be initiated into and/or removed from a workflow the same way as products, classification, entities,
and assets. LOVs can be assigned to a respective user or user group to update the LOV values, similar to the
enrichment of product attributes.

The workflow must be valid for the LOV object type ‘Domains’ as shown in the image below.

System Setup
=[] Workflows

>g {Mew Collection)
=5

@ Business_Action
@ Clerical Workflow 2
>@ Collection

@ Contact Workflow
@ Contract Agreements
0 ritical Domains
‘ Ciscontinued State
¥ vt

Approve Recursively - Validity

|5TEP Workflow Editor | BRUELTE[18Y Lngl Status

Domains are the only object type for LOV's and are found in workbench in System Setup > Object Types &
Structures > Basic Object Types > List Of Values Group Type (as shown in the image below).

System Setup
=& Object Types & Structures
[+-[ 7] Alternate Classifications
-- Assets
8 Availability
-2 Basic Object Types
{%‘ Asset Importer Configuration
-z Attribute Group
- attribute Transformation
{7 Business Action Type
{72 Business Condition Type

E@’ List Of Values Group Type

-2 Qutbound Intearation Endooir

Initiate an LOV in a Workflow

Below are steps to initiate one LOV to a Workflow, however more than one LOV can be initiated to the same
workflow.

1. Right-click on an LOV, and select ‘Initiate in STEP Workflow.’
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_ |I AT AITNTOIE STOOE
- =[]

Cut Ctrl+X

Delete

wr X

Duplicate Ctrl+J

Merge LOVs

Merge Values in LOV

Initiate in STEP Workflow
Remowve from STEP Workflow

2. The Initiate in STEP Workflow dialog will display listing only those workflows configured with validity for
Domains (LOVs). Select the appropriate workflow, optionally enter text within the Process Note parameter,
and click the OK button.

Initiate in STEP Workflow

(®) Approve Recursively
(") Business_Action

Process Mote | |

|DK||Cancel|

The LOV has now been initiated into the workflow. This can be viewed by going to STEP Workflow >
Expanding the respective workflow flipper and selecting the workflow state. The workflow editor will display.
Click the STEP Workflow ltems tab and the LOV will display.

STEP Workflow STEP Workflow Items

Prafile STEP Workflow Items | List of Values || References | State Log || Tasks
Y * [Mame WD
G P Energy Drinks > EnergyDrlnks Energy Drinks

|Filter by Collection |

Failure
Initial

For more information, see the Working with Tasks in Workflows section of the Workflows documentation.
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Remove an LOV from a Workflow

Below are steps to remove an LOV from a Workflow.

1. Right-click on the LOV which is already in a workflow, and select the option ‘Remove from the STEP Workflow'
as shown below.

e Soft Drinks % Cut Ctrl+X

¥ Delete
Bg Du plicate Ctrl+)

Merge LOVs

Merge Yalues in LOY
Initiate in STEP Workflow
Remove from STEP Workflow I

2. The Remove from STEP Workflow dialog will display with the workflow in which the LOV has been initiated for.
If required add text to the Process Note parameter, then click the OK button.

Remowve from STEP Workflow

(®) Approve Recursively (started)

Process Mote

Cancel

The LOV has now been removed from the workflow. For more information on workflows, see the Workflows
guide.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 160



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

Java API for Workflows

Complete documentation for API functionality related to workflows can be found in the STEP API documentation
at [system]/sdk or by clicking the STEP APl Documentation button on the STEP Start Page. This topic provides
some introductory information and simple examples, but should not be considered comprehensive.

In the Public Java API "WorkflowableNode" is the main interface for Workflow related functionality. All the
"workflowable" node types inherit the interface and thus you can call the available methods from the node
shorthand.

If, for instance, you wanted to get the time where an object entered a specific state, on entry to the state you could
have a business action with a script like the one below, storing the entry time in the script variable "entryTime".

var entryTime = node.getTaskByID ("Workflow ID", "State ID").getEntryTime
()

The getTaskBylD() method from the WorkflowableNode interface is called on node. This returns a Task that has
the getEntryTime() method (see the Task interface).

Note that this script will only work if the object is actually in the workflow with the specified ID and in the state with
the specified ID.

From a business rule used in a workflow (e.g., a local rule within the workflow itself), you can typically be pretty
sure that the object is in fact in the workflow. However, if you run from a business rule used elsewhere in STEP
and wanted to check whether an object was in a given flow, you could write something like:

if (node.getWorkflowInstanceByID ("Workflow ID")) {

// Object is in Workflow - do something

else {
// Object is not in Workflow - do something else
}

Thus, if the object is not in the workflow, the method returns "null" - a "false" value in JavaScript.

While in the entry time example above you could be sure that you were in the workflow, likewise if you ran the
script on entry to the state referenced with "State ID", you could be sure that you were in that state. However, if
you are working with parallels, you could wish to do something with a task on a state that is not the same as the
one you are running the business rule from. In that case it would make sense to start your script with a check for
whether your object is actually in that other state:

var task = node.getTaskByID ("Workflow ID", "ID of another State");
if (task) {
var entryTime = task.getEntryTime () ;
}
else {
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logger.warning ("Object with ID '" + node.getID() + "' is not in expected
State");

}

The two primary interfaces available through the WorkflowableNode interface are Task and WorkflowInstance.
Via the Task interface you have methods available that relate to a given object-in-state-in-workflow relation.
WorkflowInstance meanwhile gives you access to the methods relating to the object-in-workflow relation. In the
Workflow Variables topic of the Advanced Workflow topics documentation, the concept of workflow variables is
described. These variables live on the object-in-workflow relation and can thus be manipulated via the
WorkflowInstance interface.
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Localizing Workflow State Names and Events

End users interact with STEP in many languages. Though a workflow may be initially created in one language,
end users may use a different language and would therefore prefer to see workflow state names and eventsina
different language. This is possible using the Localize State Names and Events options in the STEP Workflow
Designer. With this functionality, workflow designers can create a single workflow that includes localized workflow
state names and events, thus eliminating the need to maintain multiple workflows for localization purposes.

To localize workflow state names or events:

1. From the System Setup tab, select the relevant workflow, right-click, and select Edit STEP Workflow.
2. Fromthe Edit menuin the STEP Workflow Designer, select Localize State Names and Events.

STEP Workflow Designer - SampleParallelswithPricrity

File | Edit View
Work #y Undo Iimple Parallels with Priority (SampleParallelswithPriority) &
D
™ Redo
Wark % B Progeed
- e
[B Paste
Enrich Data = Product Assets
P Delete
rd LY
B Select None V' \\ Pro::é/e‘d H.\]‘ ct\
==
V. Prucé\ed ﬁfe“wd N ) .,
Edit Werkbench Views and Mappings N vl N rd Nu_ﬁﬁg L |
Localize State Mames and Events Review Images | .~
~
Edit Event Mandatory Settings Approve Apptove
h ] L A 4
Edit Audit Action EEnri::h Data Cumplete] [Prudu::t Assets Cumplete]

3. Enter the localized values for each state name and/or event.
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Localized values entered in the workflow designer appear when users access a workflow in the relevant locale-
specific Web Ul or in a translated instance of the STEP Workbench. Within the workbench, this includes but is not
limited to: STEP Workflow tab, object Status and State Log tabs, and dropdown search options when using a
STEP Workflow search criteria.

For example, a user logging in to the Spanish workbench or Web Ul locale would see the corresponding localized
values entered in the workflow designer.

Resources

: STEP workbench (

_! STEP workbench (

_I STEP workbench (French)

Danish)

Enalish)

_! STEP workbench (Spanish)
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Buy-side/Sell-side Portal
userl

Forgot password?

Locale Enalish (United States)

English (United States)

espanol

Considerations and Limitations

« The name of the workflow itself is not translatable via this feature as this is driven by context. If the context
being viewed employs a different language than the translated workbench instance or selected Web Ul
locale, this could result in an end user seeing the name of the workflow itself and the states and/or events
within the workflow in different languages.

« Offline translation of state names and events via export / import is not supported. Exports of workflows with
localized state names or events include the localized values and import to new systems will reflect the
localizations. If an imported workflow contains more locales than the target system, only locales common to
both systems are displayed. If a new locale is later added on the target system and localized values exist for it
via previous import, the localized values will display. If an imported workflow contains fewer locales than the
target system, translations on the target system that are existing will be deleted, since the imported workflow
definition will be seen as the governing workflow.
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Mandatory Attributes and References in Workflows

Workflow mandatory attributes and references are one of the most common ways to set up mandatory attributes.
The primary benefits to using this functionality are:

« Designers are given the freedom to make the right data mandatory at the right time (as opposed to using
approval mandatory settings)

« Mandatory settings are configured a single time in the STEP Workflow Designer and take effect across all
interfaces (workbench, Web Ul, and Smartsheets), without requiring any additional configuration

« Functionality includes both visual indicators and user-facing messages at the time of enforcement (e.g.,
when a task is submitted from a state)

Essentially, workflow mandatory attributes provide a combination of the functionalities described above as they
provide both visual indicators and enforcement, and do so across workbench, Web Ul, and Smartsheets, as well
as allowing for attributes to be conditionally mandatory in all of these interfaces. Because of this, workflow
mandatory is the preferred method for handling mandatory attributes. However, this method is of course only
available when data is being populated within a workflow, so when this is not the case, the other mandatory
attribute settings described in this topic can be used.

This topic describes the functionality for making attributes, attribute groups, and references mandatory specifically
within a workflow state or for a particular workflow transition.

Prerequisites

In using this functionality, it may also be helpful to understand the other mandatory attribute settings (e.g., those
that are not specific to objects within a workflow). For more information on general mandatory attribute settings,
see the Mandatory Attributes topic in the Attributes section of the System Setup / Super User Guide.

For mandatory references, there is no general functionality, other than business rules, to make references
mandatory for objects that are not specifically in a workflow. However, references can be made mandatory in
Smartsheets without the need for business rules to enforce their population. For more information on mandatory
references in Smartsheets, see the Mandatory Attributes and References in Smartsheets topic in the Excel
Smartsheet Format section of the Data Exchange documentation.

Setting up Workflow State Mandatory Data

Users can specify which attributes, attribute groups, and references are mandatory for a selected workflow
state via the State Editor.

Setting up Workflow State Mandatory Attributes

The following steps describe how to specify which attributes and attribute groups are mandatory for a workflow
state via the State Editor.

Mandatory attributes configured on a state will be marked with an asterisk when working in Web Ul. Mandatory
attributes configured on a state will be marked with an asterisk in the workbench only if the ‘Mandatory' checkbox
is selected when adding the attribute to the workbench view. For more information, see the Configuring Views
for Workflows topic in the Workflows documentation.
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1. In System Setup, locate and select the desired workflow.
2. Right-click and select Edit STEP Workflow.

3. Inthe STEP Workflow Designer, select the relevant state, then right-click and select Edit State to edit the
state.

4. Selectthe Mandatory Data tab in the State Editor.

State Editor

Edit

State 0On Entry On Ext i
Deadline/Escalation Comments Web UL Screen Mapping Mandatory Data

@ Mandatory Attribute Groups
D ¥ [Mame * [Indude References » |Condition

» MarketingApproverdpprove  Marketing Approver, Approve.]
*|| Add Attribute Group

W

@ Mandatory Atiributes

D * [Mame * |Condition »
> Date Date [=]
* Category Description Category Description IsProductItem EI
>|| add Attribute
&= Mandatory References
| Show Edited State |

5. Click Add Attribute Group or Add Attribute to add an attribute or attribute group to the list of mandatory
attributes.

6. Ifthe mandatory status of an attribute or attribute group needs to be determined by a business condition, click
the ellipsis button (E) next to the applicable attribute or attribute group. In the Mandatory Condition editor,

configure an appropriate business condition or select a global business rule.

For more information about conditionally mandatory attributes, see the Conditionally Mandatory Attributes
and References in Workflows section of the Workflows documentation.

7. Save the workflow.
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If any mandatory attributes are missing when submitting an object in workbench or Web Ul, an error message
listing all missing mandatory attributes will appear, preventing the user from progressing through the workflow. For
more information on how Web Ul handles this, see the Workflow Mandatory Attributes in Web Ul topic in the
Web Ul Getting Started documentation.

In Excel Smartsheets, users will receive an error message when validating a sheet with missing mandatory
attributes. For more information, see the Mandatory Attributes and References in Smartsheets topicin the
Excel Smartsheet Format section of the Data Exchange / Data Formats documentation.

Setting up Workflow State Mandatory References

Mandatory references are set up in a similar way to mandatory attributes in the State Editor. Mandatory
references configured on a state will be marked with an asterisk in the following Web Ul components:

o References

» Reference Value

o Reference Header

» Referenced Asset Representation
o Classification Links

« Classification Product Links

1. In System Setup, locate and select the desired workflow.
2. Right-click and select Edit STEP Workflow.

3. Inthe STEP Workflow Designer, select the relevant state, then right-click and select Edit State to edit the
state.

4. Selectthe Mandatory Data tab in the State Editor.
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Edit

Deadline Escalation
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State On Entry
Comments Web UI Screen Mapping
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D » [Mame Indude References » [Condition >
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—>Il|,ﬂa:|d Aftribute Group
®= Mandatory Atributes
@ Mandatory References
D Mame » (Condition »
> additional Digital Assets and Files  Additional Digital Assets and Files E

>I Add Reference

Show Edited State

5. Click Add Attribute Group, then check the Include References box to make all references contained in the
attribute group mandatory for the workflow state.

6. Click Add Reference to add a reference to the list of mandatory references.

7. Ifthe mandatory status of a reference or references within an attribute group need to be determined by a
business condition, click the ellipsis button (E) next to the applicable reference or attribute group. In the

Mandatory Condition editor, configure an appropriate business condition or select a global business rule.

For more information about conditionally mandatory references, see the Conditionally Mandatory
Attributes and References in Workflows section of the Workflows documentation.

8. Save the workflow.

If any mandatory references are missing when submitting an object in workbench or Web Ul, an error message
listing all missing mandatory references will appear, preventing the user from progressing through the workflow.

In Excel Smartsheets, users will receive an error message when validating a sheet with missing mandatory
references. For more information, see the Mandatory Attributes and References in Smartsheets topicin the
Excel Smartsheet Format section of the Data Exchange / Data Formats documentation.

Setting up Workflow Transition Mandatory Data

Users can specify which attributes, attribute groups, and references are mandatory on workflow transitions

via the Transition Editor.
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Setting up Workflow Transition Mandatory Attributes
1. In System Setup, locate and select the desired workflow.
2. Right-click and select Edit STEP Workflow.

3. Inthe STEP Workflow Designer, select the relevant transition, then right-click and select Edit Transition to
edit the transition.

4. Selectthe Mandatory Data tab in the Transition Editor.

Transition Editor

Edit
Events Condition On Transitiml Mandatory Data
@ Mandatory Atiribute Groups
D » [Mame » [Include References » [Condition >
* |ColorAttributes Color Attributes (]
Eﬂ Add Aftribute Group
@ Mandatory Attributes
D » |Mame » (Condition »
» BhortItemDescription Short Ttemn Description Is Specific Hierarchy Ttem |Z|
* Date Date El
>|| Add Attribute
&= Mandatory References
| Show Edited Transition |

5. Click Add Attribute Group or Add Attribute to add an attribute group / attribute to the list of mandatory
attributes.

6. Ifthe mandatory status of an attribute needs to be determined by a business condition, click the ellipsis button (
E) next to the applicable attribute. In the Mandatory Condition editor, configure an appropriate business

condition or select a global business rule.

For more information about conditionally mandatory attributes, see the Conditionally Mandatory Attributes
and References section of the Workflows documentation.

7. Save the workflow.

If any mandatory attributes are missing when submitting an object in workbench or Web Ul, an error message
listing all missing mandatory attributes will appear, preventing the user from progressing through the workflow. For
more information on how Web Ul handles this, see the Workflow Mandatory Attributes in Web Ul section of
the Web User Interfaces / Workflows in Web Ul documentation.
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Mandatory references are set up in a similar way to mandatory attributes in the Transition Editor.

1. In System Setup, locate and select the desired workflow.
Right-click and select Edit STEP Workflow.
In the STEP Workflow Designer, select the relevant transition, then right-click and select Edit Transition to

edit the transition.

Transition Editor

Select the Mandatory Data tab in the Transition Editor.

Edit
Events Condiion On Transitiory MandatoryData
@ Mandatory Atiribute Groups .
D » [Mame A[Indude References » [Condition >
* ColorAttributes Color Attributes
» | Add Attribute Group |
E= Mandatory Attributes
@ Mandatory References
D * [Mame » [Condition >

W

PrimaryProductimage

Primary Product Image

W

_JFu:Id Reference

Show Edited Transition

5. Click Add Attribute Group, then check the Include References box to make all references contained in the
attribute group mandatory for the workflow transition.

6. Click Add Reference to add a reference to the list of mandatory references.

7. Ifthe mandatory status of a reference needs to be determined by a business condition, click the ellipsis button (
... ) Next to the applicable attribute group or reference. In the Mandatory Condition editor, configure an

appropriate business condition or select a global business rule.

Smartsheets State Mandatory Attributes and References

In Smartsheets, it is possible to enforce the mandatory status of attributes, attribute groups, and/or references on
workflow states. For more information, see the Mandatory Attributes and References in Smartsheets topic
in the Excel Smartsheet Format section of the Data Exchange / Data Formats documentation.
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Set Workflow to Ignore Mandatory Attributes and References

After setting mandatory attributes and/or references on a state, transition, or on a Web Ul screen, specific events
can be identified for which the population of the attributes and/or references should not be enforced. This allows
an object to move through designated states in a workflow, even when the object is missing mandatory attribute
values or linked references. The following example uses mandatory attributes, though the functionality behaves
identically for mandatory references.

In the below example, 'Color' and 'Material' are set as mandatory attributes on the Enrich state. If the user does
not populate these values on a given product and attempts to submit from the state via any transition (Reject or
Approve), the object would not be able to proceed through the workflow until the missing values were provided.
However, if the Reject event is set to ignore mandatory attributes, the user may send the product to the 'Rejected’
state even if 'Color' and 'Material' have missing values.

1. Inthe workflow editor, navigate to Edit > Edit Event Mandatory Settings.

STEP Workflow Designer - ltemEnrich

File | Edit Wiew
Wark

Undo tem Enrich (lkemEnrich) &

D
Redo

Mam
Cut

Wark

Copy
Paste

LIS G

X

Delete

Select All
B

Ve

Select Mone

Edit Weorkbench Views and Mappings

Localize State Mames and Events

Edit Event Mandatory Settings

Edit Audit Action

2. Inthe'Event Mandatoriness Settings' pop-up window, check the appropriate event(s) for which mandatory
attribute and reference requirements should be ignored, then close the window.
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Event Mandatoriness Settings

Tick checkbowes below for all events that
should override State and Transition
Mandatoriness

[ ] Approve
[ ]Re-Submit
[«] Reject

] Submit

3. Save the workflow.

Mandatory attributes set on a Web Ul screen are only honored if the 'Submit Action' has 'Enforced Validity'

checked. For more information, see the Mandatory Attributes in Web Ul topic in the Web User Interfaces /
Web Ul Getting Started documentation.
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Conditionally Mandatory Attributes and References
in Workflows

Sometimes it is essential for an attribute or reference to be populated in one or two specific cases, but is otherwise
unnecessary. To account for these cases, the mandatory status of attributes and references on objects moving
through a workflow can be enforced via business conditions set on a state or transition.

Mandatory attributes and references configured with a condition will remain mandatory unless that condition
returns false, indicating that the condition was not met and the attributes in question are not required when
proceeding to the next state in the workflow. Like standard mandatory attributes and references, if conditionally
mandatory attributes / references are missing values when attempting to submit an object to the next state, the
object is prevented from progressing through the workflow and the user receives a message listing the attributes /
references that have missing mandatory values. In Web Ul, these conditions can be evaluated on the fly and
dynamically reflected as the user works with the data, with a change in mandatory status being reflected on the
screen in real time, allowing users to react immediately, without having to submit and receive an error message.

For more information about setting mandatory attributes and references in workflows, see the Mandatory
Attributes and References in Workflows section of the Workflows documentation.

For more information about business conditions, see the Business Conditions section of the Business Rules
documentation.

Configuring Workflow States / Transitions with Conditionally
Mandatory Attributes

A condition can be mapped to an attribute or a group of attributes on either a state or transition in a workflow.

1. Navigate to the Mandatory Data tab in the State / Transition Editor.
2. Locate the relevant attribute group and/or attribute(s) and click the ellipsis button (...) in the 'Condition’ column.
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State Editor

Edit

State  OnEntry OnExt Assignee Deadline/Escalation  Comments Web UI Screen Mapping Mandatory Data
@ Mandatory Attribute Groups

0] » [Mame Include References * |Condition >
* lzameAttributes Game Attributes ] Game Reference Condition | |...

> | Add Aftribute Group

W

@ Mandatory Atiributes

D » [Mame » [Condition
» Co-op Co-op Multiplayer
* PP == Multiplayer
> | Add Attribute
&= Mandatory References

Show Edited State

3. Inthe 'Mandatory condition for' editor that displays, specify the condition to use by selecting a global business
rule via the 'Business Rule' ellipsis button (|...). Once the selection is made, close the editor.

Mandatory condition for Attribute Co-op

Business Rule Multiplayer Condition (Multiplayer) m ﬁ Eg b
Mame Multiplayer Condition

Description

Type Condition

Scope Global

Valid Object Types  |&ll object types valid
Run as privileged

Operations Dependencies Appliesif

| T
a3 JavaScriptBusinessCondi tionWithBinds: Bindings, 0 messages, if(attr == "Yes"™) {return true;}else {returnlm'l'st

< >

Add new Business Condition

Alternatively, you can create a new business condition by clicking the 'Add new Business Condition' link at the
bottom of the editor, and then click the Edit Operation button that appears. From the dropdown, select
'Evaluate JavaScript,’ then enter the business condition in the JavaScript area.
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Mandatory condition for Attribute Co-op h-4
Business Rule | (Local business rule to be saved with workflow) | ‘ |§|
Mame | |
Description | |
Type Condition
Scope Local

Run as privileged [ ]

Operations Dependencies Appliesif

. iTrue if value for Attribute ™ "null™ LT Rx

Add new Business Condition

Important: For use with conditionally mandatory attributes, the business condition should only return
'"True' or 'False.' If anything else is returned it will be treated as 'True'.

4. Once finished, click Save and close the editor.
5. Close the State / Transition Editor and Save the workflow.

Configuring Workflow States / Transitions with Conditionally
Mandatory References

Conditionally mandatory references on workflow states and transitions are configured similarly to conditionally

mandatory attributes. Conditions can be mapped to all references listed within an attribute group or to individual
references.

1. Navigate to the Mandatory Data tab in the State / Transition Editor.
2. Locate the relevant attribute group and/or reference and click the ellipsis button (|Z|) in the 'Condition’ column.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 176



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

State Editor

Edit

State  OnEntry OnExt Assignee Deadline/Escalation  Comments Web UI Screen Mapping Mandatory Data
@ Mandatory Attribute Groups

D » [Mame » [Include References » [Condition >
* lzameAttributes Game Attributes I5ame Reference Condition
> | Add Aftribute Group
&= Mandatory Atiributes
@ Mandatory References
D » [Mame » [Condition -
» PrimaryProductImage Primary Product Image FalseForDiscontinuedProducts |
ﬂﬁu:ld Reference

Show Edited State

3. Inthe'Mandatory condition for' editor that displays, specify the condition to use by selecting a global business
rule via the 'Business Rule' ellipsis button (|...|). Once the selection is made, close the editor. (This editor is

identical to the one that displays for conditionally mandatory attributes.)

Alternatively, you can create a new business condition by clicking the 'Add new Business Condition' link at the
bottom of the editor, and then click the Edit Operation button that appears. From the dropdown, select
'Evaluate JavaScript,' then enter the business condition in the JavaScript area.

Important: For use with conditionally mandatory references, the business condition should only return
"True' or 'False.' If anything else is returned it will be treated as 'True'.

4. Once finished, click Save and close the editor.
5. Close the State / Transition Editor and Save the workflow.

Conditionally Mandatory Attribute and Reference Handling in Web Ul

In Web Ul, the mandatory status of attributes and references can be evaluated on the fly as the user works with
the data, with any change in mandatory status being reflected on the screen in real time. In order to display these
dynamic changes, the attribute values driving the condition must be bound to that condition in the business rule
configuration. While the condition driving the mandatory status of an attribute or reference can take more than just
attributes into account, if something else is driving the condition, such as a reference, the page will need to be
refreshed to update the interface.
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Evaluate Javasoi

Binds: ?
Variable name *|Binds to *|Parameter »
Iattr lﬁtlﬂ'bute Value hulﬁplaver (Multiplayer)

Important: The use of business rules to determine mandatory status of an attribute or reference should be
done with care, as the performance of the dynamic behavior of the editors could be impacted if highly complex
business rules are used.

When viewing a state in a Node Editor, any attributes or references that are currently mandatory are marked with
an asterisk. If the condition returns false due to changes in data on the page, these indicators vanish. Additionally,
if there are any missing attributes that are currently mandatory, the Submit/ Approve button will be locked.

On Node Lists using Multi-Edit Display Mode, conditionally mandatory attributes and references are indicated by
highlighting the cell blue. As with the Node Editor screen, the mandatory status is dynamically evaluated so if the
condition returns false, the highlighting disappears.

Example

The business condition states that if the value of the attribute 'Multiplayer' is 'Yes', the attributes 'Co-op' and 'PvP"
are mandatory. Otherwise, 'Co-op' and 'PvP' are not mandatory.

In the image below, the condition is returning true for the Space Adventure Game, so 'Co-op' and 'PvP' are
mandatory (and are highlighted blue). Clicking Submit/ Approve if either mandatory value is missing will result in
an error message listing which mandatory attribute(s) are missing. If both attributes have values they are free to
move on to the next state.
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Fad 1D . Co-op PvP . Multiplayer ®
0O EZEE Baseball | 536126 2-6 Players 2-16 Players Yes
Space
[J Adventure 236124 2-3 Players Yes
Game
0 Cosmic Video 347736 No

Zame

In the image below, the condition is returning false for the Space Adventure Game, so 'Co-op' and 'PvP' are not
mandatory (and are not highlighted). This object is free to move on to the next state, even if 'Co-op' and 'PvP' don't
have values.

Iltem Enrich - Enrich

@ Selzct all

=]

Fad 1D . Co-op PuP . Multiplayer ®
College Baseball
236126 2-6 Pl 2-16 Pl by

O Game ayers ayers 25

Space
[ Adventure 236124 2-3 Players Mo

Game
0 Cosmic Video 347736 No

Game

In the image below, the condition is returning true, so 'Co-op' and 'PvP' are mandatory (and are marked with
asterisks). Since they have values, the Submit/ Approve button is enabled.
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Basic Information and References Display Relations Cost and Prices Status
ID 236124
Product Categoryfx Products | Electronics | Game Software | Playstation 4 | F#
This attribue will show the path to the object in the Tree tab
Mame Space Adventure Game
* Cp-pp “Sm— 2-3 Players ,;
Disc Dimensions ,;
Multiplayer Yes ,;
- m— 2-3 Players f;

In the image below, the condition is returning false, so 'Co-op' and 'PvP' are not mandatory (and are not marked
with asterisks). Since it does not matter if they have values, the Submit/ Approve button is enabled.
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Basic Information and References Display Relations Cost and Prices Status

D 236124

Product Categoryfx Products | Electronics | Game Software | Playstation 4 | F#
This attribue will show the path to the cbject in the Tree tab

Mame Space Adventure Game

Co-0p m— ’;

Dizc Dimensions B/ x53x05In "";

Multiplayer |‘ Mo "";

PYP ‘ ’

G e [ B semaroron |

In the image below, the condition is returning true, so 'Co-op' and 'PvP' are mandatory (and are marked with
asterisks). Since 'Co-op' is missing a value, the Submit/ Approve button is disabled.
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Basic Information and References Display Relations Cost and Prices Status
D 236124
Product Categoryfx Products | Electronics | Game Software | Playstation 4 | F#
This attribue will show the path to the object in the Tres tak
MName Space Adventure Game
* Co-op b ,;
Disc Dimensions ,;
Multiplayer Yas ,:5
- — 2-3 Players 4

Save Reset Save & Approve
oo

Conditionally Mandatory Attribute and Reference Handling in
Workbench

Support for conditionally mandatory attributes and references is also available in the workbench, though visual
indicators are not managed in relation to this. When attempting to submit an object, conditionally mandatory
attributes / references are evaluated and an error is presented to the user listing any missing conditionally
mandatory attributes / references (in the same manner that standard mandatory attributes / references are
reported).

Determining Mandatory Status of an Attribute or Reference

Any attributes / attribute groups and/or references specified under the 'Mandatory Data' tab of a workflow state or
transition are considered mandatory if:

« Thereis no condition set for the attribute / attribute group or reference(s)
« The condition is not applicable for the object type of the object being evaluated
« Thereis a pre-condition on the rule that is not met and therefore the condition is not evaluated
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o The condition fails
o The condition returns 'True'

The only case in which an attribute / attribute group or reference is not considered mandatory is if the condition
returns 'False'.

Because the mandatory status of an individual attribute or reference can be determined in a number of different
ways, some methods must take priority over others:

« Anindividual attribute or reference specified on the state / transition takes priority over attributes / references
specified as part of a group.

« Ifan attribute / reference is listed via multiple groups, the group configured with a condition takes priority.

o Ifan attribute / reference is listed via multiple groups and more than one of those groups is configured with a
condition, only the first condition listed is applied.

« Ifthe attribute is explicitly defined as mandatory in Web Ul via being set as mandatory on the screen, that
setting overrides any conditions that may say otherwise. (This does not apply to references, which cannot be
set as anything other than 'visually mandatory' on Web Ul screens)
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Monitoring Workflows

Workflows can be monitored via Workflow Profiles. Profiles are maintained on the Profile sub-tab of the STEP
Workflow navigator tab. Profiles are available to users with the 'View and Maintain STEP Workflow Profile’
privilege. A Profile can contain a wealth of information about workflows, such as: number of exceeded deadlines,
how long the tasks have been assigned to the assignees, what is the workflow throughput this month versus the
last six months, etc. This is all configured using the STEP Workflow Profile Wizard.

1. Tocreate a new Profile, navigate to the STEP Workflow tab, select the Profile sub-tab, and click the Create
new link at the bottom of the Profile sub-tab.

D Context |English US
STEP Workflow

Mew Item Creation Profile

[ Bookmarks ” System Setup ” BG Processes (4) ” Search ” Tree

=
=}
=
-
-
=
=
=R
LLl
==
Wi

Create new

Ready

1. ForLabel and Type, provide an ID, Label (name), assign a Setup Group, and choose a Domain (from the
options in the following table).
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4. UserGroup Filtering

Steps Label and Type
1. Label and Type jinf WorkfowProfile
e Label: Warkflow Profile
3. Collection Filtering

Setup Group:  [Workflows Murkﬁuws}|

Select Domain

5. Display
(@) States
() Assignees
() 5TEP Workflaws
Back Mext Finish Cancel
Domain Description Example
States Allows a user to view data How many objects are in the various states of a workflow
focused on workflow states. Who the state tasks are assigned to
How long the objects have been in the states
Number of exceeded deadlines
How long the objects have been in the states that are
assigned to a particular user or group
How many objects have passed through the states today
versus yesterday, versus the day before, etc.
Assignee | Allows a user to view data How many tasks are assigned to the various assignees
focused on assignees. How long the tasks have been assigned to the assignees
If the assignees have tasks with exceeded deadlines
How many tasks the assignee has completed this week
versus the week before, etc.
STEP Allows a user to view data How many objects are currently in the workflows
Workflows | focused on entire workflows. How long the objects have been in the workflow, on
average
What is the workflow throughput this month versus the last
six months, etc.

2. For STEP Workflow Filtering, determine the workflows or workflow states (within one or multiple workflows)
that the profile should contain as defined below.
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The options differ somewhat for each domain (selected in the previous step). Since profiles are not limited to a
single workflow, a user could have an Assignee-domain Profile that shows information for tasks in numerous
workflows.

The domain chosen previously impacts the options available in this step.

. States domain or Assignee domain: Specify whether the profile should contain data from all workflow
states or if it should be limited to specific workflow states only. If 'All States with tasks' is selected, the profile
will contain data from every workflow state, from every workflow in the system. The 'Hide States with no
Tasks' checkbox is only available when Specific States are selected.

S5TEP Workflow Profile Wizard

Steps STEP Workflow Fitering

L. Label and Type () All States with tasks

2. STEP Workflow Filtering

3. Collection Filtering

4. UserGroup Filtering Available States Selected States

5. Display -] Advanced Search Forecasting
{E Aaset Upda-ute Remove
{E Item Creation
- 18] Item Maintenance Add Al

{E Product Awaiting Asset Remave Al
-/ 13] Pull From Site

! u
{E Sales Ttem Creation i
{E UserPortal Workflow Down
[ ] Hide States with no Tasks
Back Mext Einish Cancel

« STEP Workflows domain: Only entire workflows can be chosen for this option. Data cannot be filtered
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down to the task level.

S5TEP Workflow Profile Wizard

Steps STEP Workflow Filtering
L Label and Type () All STEP Workflows
2. 5TEP Workflow Filtering
1 S (@) Specific STEP Workflows
4, User (Group Filtering Available STEP Workflows Selected STEP Workflows
5. Display [E Flatplanner_Pre-8.0 ~ Item Creation
[E FP_Workflow
[E GDSM CIC Handling Remave
(B 1casea Add Al
[E Image Deduplication
@ Item Creation Remove All
@ Lead Pipe Plumbing ¢ Up
@ My Workflow W e
£ >
Back Mext Einish Cancel

3. For Collection Filtering, a user can optionally filter the profile results to contain information only for objects in a
given collection.

For example, a user could create a profile that only shows data for objects that are to go live at a certain date,
or only shows data for objects in a particular part of the tree hierarchy.

STEP Warkflow Profile Wizard

Steps Collection Fittering
1. Label and Type [] Filter by Collection
e Select Collection Selected Collection
3. Collection Filtering
4, User/Group Fitering - D Collections
5. Display
Add
Remove

Automatically refresh Collection when Profile is loaded

Einish Cancel
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4. For User/ Group Filtering, a user can filter the profile results to contain information only for tasks that are
assigned to specific users or user groups. This step is disabled for the STEP Workflows domain.

For example, in the Assignee domain, the 'Specific Users / Groups' option is valuable to view the workload for
a number of users. If the 'Assignees' option is selected, users with no tasks will also be included in the profile.

STEP Warkflow Profile Wizard

Steps User/Group Fittering
1. Label and Type (O Assignees
2. STEP Workflow Filtering
3. Collection Elte All Only Users Only Groups
4. User/Group Filtering (@) Specific Users,Groups
5, Displa
i Select Users/Groups Selected Users/Groups
:ﬁa Brand ~ 5 Buyer Group
cﬁa Brand Managers add
F¥l- 2 Buyer Group
- (%% Catalog Flagging Remove
N T, =
£ >
Hide Users/Groups with no Tasks
Back Mext Einish Cancel

5. For Display, the profile options are different depending on the domain was selected in step 1.

« Forthe States and Assignees domains, the profile will consist of two tables: a Master Table and a
Details Table.

Table Description

Master | Displays more general information about the states or assignees.
Table

Details | Appearswhen arow in the Master Table is selected—displays more specific information about the
Table | objects that are contained within a state or assigned to an assignee.

o Forthe STEP Workflows domain, there is a single Master Table. Step 5 is where a user specifies which
columns should be shown in these tables.

Common to all domains are the two divisions of the Master Table settings shown below.
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Table Settings Description

Live Data Data that can be kept up to date automatically — data for workflow instances in their
present state.

On Demand Historical data that is retrieved from the object's State Logs.

Data

« For On Demand Data, this data is generated on demand for all three domains and allows the user to
specify a time period of days, weeks, or months for which they would like to generate historical data.
For example, if you select three (3) days, the generated On Demand table will display three columns,
one for each selected day (e.g., "Throughput today," "Throughput yesterday," "Throughput 2 days
ago.")

STEP Waorkflow Profile Wizard

Steps Display
1. Label and Type ~Master Table:
2. STEP Waorkflow Filtering Live Data:
3. Collection Filtering Show count column Show exceed Deadlines column
4. User/Group Filtering Show average time in State column Show maximum time in State column
5. Display Show STEP Workflow calumn

Cn Demand Data:
Show historical throughput Show historical avg. time in State

Show columns for the last |1

~Details Table:
Show STEP Workflow column Show Deadline column
Show time in State column Show Assignee column
Show Assignment time column Show Status Flag column

Back Mext Finish Cancel

The following sections explain the different options by domain, for step 5.
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States Domain

Table Description

Settings

Master « Show count column: Number of objects currently in the state

Iablg » Show average time in State column: Average time that the objects have been in the state
ive Data

o Show STEP Workflow column: Name of the workflow to which the state belongs

« Show exceeded Deadlines column: Number of exceeded deadlines for objects in the state,
followed by the average exceed time

o Show maximum time in State column: The longest period an object currently in the state has

been there
Master « Show historical throughput: Number of objects that have exited the state within the given
Table-On period (day/week/month). The number is increased each time an object exits the state,
Demand regardless of whether the object has been in and exited the state earlier.
Data » Show historical average time in state: Average time that objects—which have exited the state
within the given period (day / week / month)—were in the state
Details o Show STEP Workflow column: Title of the workflow to which the state selected in the Master
Table Table belongs

« Show time in State column: How long the object has been in the state

« Show Assignment time column: How long the task (which the object-in-state represents) has
been assigned to the current assignee

» Show Deadline column: The deadline, if any
o Show Assignee column: The assignee
« Show Status Flag column: The current status

Assignees Domain

Table Description

Settings

Master Table- | « Show count column: Number of tasks currently assigned to the User/Group

Live Data « Show average Assignment column: Average time the current tasks have been assigned to
the user/ group

« Show exceeded Deadlines column: Number of exceeded Deadlines for Tasks assigned to
the user / group, followed by average exceed time

« Show maximum Assignment time column: Longest period that a task has been assigned to
the user/ group

Master Table- | « Show historical number of assignments: Number of assignments within the given period
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Table Description

Settings

On Demand (day/week/month). i.e., how many times during the period have tasks been assigned to
Data the user/ group

« Show historical number of completed tasks: Number of tasks that were completed within
the given period (day / week / month) while assigned to the user / group

« Show historical average assignment time: Average time tasks were assigned to the user/
group within the given period (day / week / month)

« Show historical average completion time: Average time within the given period (day / week
/ month) that it took a user / group to complete a task, once assigned

Details Table o« Show STEP Workflow column: Name of the workflow in which the task exists
o Show State column: The state in which the task exists

« Show Assignment time column: How long the task has been assigned to the current
assignee

« Show Deadline column: The deadline, if any

« Show time in State column: How long the task has existed, i.e., how long the object has
been in the state

o Show Status Flag column: The current status

STEP Workflows Domain

Table Description

Settings

Master Table- | « Show count column: Number of objects currently in the workflow that are not in a final state
Live Data on the outer level

« Show average time in STEP Workflow column: Average time the objects have been in the
workflow

Master Table- | « Show historical throughput: Number of objects that have reached a final state on the outer
On Demand level during the given period (day / week / month)

Data « Show historical avg. time in STEP Workflow: Average time that it took objects to reach a
final state on the outer level (from time of workflow initiation) during the given period (day /
week / month)

6. Click the Finish button.
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Profile Editor

Once a profile has been configured, you can generate the On Demand data by clicking the 'Update on-demand
data' button at the top of the Profile tab. You can also edit the configuration and copy the master table data into the

clipboard, so you can paste it into a spreadsheet (e.g., Excel).

S5TEP Workflow Profile Wizard

Steps Display
1. Label and Type ~Master Table:
2. STEP Workflow Filtering Live Data:
3. Collection Filtering [+] Show count column [+] Show exceed Deadlines column
4. User Group Filtering [+] Show average time in State column [+] Show maximum time in State column
5. Display [«] Show STEP Workflow column

On Demand Data:
[+] Show histarical throughput [«] Show histarical avg. time in State

Shaow columns for the last |1 v| | v|

~Details Table:
[+] Show STEP Warkflow column [+] Show Deadline column
[+] Show time in State column [] Show Assignee column
[] Show Assignment time column [] Show Status Flag column

e | pon | | cond

Clicking the 'Update on-demand data' button creates a background process, and updates the table. This displays
the number of objects that have exited the workflow (for STEP Workflow domain) within the given period or based

on the average time in state.
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Remove Objects from Workflows

There are many reasons why an object may need to be removed from a workflow. A few of the reasons for
removing an object from a workflow are:

1. It has finished going through the workflow
2. The object needs to be amended before being put back into the workflow
3. The objectis no longer relevant for the workflow

No matter the reason for removing an object from a workflow, objects can be removed, i.e., taken out of
workflows, in several different ways.

Remove Single Object

If a user wants to remove a single object from a workflow, and they have the 'Remove ltems from STEP Workflow'
privilege, this can be accomplished via the Remove from STEP Workflow context menu option on the object.

To do so, right-click on an object, or product, and select Remove from STEP Workflow.
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Remove All Objects from a Workflow

If a user needs to remove all objects from a workflow, and they have the 'Remove ltems from STEP Workflow'
privilege, this is possible via the workflow context menu option Remove items from STEP Workflow.

e MASTER DATA MANAGEMENT

Navigate to System Setup, right-click on the workflow that needs all items removed, and select Remove items

from STEP Workflow.
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Remove Objects from a State Using Bulk Updates

Should a user want to remove all objects from one state in a workflow, they can do so using Bulk Updates if they
have the ability to search the STEP Workflow tab, and they have the 'Perform Bulk Update' privilege.

1. First navigate to the main Search tab, and once on the tab, from the dropdown Search menu select STEP
Workflow.
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Next, from the two dropdown menu, selects the desired workflow and then specifies which state all objects are

to be removed from. Press Search when finished.

STEP Workflow

STEP Workflow :Shipment Order Process

State

.Rﬁuiew Data

Erl

earch

Result

Show Details

5
|

Mame

>

Once the search result displays, click on the Bulk Updates button at the bottom of the results list.
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STEP Workflow ;
STEP Workflow _Shipment Order Process -
State Review Data -
(Ep [ Reset ] [ Search

Displaying 2 of 2 results Show Details
MName »

. — Blue Hat 1D = 20505
* I Yellow & Pink part for flashlight 1D = 135005
-Operations on Entire Result

4. The Bulk Updates window will display. Click next and on the second step, Operations, from the dropdown
menu at the top select Workflow > Remove items from STEP Workflow.

Bulk Update
Steps Operations

1. Configuration :
2. Operations Merge Attribute Values . E
3. Parameters Attribute values » : :
s = Data Containers »
> Advanced Data Quality , [faues v

Merge Golden Records * -

Publishing »

References and Links  *

Workflow » Claim

Run Business Rule Initiate iterns in STEP Workflow

Send Republish Event Remowve iterns from STEP Workflow

Set Mame Trigger STEP Workflow Event

Set Object Type

Add Operation
Back Mext Finish Cancel

5. Select the desired workflow, enter a 'Process Note' if desired, and select Finish. This will remove all objects
from the state.
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Bulk Update

Steps Operations

1. Configuration Remove items from STEP Workflow '

Operations T
z Choose a Workflow | SampleWorkFlow e
Sl =i Process Mote All items are removed from the Review Data state,
4, Preview
5. Advanced

Add Operation
Back Mext Finish Cancel

Removing Objects from the Final State

As objects by default stay in the final states of the workflow until explicitly removed, it is highly recommended to
automatically take the objects out of the workflow when reaching a final state on the outer level. This can be done
one of two ways: use the 'Remove object from STEP Workflow' business action or use an 'Execute JavaScript'
business action. Itis important to note that both business actions can be used on states other than the final state,
however, the information described below is the most typical scenario in which these actions are used.

Remove object from STEP Workflow Business Action

1. To set up the business action, navigate to System Setup, open the STEP Workflow Designer for the desired
workflow, and right-click on the outer level Final State.

2. Inthe dialog that appears, select the On Entry tab > Add new Business Action > Merge into.

[ STEP Workflow Designer - 11123 *
File Edit View
Worlfiow Properties Shipment Order Process (11123) ® A
jin} 11123
MName |Shipment Order Process Edit
Workflow Variables/Attachments Proceed 1 Comments Web UI Screen Mapping Mandatory Data
Reson for rejection? abe| ™ State Assignee Deadline [Escalation
Skip State' = Proceed 2 | Review Data © Business Rule (Local business rule to be saved with workflow) ||, [Nl lE & %
statusFlagl' abe P L
: .
statusFlag2 abe| Skip_State Confirm data
Bl ¥ E J"'-"---.._______I_’roceed_a ::’ ""“‘“-.,j Action
Validation errors: T T el Local
Approve Data Ryh as privileged  []
Proceed_4 Operations Dependencies Applies if

E Merge intor LTI

tems packaged

Proceed_5

End State @

Add new Business Action

Show Edited State
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3. Go to 'Workflow' from the dropdown menu, and click on the Remove object from STEP Workflow option in
the submenu.

4. The Current radio button is selected by default. (If using this business action in a way that it will be invoked
outside of a workflow or if the current action should apply to a different workflow, then you can select Other and
specify a different workflow.)

5. Next, if desired, add a message to be logged in the Note field of the object State Log.

Edit Operation

r [ Remove ohject from STEP Workflow |

Message:

Save Cance

6. Click Save and remember to save your changes before exiting the STEP Workflow Designer.

Execute JavaScript Business Action

If below script is entered in a business action configured 'On Entry' to the final state, once objects enter the state,
they will be removed from the workflow and the supplied process note posted to the State Log if one was entered.

node.getWorkflowInstance (workflow) .delete ("Object automatically removed
from Workflow");

1. Toadd the above script to a business action, navigate to System Setup, open the STEP Workflow Designer for
the desired workflow, and right-click on the outer level Final State.

2. Inthe dialog that appears, select the On Entry tab > Add new Business Action > Merge into.
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Workflow Properties

Shipment Order Process (11123) @

jin] 11123

Mame |Shipment Order Process

Workflow Variables/Attachments

Reson for rejection?’ abe | ™
Skip State' abe
statusFlagl’ abe
statusFlag?' abe|
EYRPORRY|

Validation errors:

Skip_State

- Proceed_3

Edit
Proceed_1 Comments U_\_feb uI Scre.en Mapping _Mandamr\{' Data
State Assignee Deadline Escalation
Procesd_2 | Review Data @ Business Rule (Local business rule to be saved with workflow) | S8 |§| & |
=
Confirm data
" .,
T . .
. ) )y | Action
— T~ = Local
Approve Data as privileged []
Proceed_4 Operations Dependencies Applies if
. LT
termns packaged ﬁ Merge into
Proceed_5
Endl State @ Add new Business Action
Show Edited State

Select 'Execute JavaScript' from the dropdown menu, and click on the Edit Binds button, to add any
necessary binds. Note that the two binds being added for this particular workflow are: Workflow to Current

Workflow and Node to Current Object.

Edit Operation

‘I Execute JavaEcr'lptI -

Einds: % Binds

Variable name * |Binds to

workflow Current Workflow

node Current Object
Messages: T Messages

|'I.-'aria|::|e name » |Message >
JavaScript: 1

Edit externally

>

Save Cancel
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4. Next add the following script in the JavaScript window. Notice how the variable name for the Current Workflow
Bind is used. Users should make sure to replace with their variable name in the script.

Edit Operation

[ Esscute JavaSoipt =

Binds: P Binds
Variable name ¥ |Binds to >
workflow ~ Current Waorkflow
node \ Current Object

N3 \
Messages: T Messages

|'I.-'aria|::|e name \ > |Message > I'Franslations > |
Javasaipt: | 1 node.getWorkflowInstance(workflow).delete("Object automatically removed from Workflow™); ™
v
Edit externally
Save Cancel

5. Click Save and remember to save your changes before exiting the STEP Workflow Designer.
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Running Background Processes from Workflows

Via the API Task interface, it is possible to start a background process, BGP, and have events triggered on the
task matching the end status of the background process. Image below shows a simple workflow where an
Approve Recursively Background Process is started when entering the 'Trigger_ BGP' state. When the
background process is done, one of the transitions out of the state will be performed based on the end status of the
background process. i.e., If the end status is 'succeeded’, the "bgp.succeeded" event will be triggered. If it is failed,
the "bgp.failed" event will be triggered. Similar to the "StatelD.Something" (where 'Something' stands for the
user's word choice) and "stibo.import" events, any event beginning with "bgp." will be hidden in the STEP
Workflow Items editor and on the Object Tasks tab.

In the picture below, as soon as a task is released to the 'Trigger BGP' state, the Approve Recursively with a BGP
process script will execute.

STEP Workflow Designer - My_Workflow

File Edit View
Waorkflow Properties

r
Approve Recursively (T1) & ~

D T1

Mame | Approve Recursively

Waorkflow Variables/Attachments _

BGP ID' abi:
VariableHoldinglzerID' ahe
e
Try_Again— @ BGP D
! gp sugceeded
Failure (A0 —lalgfa«:falleel-/E
B 1% & r
SuUCcess
Validation errors:

e
Final

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 202



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

Once a BGP has finished, if a particular task / item needs to be investigated, a user can navigate to its State Log
tab and see all Background Process IDs that occurred.

Tree

[#-{ 7] Assets

[#-{7] Configurations

[#-{Z5] ETIME Article Groups

[1-(Z5) ETIM Artide Groups

[+-{I= Index Words

(- 7] Merchandising Hierarchy

-] Suppliers

-] Templates

-] Web Sites

[+-{il| Entity Root

[ [) GDSN Receiver

[~ Promotions

[]---ﬁ Publications

E1-[IF] Primary Product Hierarchy

f—]lj Products

Elrj Apparel

[T Upper Body Wesar
2T Tshirts

-] T-shirts Ttems
B 126Gk

il 55723-12

|_'_=| Head Wear
[=-[[F] Footwear
[+-I77 Safetv

0 135442 — 12-GC

il Cotton T-Shirts
[[Z] T-Shirts Sales Items

L]

12-GGK79 rev.0.11 - Status

Product || Sub Products || References || Referenced By || Images & Documents || Commercigl || Tables || Category Profile || Proof View || Status m

@ Approve Recursively

Show transitions Show assignments Show notes

[Time User  * |Event From State * [To State * |Note > |Assignee * |Log Type
> |2016-05-23 07:13:24 LSERL Success e Ie IERATHIEE sshabyed transition

t removed from Workflow
» [2015-05-23 07:11:18 USERL Success LUSERL assignment
> | 2016-05-23 07:11:18 USERL  bap.succeeded  (State-3)  Success zﬁgigﬁ—m_‘m’ oaeEdiarsiats transition
» | 2016-05-23 07:11:13 LISERL State-3) USERL assignment
» | 2016-05-23 07:11:13 USERL  [Try Again Failure State-3) transition
> | 2016-05-23 06:02:52 LUSERL Failure USERL assignment
> | 2016-05-23 06:02:52 USERL  bap.faled State-3)  Failure gi‘l’::“ (B 7o7s ingaessdiastatiis transition
» | 2016-05-23 06:02:50 USERL State-3) USERL assignment
> | 2015-05-23 06:02:50 USERL Initial State-3) transition
» | 2016-05-23 06:02: 10 LSERL Initial USERL assignment
> | 2015-05-23 06:02:10 USERL Initial transition
e SYSTEM-GEMERATED MESSAGE: Object -

» | 2015-05-23 06:01:46 USERL Success e o e trow transition
» | 2016-05-23 05:50:55 USERL Success USERL assignment
> | 2016-05-23 05:50:55 USERL  bap.succeeded  (State-3)  Success ;rlzx:gsp_m?zs} togaedasahs transition
» |2016-05-23 05:50:51 LSERL State-3) USERL assignment
» | 2016-05-23 05:50:51 USERL Initial State-3) transition

Should the user need to examine any background process information further, they can do so by either going to
the main BG Processes tab and looking at the background processes for the receptive workflow or by searching
for the Background Process ID.
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[T context [Engish us .:g 6 CurL E ¥ 7 [l coto [10iName - [

BG Processes

Started from Workflow - Background Process

Background Process [ReTCNCR0G ()
--% AddItemsToCollection # || Properties ~
; % Analyze Change-Package Property s [value e
% Approve Recursively Started by USERL
i % Queued Processes
" EI :& Active Processes Id BGP_175833
E ' %:'ué} Approve 12-GGKFS Description Started from Workflow
L i )
B é:lué} Started from Workflow Execution Server doc-dev
& %&% Started from Workflow D
Jone
> [ " Approve Recyde an progress
e I R B .36 Approve Level2 Status succeeded
g E Ended Processes Created Thu Jun 02 15:01:54 EDT 2016
N Started from Workflow
' & o Started Thu Jun D2 15:01:55 EDT 2015
& % Asset Integrity check
S :.& AssetDelivery Finished Thu Jun 02 15:01:55 EDT 2016
| B
e --% Autopage Batch Service Processing Time 0m0s
'% "% BGFTest Time in Queue Omis
1| B-2:5 Bulk Update
gl s .
2 --% Cateqory Profile Batch Processes # of warnings u
o H
| --% Change Attribute References # of errors ]
- #i= Create Collecti
E H % reate Col e. r?n . ®
T --% Create Publication Section as copy of
= % CreateInDesignPackage 1 Recursive approval started on 100703 in context ‘English US'
& {'E CreatePDF = Approved 0 classifications; 0 products; 0 assets; 0 entities..
| % CreatePDFofPublication © Recursive approval of 0 objects done. 0 warnings and 0 errors.
--% CreateProductProof

If the BGP should fail, looking at the BGP report can help in determining why.
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Started from Workflow - Background Process

<
7 Properties
Property > [Value >
Started by DBA
Id BGP_179741
Description Started from Workflow
Execution Server doc-dev
Status failed )
Created Mon May 23 09:01:23 EDT 2016
Started Mon May 23 09:01:24 EDT 2016
Finished Maon May 23 09:01:25 EOT 2016
Processing Time Omls
Time in Queue Omls
# of warnings ]
# of errors 1
7' Execution Report

1 Recursive approval started on 100703 in context "English UK

2 Approved 0 classifications; 1 products; 0 assets; 0 entities.; 1 errors

2 Approve error report for 12-GGKTS

I+ Lnable to approve object due to missing mandatory values on attribute(s): step:fattribute ?id=CQtyOfMextLowerPackage
= Recursive approval of 1 objects done. 0 warnings and 1 errors.
H 4l 1-50f5 | [k [ Truncate

In the case of this 'Approve Recursively' workflow example, the task will be moved to the Failure state, and only
once the error is fixed, then the task can be moved from the Failure state by selecting the event "Try_Again'. Then
if the BGP is successful, it will move to the Success state.

On Entry Background Process Script

While the script below could be used for other scenarios, two scenarios that this script can be used with workflow
for are the following:

1. Ifan objectis required to run a translation, and it is mandatory that an object is in the approved state before
running the translation.

2. Ifthere is any extraction required from the Approved workspace
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The On Entry script that starts the background process is shown below. The last line stores the ID of the started
background process in a workflow variable with ID "BGP ID". The ApproveRecursiveServiceDescriptor is
described in the public APl documentation, accessed by clicking the STEP APl Documentation button on the
STEP Start Page.

var task = node.getTaskByID ("WokflowID", "WorkflowStateID");

var serviceDescriptor =
com.stibo.services.base.approverecursive.ApproveRecursiveServiceDescripto
r;

var parameter = new serviceDescriptor.Parameter();
parameter.context = step.getCurrentContext();
parameter.nodes = [node];

var bgp = task.startBackgroundProcess (serviceDescriptor, parameter,
"Started from Workflow");

node.getWorkflowInstance (workflow) .setSimpleVariable
("WorkflowVariableID", bgp.getID());

The On Entry script in the state "Trigger_BGP" will look like the image below. Also notice that the image below has
filled in the appropriate "WorkflowID," "WorkflowStateID," and "WorkflowVariableID" in accordance to the
workflow information.

Edit Operation

Variable name * |Binds to >
node Current Object
step STEP Manager
workflow Current Waorkflow
Messages: 7
Variable name » Message » [Translations >
Javascript: var task = node.getTaskByID("T1", “Trigger BGP"); 2

var serviceDescriptor = com.stibo.services.base.approverecursive.ApproveRecursiveServiceDescriptor;
var parameter = new serviceDescriptor.Parameter();

parameter.context = step.getCurrentContext();

parameter.nodes = [node];

var bgp = task.startBackgroundProcess(serviceDescriptor, parameter, "Started from Workflow™);

node. getlWorkflowInstance (workflow).setSimpleVariable("BGP ID", bgp.getID());

=] A s L B

Edit externally

|Sa\re||Ca'1cei
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Send Email from a Workflow

Generally emails are sent from a workflow to a user to escalate the importance of a task as it moves during the
transition from one state to another. There are a number of reasons why a workflow might be setup to do this. One
reason might be that a task was rejected from a state by the 'reviewer' due to the task not being done correctly. In
this case, if there was a business action set up on the transition to notify the previous user, the user then would
receive an email saying that the task they had previously pushed through was sent back. No matter the reason for
setting up email notifications from workflows, it is possible to set this configuration up via a business action utilizing
the "mailer" script shorthand. The business action can be configured or used on the State Editor screen in the
'Deadline/Escalation’, 'On Entry', or 'On Exit' tabs, as well as on the Transition Editor on the 'On Transition' tab.

For information on configuring email from STEP, see the Email from STEP topic in the Resource Materials of
online help.

Dynamic Email Addresses

When sending emails from a workflow, it is often necessary to send emails to different users who interact with the
same workflow. One scenario for this might be that a number of users may claim tasks from the same state. If the
task is later released, and then rejected due to an error, it is important to inform the correct user who last worked
onit.

Configuring Emails from Workflows

The script example below shows how an email address defined on a STEP User can be obtained, and how an
email without attachments is sent to that user. In the following example, this script is used on a Transition Editor on
the 'On Transition' tab.

var userId = node.getWorkflowInstance (workflow) .getSimpleVariable
("VariableHoldingUserID") ;

var emailAddress = step.getUserHome () .getUserByIld (userId).getEMail () ;
if (emailAddress) {
mailer.send ("noreply@stibo.com", emailAddress, "From Workflow",

"This is a mail sent from a Workflow");

else {

logger.warning ("No email address specified for User with ID " + userId);

}

Conditions
To execute the above configuration, the following two conditions must be met for 'Sending Email from a Workflow'.
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1. A Simple Mail Transfer Protocol (SMTP) server must be configured in the executing system.

2. The user who is to receive the email should be entered into the User tab under description. To do so, go to
System Setup, navigate to the node that houses Users and Groups, expand the node and click on the user who
will be emailed. Enter in their name and email.

System Setup

=% Super Users -

Mame ¥ » |Value >

..... & D'rPU5er > ID USER.L
""" & kihe » Mame User L

..... jer 1
2, supplier s E-Mail ermail @domain. com

..... £, user > Force Authentication via 5...

""" % User » Group Information abe

Lser Information abe

Change User Password

I

Group Information

..... £ User 5 Mame v
..... &, User 6 * Buper Users
..... £ User 7 | * | Add User to Group

m

In the example below, there are two business actions set up to send emails to various users.
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STEP Workflow Designer - Business_Action

File Edit View
Waorkflow Properties

Business_Action (Business_Action) & e

D |Business_.ﬁ.ctiu:un |

Mame |Eusiness_.ﬁ.ctiun |

Waorkflow Variables/Attachments

assinge’ abe:

Released_by' abe _
Submit

Validation errors: ]
Edit @@ i

Reject

Subymit

w - ]
Review

Acéept

One business rule is on the State Editor on the 'On Exit' tab coming from the Edit state going to the Review state.
This business action, which is pictured below, is set up to retrieve the email ID of a user who submits a task from
Edit state to the Review state as a variable. In this case, 'Released_by' is the variable defined to retrieve the email
ID.

See Workflow Variables in the Workflows documentation for more on workflow variables.
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Edit Operation

 Execute Javaboipt =
Binds: 7 Binds

Variable name ¥ |Binds to >

node Current Object

workfow Current Workflow

Ftep STEP Manager
Messages: § Messages

|variable name > |Message » [Translations »
JavaScript: | 1 Par‘ assigneelIl = step.getCurrentUser().getID(); 2

2 node.getWorkflowInstance(workflow).setSimpleVariable("Released _by", assigneeID);
W
Edit externally
Save Cancel

The second business action is on the Transition Editor on the 'On Transition' tab. This transition is coming from the
Review state going to the Edit state and has the event name Reject.

The business action script uses the variable 'Released_by' as well, where it is helping to identify who to send the
workflow email to and notify that the task they just submitted was rejected. This script also is sending the email to
the user without any attachments other than the message. Notice that the message shown in pink, can be crafted
to say anything that might be helpful to the receiver whenever a task is rejected.
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Edit Operation

[ Exscute JavaSoipt

Binds: ¢ Binds
\Variable name * |Binds to >
node Current Object
step STEP Manager
workflow Current Workflow
mailer Mailer {deprecated)
Messages: 7 Messages
|ﬂaﬂabh name >|Message > hTandaﬁnns >
JavaSaipt: | 1 far userld = node.getWorkflowInstance(workflow).getSimpleVariable("Released by"); 2
2 wvar emailAddress = step.getUserHome().getUserById(userId).getEMail();
3 if(emailAddress) {
4 mailer.send( "noreplyf@stibo.com”, emailAddress, “"From Business Action Workflow",
5 "This is a mail sent from a Workflow, as the one of task got rejected");
€}
7 else {
] logger.warning("No email address specified for User with ID ™ + userId);
9}
W
Edit externally
Save Cancel

It is important to note that if there is no email address registered, or if the email is not a valid one, the executing
user is not notified (e.g., no pop-up appears). However, it is captured in the STEP system log on the application
server.

If the user doing the rejecting should be notified that no email was sent and provided with an error message, then a
business condition must be added to the Transition Editor on the 'Condition' tab. The following script is what
should be entered in below.

var userId = node.getWorkflowInstance (workflow) .getSimpleVariable
("Released by");

var emailAddress = step.getUserHome () .getUserByIld (userId).getEMail () ;
if (emailAddress) {
return true;

}
else {

return "No email address specified for User with ID " + userId;

}
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Edit Operation

[ Ewzlszte JavaSoipt
Binds: 7 Binds

Variable name * |Binds to »
node Current Object
workflow Current Workflow
Istep STEF Manager
Messages: ¥ Messages
|'I.-'ariab|e name > |Message > |Trans|atiu::ns >
Javasaript: | 1 war userId = node.getWorkflowInstance(workflow).getSimpleVariable("Released by"); 2
2 wvar emailAddress = step.getUserHome().getUserById(userId).getEMail();
3 ifiemailAddress) {
4 return true;
50
& else {
7 return "No email address specified for User with ID " + userId;
g1

Edit externally

Save Cancel

Static Email Address

In the above scenario, STEP will trigger emails to the executing users. However, in some cases the same user will
always need to be notified and never change (a static email address). In this case it is possible to send emails to
the static email address with the 'Send Email' operation, and no JavaScript is needed.

This 'Send Email' operation can be added in a State Editor on the 'On Entry', 'On Exit' or 'Escalation’ tabs. It can
also be sent in the Transition Editor on the 'On Transition' tab. Select the appropriate Editor and tab and then
select Add new Business Action > Merge into > Send Email.
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Edit Operation

 Gend Email

& v | .

To: | |

From: | |

Subject: | |

Message:

Save Cancel
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State Characteristics in Workflows

The State tab of the State Editor allows for workflow designers to assign specific characteristics to a state.

State Editor

Edit

Deadline/Escalation Comments Web UI Screen Mapping Mandatory Data

State On Entry On Exit Assignee

ID State-1
Mame |Initiate Data

- Characteristics
Initial

[ ] Final

[ ] Cluster

[] Parallel

Show Edited State

When creating states for a workflow, not all states need a characteristic assigned to them. Many states will not
have any characteristics assigned, but in some cases state characteristics become very important. For example, in

order for a workflow to be valid, it needs one Initial state and one Final state. Additionally, if clusters are presentin
a workflow, there also needs to be one Initial state inside the cluster.

This section of the documentation describes the various state characteristics and how they are used within
workflows, specifically:

« Initial and Final

o Clusters

o Parallels
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Initial and Final States in a Workflow

A workflow can have as many states as it needs in order to correctly depict the action or actions taking place.
These states all must have at least one transition coming into the state and at least one outgoing transition from the
state. However, the two states that every workflow need, the Initial State and a Final State, do not necessarily
have to abide by these transition rules depending on the workflow layer they reside in.

Initial

Initial State

The Initial State, represented by a slightly darker colored state, signals to an object entering the workflow where
to start. This could be in a simple workflow, such as the one pictured below, or it could be in regards to telling an
object which state to start with when entering a cluster. There can only be one outer Initial State for the general
workflow, and there can only be one Initial State inside each cluster. An outer layer Initial State does not have an
incoming transition, only an outgoing transition. This outer Initial State signals to the object / task entering the
workflow where to start. Once an object knows what state to start with, the workflow can progress.

Workflow 4 (Workflowd) @&

-
State 2
w

For more on Clusters, see Clusters in Workflows in the Workflows documentation.

Initial as a Parallel

It is often necessary for more than one incident to take place at a time in a workflow. In this case, a Parallel
structure should be used as the Initial State, which auto-initiates the object into the Initial States within each
cluster simultaneously. The object only leaves the Parallel once the object has reached the Final State in each
cluster.
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Workflow 4 (Workflowd) &

= Cluster = Cluster 2

State 2 Cluster
State 2 Cluster 2

Al
| Fimal Cluster Final cluster 2

1

Review State
Al
State 2
e
Final

For more on Parallels, see Parallels in Workflows in the Workflows documentation.

Final State

States with the Final characteristic are used to denote the ending of either an entire Workflow or a Cluster. Only
Final States within Parallels and Clusters can have an incoming and outgoing transition.
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All workflows should have a reachable outer layer Final State. Never-ending workflows can lead to performance
impacts. However, there cannot be transitions out of a outer layer Final State characteristic, only incoming
transitions. For this reason the outer layer Final State rarely represents a human task. When an object reaches a
Final State on the outer level of a workflow (not in a Parallel or Cluster), it will remain there until the object is taken

out of the workflow.

For performance reasons, and because the workflow cannot be started again on an object already in the
workflow, it often makes sense to automatically remove objects from the workflow as they reach a Final State on

the outer level.

For more on how to automatically remove an object from a workflow see Remove Objects from Workflows in
the Workflows documentation.
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Clusters in Workflows

A cluster is a grouping of states. There are two main reasons why a grouping of particular states might be
beneficial within a workflow. It may be useful for purely administrative reasons, making it possible to easily monitor
a section in a workflow, or it may be used in conjunction with other clusters inside of a parallel, which is the more
likely use case. For whatever the reason may be, it is important to know how to clusters work and how to create
them.

Creating and Entering Clusters in Workflow

Any state can have the cluster characteristic added to it. This means that the particular state can have sub-states.
The first sub-state in a cluster has to be an Initial state in order for the workflow to be valid. This means that there
could be multiple states in a workflow with the characteristic of Initial state.

=
Workflow3 (Workflow3) %

¥
= 2nd State

4th State

U

Sth State

7th State

Itis important to note that states with cluster characteristics are still states in their own right. If an objectisina
cluster sub-state, it is also at the same time in the state with the cluster characteristic.
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If a state with a cluster characteristic contains sub-states, the cluster characteristic cannot be deselected in the

State Editor.

Workflow3 (Workflow3) ®

= a5

= 2nd State

Edit
Web UI Screen Mapping Mandatory Data
Deadline/Escalation Comments
o [ ........ state | On Enfry On Exit Assignee
D State-2
[ 5th State ]
Name |2nd Stzte
[End Inside Cluster] - Characteristics
[ ] mitial
= = _
II Final
|I Cluster
k4
[ 7th State J [] paralle

Show Edited State

[ End Warldflow ]

In looking at the following cluster, it is important to know how an object placed into the workflow would move

through it.
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=
Workflow3 (Workflow3) &

*I

= 2nd State

4th State

il

ath State

U

L
End Ingide Cluster

7th State

i |

Enel Woark flow

1. After entering into the 1st Initial State, an object enters into the 2nd State, which also happens to be a
cluster.

2. Onceinthe cluster, the object also simultaneously enters into the 3rd State-Initial.

3. ltthen proceeds through the next ordered steps until it reaches the End Inside Cluster (Final state).
Because this is inside of a cluster, there is a transition allowed out of this Final state (which is different than
what is allowed for the ultimate Final state of a workflow). In this case, it exits not only the End Inside Cluster
(Final state), but it also exits the entire cluster and goes to the 7th State.

4. Fromthe 7th State, it proceeds to the End of Workflow (Final state). The object has reached the end of the
workflow.

Exiting a Cluster in a Workflow

When exiting a Final state in a cluster, the name of events on transitions can aid with the progression of the
workflow. If an event on a transition has the naming formula of 'cluster state ID.done' the transition out of the Final
state with the cluster characteristic to the next state will be triggered automatically.

For example, in the picture below, the name of the event on the transition from End Inside Cluster (which has the
characteristic of a Final state) to 7th State is being named. Following the formula to trigger the transition
automatically, the name takes on the 2nd State cluster's ID followed by '.done'.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 220



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

Workflow3 (Workflow3) &

k. J

= 2nd State

L

[ Ath State

[ 5th State ]

[Er‘ld Inside GIuster]

[ 1 Transition Edit

Edit

Add New Events

[ 7th State J

Event | sSigte-2.done

[ End Woaorkflow ]

Events Condition On Trankition Mandatory Data

E‘r[ 0K

Cancel

< Show Edited Transition

This is useful for clusters that have their last state in the cluster with the characteristic as Final state, such as the
one in the example. Normal functionality dictates that an object in a Final state would stay there until it is manually
taken out or there is special coding set up to take the object out of the workflow automatically. However, with this
naming system there is no need for a manual removal or special configurations to progress the object through the
workflow. This naming configuration allows the object to leave the Final state within the cluster, and also leave the

cluster state itself.
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The system will always look for a transition out of a cluster that has an event name of 'Cluster ID.done'. If there is
not a transition found with this name, the system will look for a transition out of the cluster with no named event and
perform that transition.

If there are two or more transitions out of the cluster that all have either the 'Cluster ID.done' event name or no
named events, the system will randomly perform one of the transitions unless conditions on the transitions
determine which one to perform.

If there are only transitions with named events different from 'Cluster ID.done' out of the cluster, objects will remain
in the Final state and can only be progressed by triggering events on the cluster state.

The image below shows an alternate way of configuring a cluster and transition relationship. There is no Final
state inside the cluster. Instead there is a transition directly from End Inside Cluster to 7th State outside the cluster.

When this transition is performed, the object will exit both the End Inside Cluster state and the 2nd State cluster.
While this configuration is perfectly valid, generally the first type of state setup with a Final state and transition is
recommended.

¥

= 2nd State

4th State

| End Inside Cluster

T
(enaneton )
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Parallels in Workflows

Parallels

The Parallel characteristic is used for implementing two or more clusters simultaneously in the workflow. A Parallel
state will automatically get the cluster characteristic indicating that it can only contain clusters as its immediate sub-
states.

= Cluster = Cluster 2
Edit
m]
Comments Web UI Screen Mapping Mandatory Data

o State  OnEntry  OnExit  Assignee  Deadline/Escalation

D State-13

i MName |Parallel

- Characteristics
Initial

Final

Cluster

Parallel

Show Edited State

Once the Final states of all the clusters that are immediate children of a parallel have been reached, the parallel is
automatically exited upon the next transition.

Exiting a Parallel

Transitions from parallels and Final states in clusters can be simultaneously and automatically triggered by using
the formula Parallel ID.done to name the event. This then allows the object in the workflow to move to the next

state outside of the parallel.

1. Inthe picture below, an object entering into the workflow would first enter into the parallel (as it is also the Initial
state), and into the Initial states inside of each cluster simultaneously.

2. The object would then proceed through both clusters simultaneously until the Final state for each cluster is
reached.
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3. Once the object has reached the Final states in all clusters inside of the parallel, it then leaves the parallel and

all clusters at the same time and enters into the first state outside of the parallel.

4. Ifthe event on the transition out of the parallel is named with the formula of Parallel ID.done (in this case State-
13.done), the object leaves both Final states in the clusters and the parallel at the same time, and automatically
goes to the Review State which is situated outside of the parallel state. If the event is unnamed, or named

without this formula, it would have to be manually moved to the Review State.

Workflow 4 (Workflow4) &

= Cluster = Cluster 2

State 2 Cluster State 2 Cluster 2

D Transition Edito
Edit

Review State

Events Condition On Pransition Mandatory Data

Add Event

[ox || concel |

Event |state-13.done

| Show Edited Transition

5. The object then continues through State 2 and ends in Final.

6. While the object is finished going through the workflow, it will not leave the workflow unless coding is in place to

trigger it to leave, or the object is manually removed.
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The image below shows an alternate way of configuring a parallel and transition relationship. There is a transition
from Initial Cluster out of the parallel straight to Review State. If this transition is performed, the entire parallel and
all its sub-states will be exited regardless of which state the object is in for Cluster 2.

=
Workflow 4 (Workflowd) (&

State 2 Cluster

State 2 Cluster 2

l
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Status Flags

Status flags are an aspect of tasks in a workflow that can be useful to group tasks, and are often used to indicate
tasks that need a higher priority or extra attention. For example, status flags can be used to signal tasks that have
been returned to a previous state, tasks that are considered critical or time-sensitive, tasks that have errors, etc.

When a status flag is applied, it is specific to the task-in-state, similar to an assignee. An assignee does not travel
with an object throughout the workflow, rather it is assigned at entry to each state, and upon exit from any state the
current assignee is not retained (unless business rules are set up to record this information). Furthermore, when
an object exits a workflow, there is no longer any assignee associated with it.

Status flags should be thought of in the same way as assignees. Configuring status flags requires the
understanding that they are specific to a task in a state, and therefore must be applied at entry to any state. In
addition, tasks in parallel states of a workflow may have different status flags applied in each state.

This section of the documentation describes how to configure status flags.

First, a place must be created to store the status flags, which is described in the Initial Setup for Status Flags
topic.

Second, status flags must be configured for the particular workflow(s) in which they should be used, which is
described in the Configuring Status Flags topic.
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Initial Setup for Status Flags in Workflows

In order to use status flags for workflows, a setup group that can hold status flag objects must be configured. This
only needs to be done once on any system and if already completed, this configuration is not required.

The required setup can be verified by skipping to step 3 below and checking if the option to create a status flag is
available from the setup group that houses workflows or any other setup group defined as a parent on the 'Status
flag type' defined in step 2 below. If you are able to create a status flag, then you may proceed directly to the
Configuring Status Flags in Workflows topic to add status flags to a particular workflow.

Prerequisites

The below configuration instructions require that a setup group has first been created for workflows. If the
Workflows setup group seen in step 3 below is not present, see the Initial Setup for Workflows topic to
configure it.

Configuration

1. Go to System Setup and select Object Types and Structures > Basic Object Types to find the object type
called Status Flags type.

System Setup

=-{Z Object Types & Structures &
rj Alternate Classifications
-- Assets
= Basic Object Types
-2 Attribute Group
-z Attribute Transformation
@‘ Business Action Type
{7 Business Condition Type
{7 Inbound Integration Endpaint "
-2 InDesign Document
@ Key
[#-Z List O Values Group Type
-{Z¥ Match Code
{7 Matching Algorithm
- {; Reference-Type
{47 Setup Entity user-type root

STEP Workflow Profile Type

2. Selectthe References tab, click the Add Parent link, select the Workflows node (or any other node where
status flags will be created) in the dialog that pops up, and click Select to close the dialog. The end result
should appear as below:
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This allows status flags to be created under the selected setup group.

e MASTER DATA MANAGEMENT

3. Tocreate a status flag, go to the selected setup group, right-click on it, and select Create status flag.

[ STEP Workflow " Bookmarks ]w

D.'_IL_‘:H LAl LUl 1TSS MUes

Eﬁ Inbound Integration Endpoints

EE Match Codes and Matching Algorithms
EE Outbound Integration Endpoints

(5] Web Uls
[+-(55] Web Uls

EE; Workflow Profiles

(-] Workfi

[+-& Object
% Tags
- Units
@ Users
B\h F‘.efej
33 Wor
ﬁ Table
[+ {am Keys
]ﬂ Ewvent
Compo
[ Recyd

]

Mew Setup Group...
Mew Business Action
Mew Business Condition

Create STEP Workflow

Create status flag I Ctrl+5Shift+5

X e e

Start Background Process to Monitor Deadlines  Ctrl+ Shift+D

Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Delete

4. GiveitanID, name, and click Create. Upon creation, the status flag will appear under the selected node.
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. System Setup

=)- 1 Workflows
g (acn-67aaf43b-259a-44b9-b73a-b389cdf4:
: (New Collection)
2021 Plannlng To Dos

@ Collectio] ID Critical

MName Cr'rti::a'

. +| 8| Contrac
P Fl] Critical

Create as many status flags as are needed to support the workflows that require them.

Status flags are global, meaning that once they are created, they can be used by any workflows in the system.
However, status flags are not available in any workflows until they have been applied to each workflow in which
they are needed. See Configuring Status Flags in Workflows for details on how to do this.
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Configuring Status Flags in Workflows

Status flags are global objects that must be applied to any workflow in which they should be used. Once the
needed status flags are created under the top node that houses them, they can then be associated to the desired
workflow.

This topic describes how to add status flags to workflows, and how to use business rules to set status flags on
tasks.

Prerequisites

Before status flags can be added to workflows, a setup group must first exist that can hold status flags, and at least
one status flag must have been created. For instructions on these processes, see Initial Setup for Status Flags
in Workflows.

In addition, it is important to understand that status flags are specific to a task in a particular state. More information
on this can be found in the introductory Status Flags topic.

Configuration

Use the following steps to enable status flags for a workflow.

1. Openthe STEP Workflow Designer of the workflow that needs status flags associated to it.

2. Double-click a blank area in the workflow frame, or right-click inside the workflow frame, and select Edit
Workflow to display the Workflow Editor dialog.

3. Select the Status Flags tab, and add any flags that are needed for the workflow. Note that a 'default status
flag' for the workflow must be selected.

Important: Any new tasks assigned to the workflow will be given the default status flag unless the
workflow is directed to do otherwise via business rules. Any existing tasks already in the workflow will also
receive the default status flag.

4. When finished, close the editor, and save your changes.
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[ 1 STEP Workflow Designer - SampleWorkflow3state* .
File Edit View
Workflow Properties A
Morkflow Editor
ID SampleWorkflow3state Workilow Editor
Edit
Name | mple Workflow (3 states) Assignee SiatusFIags
Workflow Variables/ At chments Legal Status Flags
'AssigneeGroupSelection’ abs | A
: - = , ID *Name * |Default flag
Abe
StatusfiagDowor »(Critical  [ortical [
'StatusFlagFinish' abe
g v *anrmaI |Nnrma| S

B |%] > |Errnr |Errnr [ ]

Valdation errors:

g * | Add status flag

: Show Edited 5tate |
— v
£ >

5. Aside from the default flag applied to all tasks in the workflow, status flags are not truly enabled until business
rules are created to apply them to tasks. Therefore, instructions for using business rules to apply status flags
are included below.

Using Business Rules to Set Status Flags in Workflows

While it is not required to use workflow variables in conjunction with status flags, it is often useful to create
workflow variables to be associated with each state in which a status flag should be applied. This allows for greater
flexibility in how and when status flags can be set. This is because status flags are somewhat like workflow
assignees in that they are specific to an object in a given state, and cannot be set in advance. Just as you cannot
assign a task to a user until it enters the applicable state, you also cannot bind a status flag to an object's presence
in a workflow until it enters the state. As it is often something from a previous state that determines what the status
of the object is in a subsequent state, workflow variables can be used to capture and store what the flag should be,
which can then be set on entry to the appropriate state.

The below instructions describe how to set a status flag based on a transition being taken. For example, a task that
has been rejected may need to be marked as 'Critical' as it is now spending additional time in the workflow. This is
not the only way to work with status flags, but serves merely as one example of one common use case. Rather
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than using a transition to determine the status flag for a task, any data could be used, such as an attribute value,
reference value, presence or absence of particular data, etc. The options for setting status flags are limited only to
what can be done within business rules.

However, the options for end users viewing and accessing status flags are limited by the interface in which they
access workflows. If workflows are accessed in Web Ul, it is not required that status flags be stored in workflow
variables. However, if end users will interact with the workflow only in the STEP Workbench, status flag
assignments must be stored in workflow variables as that is the only way to make them visible to the end user.

Use a Workflow Variable to Capture a Status and Apply a Status Flag

The below instructions walk through an example of how to capture a desired status flag based on a particular
transition being taken, store the information in a workflow variable, and subsequently apply the desired status flag
at entry to a subsequent state.

1. Create a workflow variable to hold the status flag using the button. As status flags are state-specific, it is

recommended to create one workflow variable for each state in the workflow that will have a status flag
determined by some factor other than entering the state, so that when the determining factor is evaluated, the
resulting flag to be applied at any given state can be stored for that state.

STEP Workflow Designer - SampleWorkflow3state®

File Edit View

Workflow Properties "

ID SampleWorkflow3state

MName | 'mple Workflow (3 states)

Workflow Variables/&tmchments Progged Reject
'AssigneeGroupSelection’ ab

[ Do Work @ ]
'StatusFlagDoWork' abe .
StatusFlagFinish ab PFDE&EEEI
'StatusFlagStart’ abe: *
'StoredAssignee’ abe [ Finish ]

[Ex =

Valdation errors:

For additional information on workflow variables, see the Workflow Variables section of the documentation.

2. For this example, when a task is rejected, we want to apply a Critical status flag so that users know to quickly
process the task in the Start state. Therefore, we need a business rule to record that the Reject transition has
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been taken and store that information. As we want the task to then have a Critical status in the Start state, we

will store the information in the StatusFlag_Start workflow variable.

Right-click on the transition that should be recorded, select Edit Transition, click on the On Transition tab,

and click the Add new Business Action link.

Transition Editor

Edit

Fro

ed ReRact | Events conditior [on Transitiond Mandatory Data

[ Do Work ® ] Business Rule

! MName
Froceed
! Description
* .
[ Finish ] Type Action
Scope Local

Run as privieged [ ]

Operations pependencies Applies if

CILEIES

£

Add new Business Action

Show Edited Transition

3. Click on the Edit icon button that appears under the Operations tab. This will bring up the Edit Operation

dialog. Select the Execute JavaScript dropdown option.
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[ 1 Transition Editor X
Edit

Events Conditior On Transiion Mandatory Datz

Business Rule S m -l

MName

Description

Type Action
Scope Local

Run as privieged [ ]

Operafions pependencies Applies if

Create Ass
Product U
E Asset Refer| t Execute JavaScript v |
Automatical
Binds: P
< Variable name * |Binds to
Add new Busines
Messages: ?

Variable name > |Message > | Translations
by

JavaScript: 1

Edit externaly

Save Cancel

4. Under Binds, click the Edit Binds button, and then click the Add Bind button.
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X

Binds:

‘ Messages:

Javag:

% Binds

Variahle name

> [Binds to

iﬁi

Edit Binds

Variable name

Add Bind

Binds to

Parameters

oK

Cancel

. For this example, we need to bind to both current object and current workflow. Input variable names and select
the appropriate binds, as shown below. Click OK to close the Edit Binds dialog when complete.

Edit Binds
Variable name Binds to Parameters -
node |Current Object 1r| b
wf |Currenthrkﬂuw "l by
o2 Add Bind y
oK Cancel

. Inthe JavaScript field type in the appropriate JavaScript formula. An example is provided below that will set the
value of the workflow variable 'StatusFlag_Start' to 'Critical'. Keep in mind that what is written in the
parentheses is driven by the variable name that was written in the bind, the workflow variable created to hold
the status flag value, and the ID of the status flag that is to be assigned.

var inst;

inst = node.getWorkflowInstance (wf) ;

inst.setSimpleVariable ('StatusFlagStart', 'Critical');
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Edit Operation

M Execute JavaScript
Binds: ? Binds

Variable name * |Binds to

node Current Object

wf Current Workflow
Sn—

W

Messages: T Messages
|Variable name > [Message » | Translations

b

JavaScript: 1 wvar inst;
2 inst = node.getWorkflowInstance(wf);
3 inst.setSimpleVariable( 'StatusFlagStart' , 'Critical');
Edit externaly
< >

Save Cancel

Click Save in the Edit Operation dialog when finished, and close the Transition Editor using the X button in the
upper right corner.

. Atthis point we have only stored what the status flag should be, but have not applied the status flag to any task.
To do that, a rule must be added to the state in which the flag should be assigned.

Right-click on the state and select Edit State. Click on the On Entry tab, and click the Add new Business
Action link.
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State Editor

Edit

Comments Web UI Screen Mapping Mandatory Datz
Do Work ® State On Enfry on Exit Assignee Deadline/Escalation ‘
: Business Rule (acn-466e2776-9f85-4539- | ..., |1 |Bm| | |
F’rutlteed
4' Name
[ Finish I Description
Type Action
Scope Local

Run as privieged [ ]

Operations Dependencies Applies if

JavaScriptBusinessActionWithBinds: Bindings, 0 messages, var inst;

<

Add new Business Action |
Show Edited State I

8. Repeat steps 3 - 5 to edit the rule and add the Current Object and Current Workflow binds.

9. Enter the appropriate JavaScript formula. An example is provided below that will take the value of the
previously stored workflow variable and apply it to the task entering the state.

var inst;

var task;

inst node.getWorkflowInstance (wf) ;

task inst.getTaskByID('Start');
if (inst.getSimpleVariable ('StatusFlagStart')) {

task.setStatusFlagByID (inst.getSimpleVariable ('StatusFlagStart'));
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Edit Operation

[ Execute JavaScript
Binds: ? Binds
Variable name * |Binds to
wf Current Workflow
node Current Object
Messages: & Messages
|Variable name > |Message » | Translations
JavaScript; | 1 var inst;
2 wvar task;
3 inst = node.getWorkflowInstance({wf);
4 task = inst.getTaskByID('Start');
5 if (inst.getSimpleVariable('StatusFlagStart')){
3 task.setStatusFlagByID(inst.getSimpleVariable( 'StatusFlagStart'));
70}
Edit externaly
< >
Save Cancel

Click Save in the Edit Operation dialog when finished, and close the State Editor using the X button in the
upper right corner.

At this point, rules have been created to capture the desired value for a status flag, and to set it upon entry to a
state. However, in order to make the status flag available for end users to view when working with tasks, additional
steps must be taken.

o Ifthe user will interact with tasks in the workbench, the workbench view must be configured to include the
workflow variable holding the status flag value. Additional information on configuring views is available in the
Views and Mappings for Workflows topic in the Getting Started with STEP Workflows documentation.

« Ifusers will interact with workflows in Web Ul, the appropriate status flag components must be added to the
screen. Additional information on working with status flags in Web Ul is available in the Status Flags in Web
Ul topic in the Web User Interfaces documentation.
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Triggering Workflow Events from Imports

If a workflow is valid for either products, classifications, assets, or entities, it is possible to configure the workflow to
automatically trigger certain transitions if an object in the workflow has an attribute value changed in an import as
long as the event on the transition has the ID of 'sibo.import'. This is helpful in that a user does not have to recheck
any existing items that are already in the desired workflow, nor do they have to take the objects out to be updated,
only to put them back into the workflow again. Instead, the objects already initiated into the workflow will be
updated and then be triggered to move to the next sate, if the event on the transition has the proper ID.

For example, a user has Object A in their desired workflow in the Initial state. The Initial state has an event on the
transition coming out of it with the ID of 'stibo.import' going to State 2. The user updates and imports objects, one
of which is Object A. Due to the setup of the Initial state, Object A is updated, and an event is triggered moving
Object A to State 2.

Condition for Triggering Workflow Events from Imports

To turn on this functionality for a workflow, select the desired workflow in System Setup and check the Listen on
updates from import checkbox on the STEP Workflow Editor tab.

 STeP workilow itor | PR EEPY JETR
[

Mame Value
* D 11123
* Mame Shipment Order Process
* Revision 0.82 Last edited by USERL on Thu May 26 15:45: 18 EDT 2016
» [nitiate automatically
* Listen on updates from impart
* Use executing user's write privileges E'Act\ - - -

ivate STEP Workflow whenever an import updates an item in the STEP Workflowl

* Disable transitions on terminated Workspaces [l
* Btart Condition

Make sure that any events that should occur have the proper ID. Again, the Import Manager can only trigger
events with the ID "stibo.import". Thus to have a transition performed for an object in a workflow when it is
changed in an import, the object must be in a state out of which there is a transition with the Event "stibo.import"
(the "stibo.import" event will not be visible in the STEP Workflow Items editor or on the Object Tasks tab).

The image below shows a simple workflow with the functionality turned on.
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stibo import

Second (1)

The_End

The "stibo.import" event is on the transition from the First state to the Second state and thus, if an objectis in the
First state and an attribute value is changed in an import, the transition will be performed.

When working with events generated by imports, there is a special reserved variable named "modifiedAttributes”
available in JavaScript. This variable will hold a list of IDs of the attributes changed in the import. In looking at the
example above, the variable will be available when leaving the 'First' state (On Exit), on the transition (On
Transition + Condition) and when entering the state to which the transition goes (On Entry on the Second state).

Using this reserved variable a user could for instance add a condition on the transition only allowing the transition if
a specific attribute has been changed and has a value after the import. This could be done with a script as follows:

var attChanged = false;
var modArray = modifiedAttributes.toArray();
for(var 1 = 0; 1 < modArray.length; i++) {
if (modArray[i] == "ID of Attribute") {
attChanged = true;

break;

}
if (attChanged && node.getValue ("ID of Attribute").getSimpleValue()) {

condition = true;

else {
condition = false;
}

It is optional for users running imports whether or not the import potentially should trigger events. Thus for column
based imports, in the Import Manger on the Advanced Settings page, the checkbox "Trigger STEP Workflow
import events on ltem Updates' controls whether or not events should be triggered.
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Import Manager

Steps Advanced Setfings
1. Select Configuration Context ' Engish US v| A
2. Select Data Source | |
Impart Process Template: Imparter
3. Select Format Po Pl Po
4, Map Data Match Units By | Mame w |
5. Identify Objects Approve Import Changes ]
6. Identify Destination
oty Auto-Initiate STEP Workflows on Item Creation

8. Advanced Settings Trigger STEP Workflow import events on Item Updates  []

Suppress Re-Translations

Auto select Import Mode (O]
Force Database Import ]
Force Domain Import ]
Remove Options Remove Un-Mapped Values
[ | attribute Groun > Y

Mext | [ Finish | | Cancel

In XML, the functionality is enabled / disabled using the STEPProductinformation tag attribute
"STEPWorkflowImportEvent" that can be setto "Y" or "N".

Since it is optional for users whether events should be triggered, the functionality is typically used in imports based
on pre-configured import configurations. A use case could be one where an object is in a state waiting for data to
arrive from an external system via an Inbound Integration Endpoint.
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Validate Data in a Workflow

Itis common for workflows to require some basic data validation to ensure that quality standards are met for the
provided data. Data validation can be easily accomplished in a workflow by applying conditions on transitions.

Business conditions will always evaluate to either true or false. In workflows they can be applied on transitions,
and thus determine whether or not a transition can be performed. If a condition evaluates to true, the task may take
the transition. If a condition evaluates to false, the task cannot take the transition and must attempt another
transition or remain in the state until the data has been corrected and the condition evaluates to true.

When using conditions for basic data validation, the transitions are generally applied on user-accessed states, so
that the user sees an error when attempting to submit via a particular transition if the data does not validate. Note
that conditions should not be used to validate that mandatory attributes are populated as that can be done using
the built-in mandatory attribute functionality, described in the Mandatory Attributes and References in
Workflows topic.

Data validation can be carried out using any number of functions and/or JavaScript. Additional information on
more advanced topics can be found in the Business Rules section of the documentation. The below provides a
simple example of data validation using the attribute value comparison function.

The below example will check to ensure that an attribute, List Price, has a value greater than or equal to .99. It
assumes that a workflow has already been created and a transition exists on which the condition can be added.

1. Double-click on the transition, select the Condition tab, then click the Add new Business Condition link.
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o )

F'ruqéze Reject
“, o

Do Waork (&

Transition Editor

Eventd Conditiorfon Transition Mandatory Data

Business Rule R BEERE-
Mame

Description

Type Condition

Scope Maone

Run as privieged  []

Operations Dependendes Applies if

Add new Business Condition

Show Edited Transition

2. Click the Edit Operation icon, select Attribute Value Comparison from the dropdown.

D Transition Editor >

Edit

Events Condition On Transiton Mandatory Data

Business Rule {Local business rule to be saved with workflow

Name Edit Operation

Description | 1 [Atrribute Valie Comparison |+ :|
Type Condition R - DI

Scope Local

Run as privieged  []

Operations  Dependencies  Ap

True if value for Attribute ™

Add new Business Condition

Save Cancel ﬂ

Show Edited Transition
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3. Click the ellipsis button (|...|) to select an attribute. Choose an operator from the dropdown, insert a value for
comparison, and click Save.

Edit Operation

Attribute Value Comparison
List Price (ListPrice) o =] |99 7

Save Cancel

4. Click the [X]in the upper right corner of the Transition Editor to close it, then save and exit the workflow.

Users attempting to submit a task that does not meet the condition will receive an error.

IList Price 508

o ~ S|

Error Occurred

Value for "List Price™ *,50 " is not greater than or equal .93 "

Note that by default, the condition also checks for the presence of a value, returning false when no value is
present.

Error Qccurred

Value for "List Price™ " 50 " is not greater than or equal *.93 "
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Workflow Variables

When working with Workflows there are two different types of variables available of which one comes in two
variants:

JavaScript Variables - Normal JavaScript variables can be declared in business actions and conditions. The
scope of these variables is limited to the action / condition where they are declared and they are only persisted
during the execution of the action / condition.

Workflow Variables - Workflow variables are string variables defined in the Workflow Designer. The variables
are global to the workflow instance and the values are stored on the object-in-workflow relation and thus persisted
as long as this relation remains. Workflow variables come in two flavors, '‘bound' and 'unbound'.

Bound Workflow Variables

A bound workflow variable is bound to a STEP Attribute and gets its validation from the STEP Attribute. Apart
from getting the validation from a STEP Attribute, bound workflow variables also get the corresponding attribute
editors when a user chooses to display them in workbench views (see the Views and Mappings for Workflows
section of the Workflows documentation).

Unbound Workflow Variables

When a workflow variable is not bound to an attribute, it is a simple string variable with a default workbench view
editor.

The value of unbound variables can be the result of an expression. In the expression panel, a reserved variable
named 'value' is used. Below a script/ expression is shown that will set the value of the variable to be the ID of the
current node. Expressions are re-calculated each time the variable is used.

value = node.getID();

Creating a Workflow Variable

To create a workflow variable press the add icon and select Add Workflow Variable in the "Workflow
Variables/Attachments' section in the left side of the Designer.
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STEP Workflow Designer - 11123

File Edit View
Workflow Properties

B

D 11123

Mame | Shipment Order Process|

Waorkflow Variables/Attachments

S
Skip State’ abe
statusFlagl’ abe
statusFlag?’ ab
Who approved? abe
Who last edited?' abe
wur A A e e i 'rl
Add Workflow Attachment
Bl
y Add Workflow Variable

This will bring up a dialog where the user can enter the ID of the variable and optionally select to bind it to an
'Attribute’ or add an 'Expression’'.

Add Workflow Variable

jin} My Variable

Attribute MFs

Expression

oK Cancel

As noted in the Business Rules in Workflows section in the Workflows documentation, workflow variables are
manipulated through the WorkflowInstance interface. Thus the value of a workflow variable can be obtained from
a business action as follows:

var valueStoredInVariable = node.getWorkflowInstance
(workflow) .getSimpleVariable ("Variable ID");

And likewise a simple value for a workflow variable could be set with:

node.getWorkflowInstance (workflow) .setSimpleVariable ("Variable ID",
"Value to be set");
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While the above applies to both bound and unbound variables, for bound variables a value object can be obtained.
This can be done with:

var valueObj = node.getWorkflowInstance (workflow) .getValue ("ID of
Attribute the variable is bound to");

Workflow Variables in Use

Consider a user group which consists of five users. All of these five users have access to a particular workflow,
and can submit a product from the Edit to the Review state. For this workflow, because there is a requirement to
identify which of these five users submitted a particular product, a business rule has been set up to save the details
to an attribute. This business action is set on the desired state in the State Editor on the 'On Exit' tab. In this case it
is on the Edit sate.

D STEP Workflow Designer - Business_Action

File Edit View
Workflow Properties =

Business_Action (Business_Action) @

o |Business_.ﬁ.cti|:-n |

Marme |Elusiness_.ﬁ.ctiun |

Workflow Variables/Attachments

Released_by' abe _
Submit
¥
[ Edit 00 AR
Reject
Submit |
Yalidation errors: “_r ]
[ Feview ]
[ 4
Accept
¥

— o )

To create this business rule, a workflow variable first needs to be defined, which is 'Released by’ for this workflow.
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STEP Workflow Designer - Business_Action

File Edit View
Workflow Properties =
D |Business_.ﬁ.ctiu:un |

Mame |Eusiness_.ﬁ.ctiun |

Waorkflow Variables/Attachments

¥

assinge’
Released_by'

¥

Validation errors:

Then a business rule needs to be written to call the workflow variable as mentioned below:

var assigneelD = step.getCurrentUser () .getID();

node.getWorkflowInstance (workflow) .setSimpleVariable ("Variable ID",
assigneelD) ;

[ state Editor x
Edit
State  OnEntry ©OnExit Assignee  Deadlne/Escalation  Comments Web UI Screen Mapping Mandatory Data

BusinessRule | (acn-032948 1e-3718-4255-af70-32ede 7eB93c4) = S e

Name Edit Operation

Description

Type sncs: @ SRESI——

[ Exscute JawvaSoipt ™

Scope Variable name > |Binds to >
Run as privilege node Current Object
- workflow Current Workflow
Operations Dep
step STEP Manager

Ja\taScri e E
?Jmsm Messages: @~ Messages e

~

JavaSaipt: 1 war azsigneell = step.getlurrentUser () .getID():
2 node.getlorkflowInstance (workflow) .SetSimpleVariable ("Released by™, assigneelD) %

Edit externally

£
Add new Busi

|Save ||Canoel
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With this business action in place, when a product is submitted, the business rule is executed and the user ID of
the user who submitted the product is stored. This is visible in the STEP Workflow Items tab if this was mapped in
the views and mappings View Editor.

STEP Workflow Items

STEP Workflow

Praofile Category Profile || Proof View || Status || State Log || Tasks

Referenced By Images & Documents " Cornmercial " Tables

STEP Workflow Items [ Product ” Sub Products " References

| I Mens T PEO >
ol _ _
| . | |E] D * MT 13400
Filter by Collection
! MName * Mens T PEO
Start 2 .
Assigned To * Group : User Group

Edit 0 :
Review 1| ||]/Assinee |6 _
Done 4 Deadline > %]
o IF'.EIeased by * USER23

For more on setting up views and mappings, see the Views and Mapping for Workflows topic in the
Workflows documentation.

Workflow Variables in Web Ul

Workflow variables are also supported in Web Ul, where they can be added to relevant components using the
Workflow Variable or Workflow Variable Header components. In addition, workflow variables can be added to
submit actions (Submit Action or Submit from Grid Action).
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Web Services for SOAP Requests for Workflows

Complete documentation for Web Services functionality related to workflows can be found in the STEP API
documentation at [system]/sdk or by clicking the STEP APl Documentation button on the STEP Start Page.
This topic provides some basic information and an example of a simple SOAP request, but should not be
considered comprehensive.

The STEP Web Services API contains the following methods related to STEP Workflows:
startWorkflow - Method for starting a Workflow on an Object

triggerWorkflowEvent - Method for triggering a Workflow Event for an Object in a State in a Workflow
deleteWorkflowlnstance - Method for removing an Object from a Workflow. l.e., deleting the instance.

getTasks - Method for retrieving info about which States an Object is in in specified Workflow. For each State
apart from the ID, a STEP url for the Assignee and the time of entering the State will be returned.

initiateltemInStateflow - Legacy version of startWorkflow
triggerStateflowEvent - Legacy version of triggerWorkflowEvent
removeltemFromStateflow - Legacy version of deleteWorkflowlInstance

getltemStatelnfo - Legacy version of getTasks

An example using startWorkflow is below:

<soapenv:Envelope
xmlns:soapeny="http://schemas.xmlsoap.org/soap/envelope/"

xmlns:ns="http://stibo.com/step/ws/step/1.0"
xmlns:nsl="http://stibo.com/step/ws/types/1.0">
<soapenv:Header/>
<soapenv:Body>
<ns:startWorkflowRequest>
<ns:accessContext>
<nsl:userName>[Username]</nsl:userName>
<nsl:password>[Password]</nsl:password>
<!--Optional:-->
<nsl:passwordType></nsl:passwordType>
<!--Optional:-->

<nsl:contextUrl>step://context?id=[Context
ID]</nsl:contextUrl>

<!--Optional:-->
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<nsl:workspaceUrl>step://workspace?id=[Workspace
ID]</nsl:workspaceUrl>

</ns:accessContext>
<ns:nodeURL>step://product?[Node ID]</ns:nodeURL>
<ns:WorkflowID>[Workflow ID]</ns:WorkflowID>
<!--Optional:-->
<ns:message>[Message]</ns:message>
</ns:startWorkflowRequest>
</soapenv:Body>

</soapenv:Envelope>
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Workflow Attachments

While not the only reason, 'Workflow Attachments' are typically used for holding files that are necessary for users
handling tasks in states. This could be written instructions, images, data sheets etc. Once the attachment is in
place, when a user receives or gets a specific task(s), they can access the attachment and follow the specified
instructions / guidelines.

Using workflow attachments a user can attach files to workflow instances. Also, like the workflow variables,
workflow attachments are global to the workflow instance.

Workflow Attachment Configurations

As described in the Configuring Views for Workflows section in the Workflows documentation, the
'WorkflowAttachment' component allows Users to add, open, download and delete workflow attachments through
views.

Attachments are defined in the left pane of the Workflow Designer. To add a workflow attachment:

1. Click on the 'Add Workflow Variables/Attachments' icon, , and select the option Add Workflow
Attachment.

2. Inthe dialog that appears, enter the ID and click OK.

Add Workflow Attachment

D |Wurk'ﬁuw Attachment

] Multivalued

| o || cancel |

If multiple attachments are required then check the option for 'Multivalued'.
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3. Nextgoto Edit> Edit Workbench Views and Mappings.

4. Inthe View Editor, right-click the view that needs an attachment added to it, and select Add Column >
Component.

View Editor
Edit
Editar ymL
-E View: Initial Data . | view
" View: Review Dz Add Column * Attribute z
-] View: Confirm dz
(-] View: Approve [ Attribute Group

-2 view: Items pad e

- &) view: End State
E Mapping : Initiat Delete Component
E Mapping : Review Data-=Heview Data
E Mapping : Confirm data->Confirm data
E Mapping : Approve Data->=Approve Data
E Mapping : Items packaged-=Items packaged
- '§| Mapping : End State->End State

Aspect olumns Automatically

5. Under the Component dropdown, select 'Workflow Attachment'. Once selected a dropdown to add an
'Attachment’ will appear. Select the attachment that was just created in step 2. For this example it is called
'Workflow Attachment.'

View Editor
Edit
Editor xmL
EI-- View: Initial Data # | Component
- EJg Column:Object (WorkflowLinkedName) Title
- EJg Column:Who Approved? (WorkflowVariable)
~[IF Attribute: Date [ Read Only
i EE Column:Warkflow Deadline (WorkflowDeadline
gé Column: o ) [] Mandatary
E'" View: Review Data Component | WorkflowAttachment — «
(#-[& view: Confirm data
- view: End State Attachment v
----- E Mapping : Initiate Data-=Initial Data
----- E Mapping : Review Data-=Review Data
----- E Mapping : Confirm data-=Confirm data
----- 5 Mapping : End State->End State v

6. Enter atitle and then decide if either 'Read Only', or 'Mandatory' need to be checked before exiting the View
Editor and hitting 'Save and Exit' in the STEP Workflow Designer. Note that neither one of these has to be
checked. If 'Read Only' is left unchecked then a user can download the attachment and upload files. These files
will be attached to the workflow instance.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 253



1STIBOSYSTEMS

e MASTER DATA MANAGEMENT

Component Returned Value

Read Only If marked as this the add and delete options will be disabled, but users will still be able to open
and download attachments. However, any uploaded files will not be stored in the STEP
database. Instead, they will live in the application server file system in a path specified via the
configuration property 'Install. STEPWorkflowArea'.

Mandatory Tell the user that the attachment is required information.

Attaching a File in a Workflow

Now that the configurations are in place, the steps below show a user how to attach and remove afile.

1. Navigate to the STEP Workflow tab, select the desired workflow, and click on the corresponding state that the
workflow attachment was mapped to in the above steps.

2. Inthe STEP Workflow Items tab, click the ellipsis button (E) next to the desired product and select the file from

the system that is to be attached.

< STEP Worklon Items
&_ a —,Ob_]ecti * |Who Approved? > Date » Waorkflow Deadline »> |Attachment 1 >
 Shpmentrdeross || pue e snion o g &
@ E @ E > Flashlight Bulbs 1 (SPO) Mser L 03-may-2016 [ex)
> Flashlight Bulbs 2 (SPO) User 5 07-may-2016 ()

|Fi|her by Collection |E] > Flashiight Bulbs 3 (S70) User2 034un-2016 E]
Initiate Data 7 > Flashlight Bulbs 4 (SPO) 03-mar-2016 @'
> Flashlight Bulbs 5 (SPO) Wser L 05-apr-2016 [eed)

» fGray Hat E]

> [Industrial Hard Hat @l

> Siiver Flashlight 28-apr-2016 %‘]

)

STEP Workflow Ttems

il Products || References [Wncedsvl
- Ben Workfiow T ] | Jobgect > [Who Approved? > [Date > Workfion Deadine >\otachment 1 7|
? _ » Blue and Purple Flashlight 23-3ug-2016 =\, E]
& E @ E > Flashlight Bubs 1 (sP0) ~ [MsertL D3-may-2016 &
[Fiter by Collection (&[] || [ashichtubs 2 S0y User 5 OTﬁav-Zﬂlﬁ ™
Initiate Data 17 * Flashlight Bulbs 3 (SPO) User2 03<un-2016 ﬂ
Review Data F » Flashlight Bulbs 4 (SPO) 03-mar-2016 E]
Confirm data 0 » Flashlight Bulbs 5 (SPO) User L 05-apr-20156 [;]
» Gray Hat E]
» Industrial Hard Hat E]
> FSiI\rer Flashlight [28-apr-2015 !
> kiHat =
> bh Helmet )
==

3. Double click on the attachment to openit.
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[ Products ” References " Referenced By
o Object * Who Approved? * |Date * Waorkflow Deadliine *|attachment 1 *
» Silver Flashlight 28-apr-2016 o [;]
> SkiHat S| @ skiHatadsx (%]
* 5ki Helmet %] . [l
[ Double-click to open attachment
: rocesd 1« [ st

4. Toremove the attachment, click on the red 'x' button, @

It is worth noting that workflow attachments are instance specific, and values will be deleted together with the
instance.

In the public API you can obtain a "WorkflowAttachment' object through the "WorkflowInstance' interface via
'WorkflowInstance.getAttachmentByID'("Attachment ID") and have various methods available on the returned
object.
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